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Chapter 1: Dialog Boxes
Dialog boxes contain controls such as options and lists through which you can carry out a particular command or 
task. For example, in the Scene Settings dialog box, you must indicate the resolution and alignment. A typical dialog 
box looks as follows:

Add Column Dialog Box
The Add Column dialog box lets you add a column in the Xsheet view.

By default, when you create a new scene, there is one drawing column in the Xsheet view and one corresponding 
drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the Timeline 
view, and a node in the Node view.
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For tasks related to this dialog box, see Adding New Drawing Elements on page 1.

How to access the Add Column dialog box

 1. Do one of the following:

‣ In the Xsheet menu, select Columns > Add Columns. 

‣ Click the Add Columns  button. 

‣ Press Shift + C.

NOTE: The Add Column dialog box contains additional parameters for working with elements which will only 
display if you set advanced preferences. To do this, press Ctrl + U (Windows/Linux) or ⌘  + U (Mac OS X) to open 
the Preferences dialog box. Select the Advanced tab, then select the Advanced Element Mode option and click 
OK.

Parameter Description

Name Lets you give the new column a meaningful name.

Type
Lets you select a type of column to create. Choices include: Drawing, Timing, 
Sound, 3D Path, 3D Rotation, Bezier Curve, Ease Curve, Expression and 
Annotation. 

Drawing Layer Options

Line Art Creates a vector or bitmap drawing column in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing column in the Colour Art layer. 

Element

Create New Element Creates an independent column with its own drawing folder.

Vector
Select this option if you want the layer to contain vector drawings. 
Deselect this  option if you want the layer to contain bitmap images. 
Most of the time, the Vector option will be enabled.

Bitmap Format
Lets you select the type of bitmap image to insert in the column. Select SCAN 
from the list if you are planning to scan drawings using the Toon Boom 
Harmony Scan module.

Scan Type
If you chose SCAN from the Bitmap Format list, select the kind of scanning 
you want to achieve.

Field Chart
When importing traditional animation, lets you indicate the size of paper on 
which the animation or background was drawn. If you are not using perforated 
animation paper, leave the 12 field default value as is.

Reuse Existing 
Element

Links your column to an existing folder within the Element folder of your scene.

Folder Lets you select the folder to which you want to link your new column.

Use Existing Element
Uses drawings from an existing column in the new column. Both columns will 
be attached to the same set of drawings, but their timing will remain  
independent  from one another. If you modify one of the drawings, it will be 
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modified in both columns. This is the same principle as the Clone column.

Name Lets you select the column to which you want to link your new column.

Add and Close
Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view and closes the dialog box. The names of the 
layers/columns are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view. The dialog box remains open for you to add as 
many layers/columns as needed. The names of the layers/columns are 
automatically numbered incrementally.

Close Closes the dialog box.

Add Drawing Layer Dialog Box
The Add Drawing Layer dialog box lets you add a drawing layer  to your project. 

By default, when you create a new scene, there is one drawing column in the Xsheet view and one corresponding 
drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the Timeline 
view, and a node in the Node view.

For tasks related to this dialog box, see Adding New Drawing Elements on page 1.

How to access the Add Drawing Layer dialog box

 1. Do one of the following: 

‣ In the Timeline view, click the Add Drawing Layer  button.

‣ From the top menu, select Insert > Drawing.

‣ Press Ctrl + R (Windows/Linux) or ⌘  + R (Mac OS X).

Parameter Description

Name Lets you give the new layer a meaningful name.

Line Art Creates a vector or bitmap drawing layer in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing layer in the Colour Art layer. 

Add and Close
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view and closes the dialog box. The names of the layers/columns 
are automatically numbered incrementally.

Add
Adds the selected type of layers to the Timeline view and corresponding column 
in the Xsheet view. The dialog box remains open for you to add as many 
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layers/columns as needed. The names of the layers/columns are automatically 
numbered incrementally.

Close Closes the dialog box.

Add Frames Dialog Box
The Add Frames dialog box lets you add frames anywhere in the middle of the scene—before or after a selection. 
If you select a frame row in the Xsheet view, Harmony will add the new frames before or after the selection, 
depending on your choice.

For tasks related to this dialog box, see Frames on page 1.

How to access the Add Frames dialog box

 1. Do one of the following: 

‣ In the Timeline view, select the frame to which you want to add frames before or after.

‣ In the Xsheet view, select a frame row. 

‣ In the Timeline view, select the frame to which you want to add frames before or after.

 2. Do one of the following:

‣ From the top menu, select Scene > Frame > Add Frames Before Selection or Add Frames After 
Selection. 

‣ In the Xsheet view, right-click and select Frames > Add Frames Before Selection or Add Frames 
After Selection.

‣ In the Xsheet toolbar, click the Add Frames  button to add frame after your selection.

‣ Press Ctrl + G and Ctrl + H (Windows/Linux) or ⌘  + G and  Ctrl + H (Mac OS X).

The Add Frames dialog box opens.

Parameter Description

Number of frames to add Lets you enter the number of frames needed in the scene.
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Advanced Save Dialog Box
The Advanced Save dialog box lets you save the scene as a new version, overwrite an existing version, set a new 
current version, display a list of modified drawings, colour palettes, and modified colour palette lists. 

For tasks related to this dialog box, see Saving a Scene on page 1.

How to access the Advanced Save dialog Box

 1. Make sure that you have the necessary rights to save the current scene version. If you do not, you can 
acquire the rights by selecting File > Rights to Modify Scene Version or Rights to Modify Scene.  

 2. From the top menu, select File > Advanced Save. 
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File Tab

Parameter Description

Save

‣ Enable this option if you want to save the modifications made to the 
current scene. 

‣ Deselect the Save option if you only want to save specific components 
of your scene listed in the Drawings, Palettes or Palette Lists tabs. This 
will disable all option in the File tab. 

This Version (number)
Saves the current version of the scene. You can rename the current version by 
typing a new name into the field. 

New Version (number)
Saves the current scene as a new version. You can name this new version by 
typing a name into the field. 

Overwrite Existing Version Lets you select an existing version of your scene from the list to overwrite it.

Description
Use this field to add or edit an existing description for the scene version you 
want to save. 

Mark as Current
Lets you set this scene version as the current one. This version will be auto-
matically selected as the default current version when the scene is selected in 
the Database Selector dialog box

Drawings

The Drawings tab lists the modified drawings.
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Parameter Description

Drawing list
Lets you select the modified drawings to save, and deselect the ones you do not 
want to save.

Select All Selects all modified drawings in list.

Deselect All Deselects all modified drawings in the list.

Palettes

The Palette tab lists the modified colour palettes.
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Parameter Description

Colour Palette list
Lets you select the colour palette to save, and deselect the ones you do not 
want to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified colour palettes in the palette list.

Deselect All Deselects all modified colour palettes in the palette list.

Palette Lists

The Palette Lists tab lists all the modified colour palette lists.
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Parameter Description

Palette Lists
Lets you select the modified palette list to save, and deselect the ones you do not 
want to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified palette lists in the list.

Deselect All Deselects all modified palette lists in the list.

 

 

 

 

 

 

Auto-Matte Dialog Box
The Auto-Matte dialog box lets you generate a matte for a drawing. 

For tasks related to this dialog box, see Art Layers on page 1.
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How to access the Auto Matte dialog box

 1. In the Camera or Drawing view, select the drawing you want to create a matte for.

 2. Do one of the following: 

‣ From the top menu, select Drawing > Generate Auto-Matte. 

‣ In the Camera or Drawing menu, select Drawing > Generate Auto-Matte.

Parameter Description

Settings

Apply to all Drawings Creates a matte for all the drawings included in layer.

Radius
Lets you increase or decrease the radius value depending on the precision or 
roughness of your line. Use a lower value, the closer to your lines’ contours the 
matte will be shaped. The higher the value, the looser the matte will be shaped.

Source Art
Lets you select the layer from which you want the matte created: Line 
Art,Colour Art, Underlay or Overlay.

Destination Art
Lets you select the layer on which you want the matte to be created: Line 
Art,Colour Art, Underlay or Overlay.

Clear Destination Art First Deletes existing artwork on the destination layer before adding a matte to it.

Copy Strokes in Destination
Copies the contour of your lines as invisible lines in the matte drawing. This is 
useful if you need to reuse the lines later.

Close Gaps Dialog Box
The Close Gaps dialog box lets you close up drawing areas that not are closed. This may sometimes happen 
when painting. You can close small gaps in a drawing by creating small, invisible strokes between the two 
closest points to close the colour zone. You do not need to trace directly over the gap. You can draw it a few 
millimeters away. The two closest points automatically close the gap.

For tasks related to this dialog box, see Closing Gaps on page 1.

How to access the Close Gaps dialog box

 1. From the top menu, select View > Show > Show Strokes or press K to see a preview of the result.

 2. If you want the strokes you draw to be flattened in your drawing instead of being on top, click the Auto-Flat-
ten  button in the Tool Properties view.

 3. From the top menu, select Drawing > Clean Up > Close Gaps or press Shift + F10 (Windows/Linux 
only).

The Close Gaps dialog box opens.
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Parameter Description

Size Lets you set the size of the gap you want to be closed.

Apply to all drawings Closes all gaps in the drawing of the selected layer.

Column Types Dialog Box
The Columns Types dialog box lets you show or hide columns in the exposure sheet.

For tasks related to this dialog box, see Showing and Hiding Columns on page 1.

How to access the Columns Types dialog box

 1. In the Xsheet view, select View > Column Types Manager.

The Column Types dialog box opens.

Parameter Description

Column Types Lets you select the types of columns to display in the Xsheet view.

Save as Default Makes these new settings the default ones used each time you start Harmony.

Restore Default Returns the settings to their defaults.

Configure Line Art to Colour Art Dialog Box
The Configure Line Art to Colour Art dialog box lets you modify settings for the Line Art and Colour Art layers.
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How to access the Configure Line Art to Colour Art dialog box

 1. From the Timeline menu, select Edit > Modify Paste Presets > All or Key Frame or Exposure.

Parameter Description

Use rendered version of the 
drawing

Renders the drawing and vectorize it to calculate the position of the centreline 
that will produce the colour art stroke.

Maximum Resolution for 
rendered image

The size of the rendered image.

Threshold for rendered image The value of grey processed to create the rendered vectorized arts.

Fitting error for rendered Bez-
iers

This value represents how precise the fitting of the colour art zone in relation to 
the line art will be.

Source layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want 
the colour art to be created from.

Destination layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want 
the colour art to be created on.

Clear Destination Art Layer 
First

Deletes the content before the colour art is added. This is useful when you 
already have artwork on the destination layer.

Perform Line Art to Colour Art 
Operation Immediately

Performs the Create Colour Art from Line Art command when you click OK.

Create Cycle Dialog Box
The Create Cycle dialog box lets you create cycles from a series of drawings and exposures. 

When you create a drawing cycle, all the repeated drawings are linked to the same original files. When modify, 
repaint, or correct a drawing named “1” for example, all drawings named “1” are updated simultaneously. In order 
to modify a drawing independently from its other exposures, you must duplicate the drawing.

For tasks related to this dialog box, see Creating Cycles on page 1.

How to access the Create Cycle dialog box

 1. In the Timeline or Xsheet view, select the cell range to loop.

 2. In the Timeline toolbar, click the Create Cycle  button (you may have to customize the toolbar to dis-
play it).
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The Create Cycle dialog box opens.

Parameter Description

Number of Cycles Lets you specify the number of cycles, including the current selection.

Create Drawing from Drawing Selection Dialog Box
The Create Drawing from Drawing Selection dialog box lets you break down the main body parts of a character. 

There is no need to create any layers prior to this process. Make sure your model is well centered and sized in the 
Camera view.

You do not need to make clean cuts around your parts; a rough one is sufficient as long as it includes all the artwork 
of the part you want to break down. You will clean the extra bits and pieces later.

Using the Cutter tool, you can roughly cut the main sections, and then use the Select tool to select precise lines and 
colour zones.

For tasks related to this dialog box, see Breaking Down the Main Parts on page 1.

How to access the Create Drawing from Drawing Selection dialog box

 1. In the Timeline view, select the cell of the model that corresponds to the first view to break down.

 2. In the Tools toolbar, select the Cutter  tool.

‣ If you prefer to use the Select  tool, choose the Select  tool from the Tools toolbar or press Alt + S.

‣ In the Tool Properties view, you can switch to the Lasso  selection mode.

 3. In the Camera view, create a selection around the first part to break down. If you click on a zone, the Cutter 
tool will select the zone. It will end the selection at the first point of intersection that it meets.
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‣ Hold down Shift to create a new lasso selection around another zone and add it to your previous 
selection.

 4. From the top menu, select Edit > Create Drawing From Drawing Selection or press F9 (Win-
dows/Linux) or ⌘  + F9 (Mac OS X).

The Create Drawing From Drawing Selection dialog box opens.

Parameter Description

Layer Name
Lets you enter a name for the layer using the naming convention you 
established.

Cut Artwork From Source Lets you cut the selected artwork from the model.
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Create Palette Dialog Box
The Create Palette dialog box lets you create a palette in Basic mode. For simple productions, it is recommended to 
use the Basic mode.  This setting stores the palettes automatically for you and saves them at the Scene level. When 
you use the Advanced Palette Lists mode, you can decide at which level you want to store your palettes: 
Environment, Job, Scene, or Element. 

For tasks related to this dialog box, see Creating a Colour Palette  on page 1.

How to access the Create Palette dialog box

 1. From the Colour view menu, select Palettes > New or click the New Palette button.

‣ Make sure you have the rights to modify the palette list. If not, select  Edit > Edit Palette List Mode.

The Create Palette dialog box opens.

 2. Enter the palette name according to the model. 

 3. Click OK.

The palette appears in the drawing element’s palette list.

Parameter Description

New Palette Name Lets you enter a name for the new palette.

Database Selector Dialog Box
The Database Selector dialog box lets youWhen you connect to the database, you cannot create new scenes 
directly from Harmony Premium. The available scenes will be the ones that were previously created using the 
Control Center.  connect to your studio's central database when working on Harmony Server. 
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For tasks related to this dialog box, see Connecting to the Database on page 1.

How to access the Database Selector dialog box

 1. Start  Stage.

The Database Selector dialog box opens.

Parameter Description

Environments Lets you select the scene's environment (project, movie).

Jobs Lets you select the scene's job (episode, sequence). 

Scenes Lets you select the scene.

Get rights to modify the scene
Allows you to modify the selected version of the scene and access the version 
manager during the opened session

Get rights to modify the scene 
version

Allows you to modify the currently selected scene version, but locks access to 
the version manager during the opened session.

Get rights to modify all scene 
assets

Automatically gets the rights to modify the scene and its assets. The user 
locking the scene using this option is the only one that can edit and save the 
scene version, all the drawings in that scene, all the palettes in the palette-list, 
both palette-lists, but not the library folders.

Version
If you saved different versions of a scene, this lets you select one to open—see 
Saving a Scene on page 1.

Drawing Dialog Box
The Drawing dialog box lets you add, delete or modify elements (drawing folders) in your scene.
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For tasks related to this dialog box, see Modifying Layers and Columns on page 1.

How to access the Drawing dialog box

 1. In the Xsheet view, double-click on a column name. Do not click on the drawing folder name that the column 
is linked to (this also appears in the column header just below the column name).

Parameter Description

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Element

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Vector
Select this option if the new element is a vector drawing or if you want to enable 
the parameters on the selected element in the Elements list.

Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Scan module, 
select the scan type from the list.

Field Chart
If you're importing traditional animation, select the size of the paper on which the 
animation was drawn.

Edit Default Paste Preset Dialog Box
The Edit Default Paste Preset dialog box lets you modify settings for the keyframe and exposure paste presets, as 
well as setting the defaults.
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How to access the Edit Default Paste Preset dialog box

1. From the Timeline menu, select Edit > Modify Paste Presets > All or Key Frame or Exposure.

Parameter Description

Drawings

Add/Remove Exposure

 

Never create drawing files: When adding exposures to a drawing layer, 
drawing files will not be created.

Only create drawing files when they do not exist: When adding exposures 
to a drawing layer, new drawings will be created only when drawings with the 
same name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure
If there are key exposures that exist on copied drawings, they are preserved 
when pasting. No key exposures are added. This is the default behavior when 
pasting.

Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key 
Exposure

Fills selected area till the next key exposure.

Keyframes

Add/Remove 
Keyframes

Motion: Copies the properties of the selected motion keyframe to the new 
frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.
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Force Keyframes at Function's Beginning and End: Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.

Edit Exposure Paste Preset Dialog Box
The Edit Exposure Paste Preset dialog box lets you reuse key exposures as you animate.  There are different 
options to paste your selected drawings when they contain key exposures:

Enforce Key Exposure: If there are key exposures that exist on copied drawings, they are preserved when pasting. 
No key exposures are added. This is the default behavior when pasting.

Fill Gap with Previous Drawing: Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key Exposure: Fills selected area till the next key exposure.

For tasks related to this dialog box, see Using Paste Special on page 1.

How to access the Edit Exposure Paste Preset dialog box

 1. In the Timeline or Xsheet view, select the drawings you want to copy and press Ctrl + C (Windows/Linux) or 
⌘  + C (Mac OS X). 

 2. In the Timeline or Xsheet view, select the cell where you want your pasted selection to start.

 3. From the Timeline view menu, select Edit > Modify Paste Presets > Exposure.

The Edit Exposure Paste Preset dialog box opens.

Parameter Description

Drawings

Add/Remove Exposure

 

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.
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Only create drawing files when do they do not exist: When adding exposures 
to a drawing layer, new drawings will be created only when drawings with the 
same name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure Creates a key exposure on the same drawing.

Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Keyframes

Add/Remove Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End:  Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.

Reset to Default Return all values to their defaults.

 

Export Soundtracks Dialog Box
The Export Soundtracks dialog box lets you export a sound file to use it in another application, such as an editing 
software. Harmony allows you to export sound files as a merged soundtrack or as a series of individual files. The 
exported soundtracks are generated as *.wav files.

For tasks related to this dialog box, see Exporting a Sound File on page 1.

How to access the Export Soundtracks dialog box

 1. From the top menu, select File > Export > Soundtrack.

The Export Soundtracks dialog box opens.
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Parameter Description

Output Lets you specify the location in which the file will be exported.

Export Range

All Exports the sound over all the frames of your scene.

Frames Sets the start and end frames in the corresponding fields on the right.

Options

Process Soundtracks 
Individually

Each soundtrack from all layers is exported as individual files.

Merge All Soundtracks

One single file is created, combining all the sound files you imported in your 
scene. Note that it will only use the sound files in the selected frame range set in 
the Export Range section. If you selected to export all the frames, all the sound 
files will be processed.

Sound Settings

Rate Lets you set the rate of the soundtrack.

Size Lets you export the soundtrack at 8 or 16 bits.

Use Lets you export the soundtrack as mono or stereo.

Export to Flash Movie Dialog Box
The Export to Flash Movie dialog box lets you export your animation as a Flash (.swf) movie. 

The SWF export supports some bitmap effects (which can be previewed in Render View  mode) and SWF Blend 
Modes (vector effects which can be previewed in OpenGL View  mode).

The following are also supported:

• Pencil line thickness: They are converted to brush strokes in the .swf file.

• Auto Patch node for creating joint patches.

• Burn-in information incuding time code, frame number and scene information—see Burn-In on page 1.
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If you have not already done so, you should preview the .swf by using the SWF preview  button to see what 
the two types of effects look like when blended together. Once you are satisfied with the results, go ahead and 
export your movie. 

For tasks related to this dialog box, see Exporting an SWF Movie on page 1.

How to access the Export to Flash Movie dialog box

 1. From the top menu, select File > Export > SWF.

The Export to Flash Movie (.swf) dialog box opens.

Parameter Description

Output Lets you specify the location in which the file will be exported.

Display Source
Lets you select a Display node to read from in the Export From Display Node 
menu.

Export Range

All Exports all the frames of your movie.

Frames Export a frame range which you specify

Options

Frame Rate

Lets you enter a Frame rate (fps). By default, it will be set to match the fps of 
your Harmony project. If you choose a lower frame rate, your export playback 
will be faster than your actual project. The reverse is also true for a higher 
frame rate. 

Jpeg Quality
Lets you select a JPEG quality:

‣ 100 = Full quality
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‣ 50 = Average quality at about 1/5th of the size.

‣ 25 = Medium quality where loss of high image resolution starts to 
occur.

‣ 10 = Low quality where “macro-blocking” or large pixelation become 
obvious.

‣ 1 = Lowest quality where there is extreme loss of colour and detail 
and the image becomes nearly unrecognizable. 

Protect from Import Prevents the movie from being imported into another application.

Convert Pencil Lines to 
Brush Lines

Retains the thickness of pencil lines.

Compress Movie
Compresses the movie for a lighter format. The movie may lose some quality, 
but the file will be lighter.

Do Not Export

Lets you select the effects you do NOT want to be rendered in the SWF movie.

NOTE: Certain Harmony effects are not listed in this section as they are not 
compatible and therefore not available for SWF export. These effects will not 
appear in the SWF render. 

Export to QuickTime Movie Dialog Box
The Export to QuickTime Movie dialog box lets you export your animation as a QuickTime movie. To render a 
QuickTime movie with transparency, you need to set the Depth to Millions of Colours +. You can set this this when 
exporting a QuickTime movie.

If you added burn-in information to your scene, it will be included in your exported file—see Burn-In on page 1.

For tasks related to this dialog box, see Exporting a QuickTime Movie on page 1.
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How to access the Export to QuickTime Movie dialog box

 1. From the top menu, select File > Export > Movie.

Parameter Description

Output

Browse
Lets you select a folder in which to save your movie and give it a file name for 
the export.

Display Source

Export from Display Node

If there is no Display node in the scene, the drop-down list will indicate Display 
All and render the scene in the same order as the Timeline view, including 
nodes floating in the Node view. It is always recommended to render from the 
Display node, located under the final Composite node, unless you want to 
render a specific section isolated by a particular Display node.

Export Range

All Exports the entire frame range.

Frames Lets you enter the frame range to export.

Resolution

Resolution list
Lets you select a resolution ratio. If you select Custom, you can enter the 
width and height.

Width and Height Lets you specify the width and height of the resolution.

Options

Movie Options
Opens the Movie Settings dialog box in which you can set the the compression 
settings for the movie you will export—see Movie Settings Dialog Box.

Expression Dialog Box
In Harmony, you can use expressions to automate the calculation of effect values based on the values in another 
function. An expression is a mathematical formula that allows you to manipulate the value in the source function 
to create new values for the destination effect.

The Expression dialog box is where you write expressions. It's a simple text editor that can handle incomplete or 
invalid JS programs although they will not be evaluated. Harmony can save and load invalid JS programs.

The Expression editor evaluates the current script at the current global frame and reports any errors or returns the 
numerical result of the program.

For tasks related to this dialog box, see Expression Columns on page 1.

How to access the Expression dialog box

 1. In the Xsheet view menu, select Columns > Add Columns or press Shift + C.

The Add Column dialog box opens.
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 2. In the Name field, type a name for the column.

 3. From the Type menu, select Expression and click OK.

 4. Double-click on the column's header to open the Expression dialog box.

The Expression dialog box opens.

Parameter Description

Name
Indicates the name of the expression column in the Xsheet. You can edit this 
name.

Description field Area in which you can type in expressions.

Extend Exposure Dialog Box
The Extend Exposure dialog box lets you extend the exposure of a selected cell in the Timeline or Xsheet.

For tasks related to this dialog box, see Filling Exposure on page 1.
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How to access the Extend Exposure dialog box

 1. Select a cell and do one of the following:

‣ From the top menu, select Animation > Cell > Extend Exposure.

‣ Press F5.

The Extend Exposure dialog box opens.

Parameter Description

Extend to Frame Lets you enter the frame up to which you want to extend the exposure.

Overwrite
Lets you expose the drawing in the frames and replace the drawings that were 
orginally there.

Insert
Lets you expose the drawing in the frames and move the subsequent frames 
forward in the Timeline view.

Fill Cells Randomly Dialog Box
The Fill Cells Randomly dialog box lets you fill in random values over a selection. You can give a maximum and a 
minimum value and create a range for Harmony to choose the random values from. The selection can be over one 
cell or a cell range in one column or more or an entire column or many entire columns.

For tasks related to this dialog box, see Filling a Selection Randomly on page 1.

How to access the Fill Cells Randomly dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 2. Do one of the following:
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‣ Select Animation > Cell > Fill Cells Randomly.

‣ In the Xsheet view, click the Fill Cells Randomly  button  (you may have to customize the toolbar to 
display it).

The Fill Cells Randomly dialog box opens.

Parameter Description

Minimum Value The lowest acceptable value. 

Maximum Value The highest acceptable value. 

Hold The exposure holding value.

Whole Numbers
If you are applying this to a drawing column, this option lets you avoid having 
decimal points.

Add Key Exposure After Inserts a key exposure after the frame following the last cell. 

Fill Exposure Using Render Changes Dialog Box
The Fill Exposure Using Render Changes dialog box lets you detect if a threshold of changes has occurred between 
two consecutive images and then expose the affected textures for further processing. It can be used for example to 
change the texture on a characters shirt only when the shape of the shirt is changed significantly from the previous 
frame.  This avoids unnecessary repetitive texture changes on every frame.

For tasks related to this dialog box, see Exposure Fill Using Render Change on page 1.
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How to access the Fill Exposure Using Render Changes dialog box

 1. In the Timeline view, select the textures or live-action sequence.

 2. From the top menu, select Scene > Default Display > desired Display node.

 3. From the top menu, select Animation > Exposure Fill > Using Render Change.

Wait while Harmony creates a low resolution render of the images to preview.

 4. In the Fill Exposure Using Render Changes window, use the Frame slider to view the motion change 
analysis.

 5. Based on your style preference, adjust the parameters to assign when the texture exposure changes will 
occur. You can adjust the type of filter to use for the motion detection, as well as threshold values to 
indicate what will be considered a big enough motion variation for an exposure change. 

Parameter Description

Changes Detection Settings

Frame: Use the slider to see when a change is necessary. A red edge 
indicates there is a large enough motion for the texture to change.

Use: Lets you use either the Red, Green, Blue, or Alpha channel, or 
Luminance difference between frames to analyze the motion changes. The 
Alpha channel is selected by default as it is the most commonly used 
parameter.

Pixel Value Change Threshold: The percentage of change in a pixel to be 
considered different from one frame to another. The higher the value, the more 
change is required when comparing two images in order for a new texture to be 
used.
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Area Change Threshold: The percentage of non-empty pixels that must 
change from one frame to another to be considered different.

Fill Settings

These settings let you change the exposure. You can also decide on how 
many images you want to cycle. 

First/Last Frame: Lets you set the first and last frame for the exposure 
change. You can set this for the entire scene or for part of the scene (frames 20 
to 32 for example).

 Number of Drawings in Cycle: Lets you set of the number of drawings to 
include in the cycle.

 First Drawing Used in Cycle: Lets you set the first drawing used in the cycle. 
Your drawings must be named using numeric values only, or number values 
with a prefix or suffix. It cannot only be letters.

 Drawing Name Prefix: Adds a prefix before the number. For example, 
texture_01, texture_02 and so on.

 Drawing Name Suffix: Adds a suffix after the number. For example, 01_
texture, 02_texture and so on.

Fill Selection Dialog Box
The Fill Selection dialog box lets you fill the same value over an entire selection. The selection can be over one cell, 
a cell range in one column, a cell range over many columns, an entire column, or many columns. You can use 
numbers, words, letters, or any alphanumeric value.

For tasks related to this dialog box, see Filling a Selection with a Single Exposure on page 1.

How to access the Fill Selection dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 1. Do one of the following: 

‣ From the top menu, select Animation > Cell > Fill Selection. 
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‣ In the Xsheet toolbar, click the Fill Selection  button (you may have to customize the toolbar to 
display it).

‣ Press Ctrl + T (Windows/Linux) or ⌘  + T (Mac OS X)).

The Fill Selection dialog box opens.

Parameter Description

Value

Add Key Exposure After Inserts a key exposure after the frame following the last cell. 

Import Images Dialog Box
The Import Images dialog box lets you  import bitmap images and vectorize them, making the images editable. 
Then you can use a variety of drawing tools to edit the image. Or you can always keep the original bitmap image 
as is.

Also, you can choose to import bitmap images on bitmap or vector layers depending on your project..

For tasks related to this dialog box, see How to Import Bitmap Images on page 1 and Importing Bitmap Images  
on page 1.

How to open the Import Images dialog box

 1. Do one of the following:

‣ From the top menu, select File > Import > Images. 

‣ In the File toolbar, click the Import Images  button.

‣ In the Xsheet view, right-click anywhere in the frame area and select Import > Images.

The Import Images dialog box opens.
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Parameter Description

Files

Browse Lets you find and select images on your computer.

Layer

Create Layers(s) Lets you create layers for imported images.

Create Single Layer 
Named

Creates a layer you can name.

Create Layer(s) Based 
on Filenames

Creates a layer based on each unique filename prefix. For example, the filenames 
a-1.tga, a-2.tga and b-1.tga will create layers name "a" and "b", where "a" has two 
drawings and "b" has one. When creating a single layer from these three 
filenames, all three drawings will be inserted in the new layers.

Add to Existing Layer Lets you select an existing layer to which imported images will be added.

Create Symbol for 
Import Items

Encapsulates imported item in a symbol.

Import Options
Depending on how you choose to import images, the Alignment section offers 
different options.

Keep as Original 
Bitmap

Retains an imported image as a bitmap. In the Alignment section, decide on the 
size and placement of your image within the camera frame. Depending on the 
Scene Settings (the height and width in pixels that you chose for your project), an 
image that you import may get scaled to the point where all its individual pixels 
become visible.

Import as Toon Boom 
Bitmap Drawing

Imports a drawing into a vector layer where you can edit the image using the 
drawing tools.

Convert to Toon Boom 
Vector Drawing

Imports a drawing and converts it to a Toon Boom vector drawing.
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Alignment 

Rules

Horizontal Fit: 

Enlarges or shrinks (but not distorts) the image height to match the full height of 
the scene grid.

Vertical Fit: 

If the image orientation is landscape, this will enlarge or shrink (but not distort) the 
image width to match that of the scene grid.

Note that the Fit alignment rule equals the Center Fit rule in the layer properties.

Actual Size: Scales the image in proportion to the scene's resolution. The 
system looks at the resolution of the bitmap image, for example 4000 x 2000, then 
compares it to the scene's resolution, for example 1920 x 1080, and adjusts the 
scale factor in proportion. So, in this example, the bitmap would appear at 208% 
(4000/1920). If you import a bitmap that is 960 x 540, it will be displayed at 50% 
(960/1920) of the size of the project resolution.

 

Fit:

Enlarges or shrinks (but not distorts) the image height to match the full height of 
the scene grid.
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If the image orientation is landscape, this will enlarge or shrink (but not distort) the 
image width to match that of the scene grid.

Note that the Fit alignment rule equals the Center Fit rule in the layer properties.

 

Pan: 

This is the opposite of the Fit parameter. If the image orientation is portrait, its 
width will be made to match the width of the scene grid. As a result, part of the 
image’s height will extend beyond the height of the frame. This can be useful if 
you want to make your background move up and down, or from left to right to 
make it appear as if the camera is panning or to actually perform a camera pan.

39



Chapter 1: Dialog Boxes     

The opposite will apply to a landscape image. Its height will be fit to the scene 
grid, therefore it is possible that the image will extend beyond the scene grid's 
boundaries.

Note that the Pan alignment rule equals the Center First Page rule in the layer 
properties.

This is the opposite of the Fit parameter. If the image orientation is portrait, its 
width will be made to match the width of the scene grid. As a result, part of the 
image’s height will extend beyond the height of the frame. This can be useful if 
you want to make your background move up and down, or from left to right to 
make it appear as if the camera is panning or to actually perform a camera pan.
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The opposite will apply to a landscape image. Its height will be fit to the scene 
grid, therefore it is possible that the image will extend beyond the scene grid's 
boundaries.

Note that the Pan alignment rule equals the Center First Page rule in the layer 
properties.

 

Project Resolution: Scales the image in proportion to the scene's resolution. The 
system looks at the resolution of the bitmap image, for example 4000 x 2000, then 
compares it to the scene's resolution, for example 1920 x 1080, and adjusts the 
scale factor in proportion. So, in this example, the bitmap would appear at 208% 
(4000/1920). If you import a bitmap that is 960 x 540, it will be displayed at 50% 
(960/1920) of the size of the project resolution.

Transparency

Alpha

Premultiplied with White: Individual pixels at the edge of an image are blended 
with white.

Premultiplied with Black:Pixels at the edge of an image are blended with black.

Straight: Pixels at the edge of an image are blended with black, white and greys.

Clamp to Colour to Alpha:Premultiplies the colour value with the alpha value. 
When the colour is clamped to the alpha, the colour value cannot be higher than 
the alpha value. It calculates the real colour value faster. When the RGB values 
are multiplied with the alpha value, that is to say, if you have a pixel of value 
R=247, G=188, B=29 and the alpha is 50% or the image has a 50% transparency, 
then the actual RGB values that are output would be half of the amounts listed 
above. 
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Vectorization

Black and White Vectorizes drawings as a solid black line; creates a 100% vector-based drawing.

Grey
Vectorizes the image as a mix of vector contour and greyscale bitmap filling. 
Lines keep the texture from the scan, and the white of the paper becomes 
transparent.

Marker Colour Dialog Box
The Marker Colour dialog box lets you set the colour of scene markers that are displayed at the top of the Timeline 
view (in the frame counter area). Using colours for scene markers helps to differentiate them visually, making 
them easy to identify in the Timeline view.

You can select a colour by choosing from a basic set of colours, using the colour wheel or by specifying the HSV 
or RGB values. Once you have selected a colour, you can adjust its intensity and save it as a custom colour that 
you can reuse.

For tasks related to this dialog box, see Setting Scene Markers on page 1.

How to access the Marker Colour dialog box

 1. In the frame counter area of the Timeline view, select a frame range to mark.

 2. Right-click and select Create Scene Marker.

The Timeline Scene Marker dialog box opens. The Colour box displays a black colour swatch, or the 
colour of the last scene marker you created.
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 3. Click the colour swatch.

The Marker Colour dialog box opens.

Parameter Description

Basic colours The basic set of colours in the system? 

Custom colours Displays the custom colours you created. 

Add to custom colours Lets you add the selected colour to the Custom colours list above.

Colour wheel Lets you select a colour by dragging the T-shaped pointer.

Value slider
Once you select a colour, you can drag the slider to change the intensity and see 
it previewed in the Colour Preview window below.. 

Colour Preview Displays the colour you are currently selecting. To apply the colour, click OK.

Hue, Saturation, Value
Lets you set the hue (colour), saturation (amount of colour) and brightness (value) 
of the colour.

Red, Green, Blue Lets you set the red, green and blue values.

 

Movie Settings Dialog Box
The Movie Settings dialog box lets you set the compression settings for the movie you will export.

For tasks related to this dialog box, see Exporting a QuickTime Movie on page 1.

How to access the Movie Settings dialog box

 1. From the top menu, select File > Export > Movie.

 2. In the Export to QuickTime Movie dialog box that opens, click Movie Options.

Parameter Description
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Video

Settings
Opens the Standard Video Compression Settings dialog box. This is where you 
can set the video compression settings for the movie you will export—see 
Standard Video Compression Settings Dialog Box on page 92.

Filter
Opens the Choose Video Filter dialog box, where you can select from a range of 
filters to apply to your video export.

Size
Opens the Export Size Settings dialog box. The size settings are overridden by 
the Harmony's scene settings.

Sound  

Settings
Opens the Standard Video Compression Settings dialog box. This is where you 
can you set the sound compression settings for the movie you will export—see 
Sound Settings Dialog Box on page 91.

New Tool Preset Dialog Box
The New Tool Preset dialog box lets you create new tool presets and manage them. 

Tool presets let you save a variety of settings and are very handy and efficient for accessing the tools you use 
most often. That way, the tool is already set with the desired properties, such as colour, line thickness, whether 
to enable Draw Behind or Auto Flatten mode, and so on. You can create presets for these tools and many more: 
Brush, Pencil, Eraser, Rectangle, Ellipse, and Line. First, select a tool, adjust the properties, and then create a 
tool preset for it. Once you have created a tool preset, you can always make adjustments to fine-tune it, as well 
as create a keyboard shortcut for it.

For tasks related to this dialog box, see Working with Tool Presets on page 1.

How to access the New Tool Preset dialog box

 1. Do one of the following:

‣ From the top menu, select Windows > Toolbars > Tool Presets.

‣ Right-click an empty area below the top menu and select Tool Presets.
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 2. In the Tool Presets toolbar, click the New Tool Preset   button.

Parameter Description

Name Lets you give the preset a meaningful name.

Icon list Lets you select an icon for the preset.

Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the preset.

Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any tool. 
The colour preset would then work on any selected tool. Selecting the brush tool 
was only a vehicle to get into the New Tool Preset dialog box. 

Palette Browser Dialog Box
When you start Toon Boom Harmony connected to the database, you can access the Palette Browser dialog box 
from the Palette Operations dialog box when you want to clone palettes. 

In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. When a palette is created 
from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene directory in a 
palette-library folder unless you specify a different location.

For tasks related to this dialog box, see Palettes on page 1 and Palette Operations on page 1.

How to access the Palette Browser dialog box

 1. Start Harmony and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 
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 1. In the Palette Operations dialog box that opens, select the palette you want to clone at the location and 
level in which it was stored. 

 2. Click Clone.

Parameter Description

Palette Location

Environment
The production, project, feature film or series—see Environments and Their 
Structure on page 1.

Job The episode and sequence from each environment.

Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

New Palette Name
Lets you enter a name for the new palette. There is no need to add the suffix 
"palette"  to the name as it is always recognized as a palette file.

Palette List

Scene Palette List

The Scene Palette List is mainly used with cut-out animation. A cut-out 
character will often be divided in twenty to thirty different drawing elements 
that use the character's master palette. 

The palette list is stored at the scene level instead of the Element directory. 
This way, all palettes linked to this list will appear in every drawing element 
created in the scene. There is no need to manually load the palette in each 
element. 

Element Palette List

The Element Palette List is mainly used with traditional and paperless 
animation. Unlike cut-out animation, all columns (drawing elements) contain 
different characters, props, backgrounds and effects. The Element Palette List 
is used because you do not necessarily want all of the palettes for all of your 
elements linked in every column. 

The palette list is stored in the drawing element's directory instead of directly in 
the Scene level. This ensures that the links to the palettes appear only in the 
appropriate element. If you prefer to access a global palette list, link your 
palettes to the Scene Palette List.

Palette Operations Dialog Box
When you start Toon Boom Harmony connected to the database, you can access the Palette Operations dialog 
box which lets you clone, rename, or delete palettes. 

In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. When a palette is 
created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene 
directory in a palette-library folder unless you specify a different location.

There are four locations where you can find palette-library folders: Element, Scene, Job and Environment.
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For tasks related to this dialog box, see Palettes on page 1 and Palette Operations on page 1.

How to access the Palette Operations dialog box

 1. Start Harmony and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

Parameter Description

Environment
The production, project, feature film or series—see Environments and Their 
Structure on page 1.

Job The episode and sequence from each environment.

Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

Description Notes, if any, of the project.

Clone
Opens the Palette Browser dialog box from which you can select the level in 
which to store the palette file—see Palette Browser Dialog Box on page 45.

Rename Lets you rename a palette.

Delete

Lets you delete a palette.

IMPORTANT: It is not recommended to disable the warning message that 
appears when you are attempting to delete a palette as this operation cannot be 
undone.

Close Closes the Palette Operations dialog box.

Paste Special Dialog Box
The Paste Special dialog box lets you determine how templates and symbols are imported in the Timeline view. 

When you import a template in the Timeline view, all layers are created as well as drawings and keyframes. You can 
choose to import only the keyframes without the drawings or import only the drawings that are not already in your 
layers. You can adjust the behaviour using the Paste Special dialog box.When you import a symbol in your scene, 
its full length is exposed by default. If you import a symbol in the Timeline view’s left side, all the frames will be 
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exposed. However, if you import it into an existing layer, you can use the Paste Special dialog box to adjust the 
import behaviour to fit your requirements.Once you set the parameters, Harmony will reuse them each time you 
import a symbol in the Timeline view’s right side until you set new parameters.

For tasks related to this dialog box, see Using Paste Special on page 1.

How to access the Paste Special dialog box

 1. In the Library view, select the symbol or template to import.

 2. Press Ctrl + B (Windows/Linux) or ⌘  + B (Mac OS X) and drag the selection to the Timeline view.

NOTE: Drop the selection in the Timeline view before releasing the keyboard shortcut key.

The Paste Special dialog box opens.

Basic Tab

Parameter Description

Drawings

Only create drawing 
files when they do not 
exist

When adding exposures to a drawing layer, new drawings will be created only 
when drawings with the same name do not already exist in the destination.

Always create drawing 
files

When adding exposures to a drawing layer, new drawings will always be cre-
ated. If drawing files with the same name already exist, Harmony will create a 
new name for the drawing.

Paste all Frames of the 
Symbols (full movie)

When enabled, the Paste Special command exposes all the symbol's frames 
instead of only the first one.

Enforce Key Drawings Creates a key exposure on the same drawing.

Cycle

Number of Cycles Lets you set the number of cycles.

Cycle Type Normal (forward): Pastes your selection as is, starting with the first cell and 
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ending with the last.

Reverse: Pastes your selection in reverse, starting with the last cell and 
ending with the first.

Forward > Reverse: Pastes your selection as a yo-yo, starting with the first 
cell, going to the last one and ending with the first cell.

Reverse > Forward: Pastes your selection as a reverse yo-yo, starting with 
the last cell, going to the first one and ending with the last cell.

Advanced Tab

Parameter Description

Drawings

Do Nothing Does not create or overwrite drawings.

Update Drawing Pivot
Revises the drawing pivot in the destination to use the same drawing pivot as the 
first drawing in the template. If you have a range of drawings selected in the 
destination, the pivot points of all selected drawings will be updated.

Add/Remove Exposure
Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.
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Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Replace existing drawings. Create drawing files when they do not exist: 
Replace drawings with the same names to update a scene with new modified 
drawings and preserve the animation.

Tip: If you don't want to lose the existing animation when pasting a 
template,  such as when placing new drawings after the animation, 
then delete the template's animation.  It will still have updated the 
drawings but not override the existing animation.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Paste all frames of the symbol (full movie): When enabled, the Paste Special 
command exposes all the symbol's frames instead of only the first one.

Enforce Key Exposure: If there are key exposures that exist on copied draw-
ings, they are preserved when pasting. No key exposures are added. This is the 
default behavior when pasting.

Fill Gap with Previous Drawing: Fills selected area in the Xsheet or Timeline 
view with the previous drawing.

Fill to Next Key Exposure: Fills selected area till the next key exposure.

Add Remove/Keyframes

Motion Copies the properties of the selected motion keyframe to the new frame.

Velocity Copies the properties of the selected velocity keyframe to the new frame.

Rotation Copies the properties of the selected rotation keyframe to the new frame.

Scale Copies the properties of the selected scale keyframe to the new frame.

Skew Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at 
Function's Beginning 
and End

 Adds a keyframe to the beginning and end of the pasted function, reproducing the 
source function.

Offset Keyframes
When pasting functions, offsets keyframes from the function's last frame value 
by the values in the pasted function. This will continue the progression of a func-
tion instead of repeating the values.

Options

Palettes

Do nothing: Does not create, overwrite, merge or link palettes.

Reuse palettes. Copy palettes if they do not exist: Palettes in the destination 
drawings are left as they are.

Copy and overwrite existing palettes: Overwrites destination palettes with the 
palettes from the source drawings.

Copy and create new palette files: Creates new palette files, placing them at 
the same relative environment and scene level as the source. If the palettes in the 
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templates were stored at the environment level of the source scene, the paste 
operation will place the palettes in the environment level of the destination scene.

Copy and create new palette files in element folder: Creates new palette files 
in the element folders of the destination scene, rather than in the same relative job 
or environment.

Copy palette and merge colours. Add new colours only: Adds new colours to 
the destination palettes and ignores colours that are the same in the two palettes.

Copy palettes and update existing colours: Adds new colours to the 
destination palette and updates duplicate colours in the destination with colour 
values from the source.

Link to original palettes (colour model): Links the colour palettes in the 
destination scene to the palettes in the source. Use this to link drawings to the 
palettes in a colour model.

Copy scene palettes and merge colours. Add new colours only: Adds new 
colours to the destination scene palettes and ignores colours that are the same in 
the two palettes.

Copy scene palettes and update existing colours: Adds new colours to the 
destination scene palette and updates duplicate colours in the destination with the 
colour values from the source.

Symbols

Copy symbols if they do not exist: This is the default setting for this operation 
and will prevent Symbols in an Action template from being copied.

Duplicate symbols: Creates a duplicate of the symbol instead of linking the Sym-
bol instance to the original one. The new Symbol is created in the Library.

Cycles

Normal (forward):Pastes your selection as is, starting with the first cell and end-
ing with the last.

Reverse: Pastes your selection in reverse, starting with the last cell and ending 
with the first.

Forward > Reverse:Pastes your selection as a yo-yo, starting with the first cell, 
going to the last one and ending with the first cell.

Reverse > Forward: Pastes your selection as a reverse yo-yo, starting with the 
last cell, going to the first one and ending with the last cell.

Nodes
Create New Columns: A new column is created when you copy and paste 
nodes from the Node view or layer in the Timeline view. If the layers are linked to 
function curves, the function curves, drawings and timing will be duplicated.

Elements
Reuse existing elements: Lets you paste existing elements without creating 
new ones. This should be used only when pasting within versions of the same 
scene.

Preferences Dialog Box
The Preferences dialog box lets you adjust preferences to suit your work style, allowing you to work more efficiently.

NOTE: Some preferences require you to exit and restart the application, or close a view and reopen it.
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How to access the Preferences dialog box

Do one of the following:

‣ From the top menu, select Edit > Preferences (Windows/Linux) or Stage > Preferences (Mac OS 
X). 

‣ Press Ctrl + U (Windows/Linux) or ⌘  + U (Mac OS X).

Shortcuts Tab

To speed up your work, all of the keyboard shortcuts can be customized. You can even choose other software 
keyboard shortcut sets.

In Toon Boom Harmony, you can choose a set of default keyboard shortcuts you are familiar with. You can 
choose between the following:

• Adobe Flash

• Toon Boom Harmony

• Toon Boom Studio

You can also customize most of the shortcuts and use the search feature to find particular shortcuts.
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For tasks related to this dialog box, see Shortcut Preferences on page 1.

Parameter Description

Keyboard Shortcut List
Lets you choose a set of keyboard shortcuts to use, including Toon Boom 
Harmony, Adobe Flash and Toon Boom Studio.

Keyboard Shortcut Categories
Each category lists all the keyboard shortcuts. Some commands may not have a 
keyboard shortcut assigned to it. Selecting a shortcut displays its description on 
the right.

Restore All Defaults
Restores all the default keyboard shortcuts. This erases any custom shortcuts 
you made.

Press Shortcut Key Displays the keyboard shortcut assigned to a command.

Clear Lets you remove the keyboard shortcut assigned to a command.

Default Lets you return a keyboard shortcut to its default.

Search
Lets you search for a command. The result is highlighted in the Keyboard 
Shortcut Categories on the left.

Search by Name/Shortcut Lets you search for a command by its name or keyboard shortcut keys.
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General Tab

Parameter Description

Save 

Open in Read Only mode if plugin syntax errors are detected: 
Opens scenes that contain plugin node errors in read-only mode to 
prevent you from losing plugin information on subsequent saves.

Auto-Save:

• Interval (minutes): This is the frequency at which the auto-save 
takes place.

• Inactivity Interval (seconds): When Auto-save is about to take 
place, it verify if you are drawing or doing anything in the 
application. If so, Auto-save waits this number of seconds before 
attempting another save.

• Ask Before Saving: Before performing an auto-save, the system 
will prompt you with a message to confirm if you want to save or 
not. You can choose to turn off this option.

• Enabled: This enables the Auto-save feature. If you do not want 
the system to automatically save your work, deselect this option. 
The auto-save is off by default.
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Automatically Save Workspace: This option is enabled by default. 
Every time you add a view to your workspace, remove a toolbar or 
change a view’s width, these modifications are saved when you quit the 
application. If you do not want the system to save these modifications, 
disable the preference. This preference does not require you to restart the 
application.

Colour Management

Default to Element Palette Lists: When this option is enabled the new, 
cloned, duplicated, imported and linked palettes will be stored in the 
Element Palette list instead of the Scene Palette List.

Interactive Colour Recovery: If a colour palette for your scene is 
deleted or cannot be found, you will be asked if you want to recover 
colours from the program’s memory. If this option is unchecked, the 
program recovers missing colours without displaying a dialog box for your 
input.

Colour Recovery: If this option is unchecked, colour recovery will not 
occur. 

Replacement Colours: If certain colours are no longer available, they 
are automatically replaced with the ones indicated by the Replacement 
Colour swatch. The default colour is red, as it acts as a missing colour 
warning device.

Colours

The Colours option allows you to modify the colours of the different user 
interface views and elements. For example, you can change the Camera 
view’s background colour from grey to white.

Altering these preferences requires you to restart the application or to 
close a view and reopen it for the modifications to be applied.

Current View Border: Sets the colour of the frame around the 
workspace view you are currently using, also known as focus. By default, 
the colour is red. Click on the red colour swatch to select a new colour in 
the Colour Picker window.

Current View Border in Template Edit: Sets the colour of the frame 
around the workspace view you are currently using when editing a 
template from your library view. By default, the colour is green. Click on 
the green colour swatch to select a new colour in the Colour Picker 
window.
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Edit Colours: Click on the Edit Colours button to open the Colours 
window.

Options

Auto Apply: When enabled, values entered or options selected in node 
editors are automatically applied to elements in your scene. The Apply 
and OK buttons are hidden in the Layer Properties when this feature is 
enabled.

Snap Keyframe: If two keyframes have the same value, they will both 
update to the same new position when the first of the two keyframes is 
modified. The previous keyframe has to be a Stop-Motion keyframe.

Editors Always on Top: When enabled, the Layers and Function Editors 
are on top of the main window.

Close Previous Editors: Closes previously opened editors.

Focus on Mouse Enter: 

Disabled by default. In Toon Boom Harmony, for the operations or 
keyboard shortcuts to work in the view in which you are working, the 
focus must be in that view. When the focus is on a particular view, a red 
rectangle appears around its frame. You must click in the view or on the 
view’s header for the focus to be done.

If you enable the Focus on Mouse Enter preference, you will not need to 
click in the view to get the focus. It will be done as soon as your mouse 
enters the view.

NOTE: If you enable the Focus On Mouse Enter preference, certain 
operations from the top menu may not be available since the view focus 
may change as you make your way to the top menu. In this case use 
keyboard shortcuts and quick access menus (right-click menus).

Shortcut Zooms on Mouse: When enabled, shortcut zooming will centre 
on the cursor location.

Auto Render: Automatically enables the Auto-Render option.

Cycle Exposure: Make navigation in the Xsheet View wrap-around from 
the last frame or the last column to the first. 

Display Cardinal Coordinates: Display coordinates through application 
either scalar (ex:+1 -1) or cardinal (1N1S).

Flat Tool Toolbar (Requires Relaunch): 

Lets you expand the toolbar so there are no nested toolsets in the toolbar. 
You will need to close Harmony and relaunch it for the new interface to be 
displayed.   A default set of tools will appear in the toolbar. However, you 
can customize which tool icons appear in the toolbar to fit your own work 
pattern.

Once you have enabled the Flat Tool Toolbar preference, you can 
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customize the tools that appear in the toolbar. This means you can 
change the default set of tools and replace the tools which you use less 
frequently with ones which are used more often. This customizing is done 
through the Toolbar Manager—see Managing the Toolbars on page 1.

Use Dark StyleSheet (Requires Relaunch): Application loads a dark 
skin for the User Interface. 

Settings

Stop-Motion Keyframes: New keyframes are created as stop-motion 
keyframes. 

Default Separate Position for Pegs: New pegs are created with 
separate position functions.

Default Separate Scale for Pegs: New pegs are created with separate 
scale functions.

Default Separate Position for Elements: New elements are created 
with separate position functions.

Default Separate Scale for Elements: New elements are created with 
separate scale functions.

Default Bezier: New functions curves are created as Bezier Curves.

Default Bezier Velocity: New velocity curves are created as Bezier 
Curves.

Field Chart: 

• X: Default value for the number of units in the X axis (east-west) of 
the field chart used for new scenes. This value should be half the 
total number of units in the X axis of the field chart. This value will 
appear by default in the Alignment dialog box. 

• Y: Default value for the number of units in the Y axis (north-south) 
of the field chart used for new scenes. This value should be half 
the total number of units in the Y axis of the field chart. This value 
will appear by default in the Alignment dialog box. 

• Z: Default value for the number of units in the Z axis (front-back) of 
the field chart used for new scenes.  This value will appear by 
default in the Alignment dialog box. 

Levels of Undo: Determines the number of actions retained by the Undo 
list. By default, 50 actions are stored in the list. You can alter the number 
if you want to.

Touch Interface

Support Gestures: Enable the gestural touch interface for the OpenGL 
views. On Mac OS X, this determines whether a two-finger drag gesture 
is interpreted as a zoom or a pan. 

Invert Scroll Direction: Inverts the scroll direction. 

Touch Sensitivity: Control touch sensitivity. On Windows, higher 
numbers favour scale/rotates over pans. On Mac OS X, higher numbers 
give a slower response to pans. 
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Camera Tab

Parameter Description

Tools

Initial Animation Mode: Determines which animation mode is enabled when 
the scene is opened.

Show Locked Drawings As Outlines:  In the Camera view, locked elements 
are displayed as outlines only.

Bounding Box Selection Style: In the Camera view, selected elements are 
not highlighted in colour but displayed with the bounding box only. 

Nudging Factor: The nudging increment value.

Set Keyframe on All Functions with the Transform Tool: When this option 
is selected, the Transform tool will create a keyframe for all functions of the 
selected pegs, including the functions that normally would not be affected by 
the transformation.

Set Keyframe At Frame One With First Application of the Transform Tool: 
When this option is selected, wherever you set a keyframe on a layer, a 
keyframe is added on your frame 1. If this options is deselected, a keyframe is 
only added to the current frame. If later on, you add a keyframe on your frame 
1, it may modify the first keyframe you added.
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Paste/Drag&Drop Adds Keyframes at Beginning and End: Select this 
option to copy and paste a set of frames that includes an interpolated 
sequence between two keyframes, but only extracts a partial section. Under 
normal circumstances, cutting and pasting a function without either the start or 
end keyframe would render the function null. This option caps the partial 
function with a new keyframe when you perform the paste.

Select Tool Works on Single Drawing: By default, when you draw a 
selection box in the Camera view, the Select tool will select all the drawing 
strokes and symbols in its path. If you prefer the Select tool to only select the 
current drawing and not the other visible drawings, select the Select Tool 
Works on Single Drawing option.

Use Rotation Lever with Transformation Tools: Lets you see the rotation 
lever when using the transformation tools. When this option is deselected, 
hovering your cursor over the corner of an element’s bounding box is sufficient 
to rotate it.

Zoom Settings

Camera View Default Zoom: The default zoom value for the Camera view. 

Top/Side View Default Zoom: The default zoom value for the Top/Side 
views. 

Settings

Thumbnail Size: The thumbnail size, in pixels, that appears in the Top and 
Side views.

Small Bitmap Resolution: The size, in pixels, of the smaller bitmap version of 
your image. When you import a bitmap image into a scene, a smaller version of 
it is created in order to accelerate the compositing and playback processes.

Override Small Bitmap Files: Enable this option if you want the system to 
generate new versions of the existing smaller bitmap files, every time you 
modify the Small Bitmap Resolution value. When the option is disabled, the 
existing smaller bitmap versions will not be regenerated and will keep the same 
resolution as when they were created.

TV Safety: The ratio value for the TV Safety frame in proportion to the regular 
camera frame.

Wash Background

Enable in Camera: Dulls background bitmaps in the Camera view. This 
allows you to see other elements clearly, such as the ones that have not yet 
been painted. 

Enable in Camera Drawing Mode: Dulls background bitmaps in Camera 
view while using the drawing tools. This allows you to see other elements 
clearly, such as the ones that have not yet been painted.

Wash Background Percentage: The Wash Percentage value.

Control Points

Show Control Points On Selected Layers: By default, when you select an 
element with the Transform tool, the motion path related to the object is 
displayed.

Control Point Tension: The default Tension value for new keyframes and 
control points.

Control Point Continuity: The default Continuity value for new keyframes and 
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control points.

Control Point Bias: The default Bias value for new keyframes and control 
points.

Preview Wash

Enable For Out of Date Previews: When you disable the automatic render 
preview, you need to click on the Update Preview button  in the Rendering 
toolbar or the Camera view bottom toolbar in order to recalculate and update 
the preview. When this option is enabled, if the current render preview is out of 
date and requires you to press the Update Preview button, the Camera view 
will display the current preview as washed out colours.

Wash Background Percentage: This is the value, in percentage, by which 
the outdated preview will be washed out.

Inverse Kinematics

Min/Max Angle Constraint Weight: This value acts similar to the Stiffness 
setting in the Inverse Kinematics Properties panel. This option only affects the 
minimum and maximum angle values set using the Min/Max Angle Mode. The 
higher the value, the stronger your need to move the body part to approach the 
minimum and maximum values set. Although the maximum value goes up to 
1.0, in a production setting, the most practical value to use would be closer to 
0.1. 

Node View Tab
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Parameter Description

Navigator

Show Navigator: Shows or hides the display of the Navigator in the Node view 
when starting Toon Boom Harmony.

Navigator Starting Corner: Indicates which corner is the default Navigator 
position.

Magnifier

Width Multiple: Sets the width of the magnifier in tenths of the Node view width. 
Values range from 0.1–10.

Aspect Ratio: Sets the width to height ratio of the magnifier. Values range from 
0.1–10.

Opacity: Sets the transparency of the magnifier. Values range from 0–100. A 
value of 100 makes the magnifier completely transparent. A value of 0 makes the 
magnifier completely opaque.

Options

Cable Type: Displays node connections as Line (straight) or Bezier (curves).

Middle Mouse Button Pans the View: Lets you use the middle mouse button to 
pan the Node view.

Double Click on a Node Opens the Editor: Lets you open a node's property 
editor by double-clicking. 

Port Output Ordering: Orders the Output Port Right to Left or Left to Right.

Port Input Ordering: Orders the Input Port Right to Left or Left to Right.

Line Drawing Options

Antialiasing Quality: Smoothness setting applied to colour art. The higher the 
setting, the more antialiasing is applied. Higher quality images require more time 
to render and more system memory. Choose a lower quality if you are rendering a 
pencil test.

• Low: No antialiasing

• Medium Low: Some antialiasing

• Medium: Medium antialiasing

• High: Extensive antialiasing 

Antialiasing Exponent: Controls the amount of area around the Line and Colour 
Art edges used in the antialiasing process. A higher value uses less area, 
resulting in sharper edges, while a lower value uses more area, resulting in softer 
edges. If the Antialiasing Quality value is set to Low (no antialiasing), this value is 
ignored.

Read Colour: Controls the production of colour information from bitmap images. 
If this node reads 3 or 4-channel bitmaps, this selection determines whether the 
colour should be read or ignored. If this node reads 1-channel bitmaps, this 
selection determines whether the channel should be read as colour. When this 
option is selected with 1-channel images, the result will be a greyscale image.

Read Transparency: Controls the production of alpha information from bitmap 
images. If this node reads a 1 or 3-channel image, this option will create a matte 
from the colour values in the image. If the node reads a 4-channel image and this 
option is not selected, the alpha information in the image will be ignored.
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Alignment Rule: The Alignment position for the element node. The new element 
node will be created following this default rule of alignment.

Transparency Type:

• Premultiplied with Black: Pixels at the edge of an image are blended with 
black.

• Straight: Pixels at the edge of an image are blended with black, white and 
greys.

• Premultiplied with White: Pixels at the edge of an image are blended with 
white.

• Clamp Colour to Alpha: Select this option when you want to premultiply 
the colour value with the alpha value. When the colour is clamped to the 
alpha, the colour value cannot be higher than the alpha value. It calculates 
the real colour value faster. When the RGB values are multiplied with the 
alpha value, that is to say, if you have a pixel of value R=247, G=188, 
B=29 and the alpha is 50% or the image has a 50% transparency, then the 
actual RGB values output would be half of the amounts listed above.

Art Layer Options, Line Art/Colour Art:

• Vector/Bitmap: Determines if a newly created element will be a vector or 
bitmap layer. 
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Exposure Sheet Tab

Parameter Description

Filtering

These preferences are used to display or hide certain layer types in the Xsheet 
view.

Show Drawing Columns: Displays the Drawing layers in the Xsheet view.

Show Sound Columns: Displays the Sound columns in the Xsheet view.

Show Annotation Columns: Displays the Annotation columns in the Xsheet 
view. 

Show 3D Path Columns: Displays the 3D Path columns in the Xsheet view.

Show Function Columns: Displays the Function columns layers in the Xsheet 
view. 

Show Selection: Sets the Show Selection option On or Off by default in the 
Xsheet view. 

Centre on Current Frame: Turns auto-centering on or off when playing back a 
scene.  Auto-centering is used during sound breakdown with the ShuttleXpress 
device.

Options Default Add Columns: The default position where the new column will be added.
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Default Column Width: The default width value for the new column being 
created.

Drawing Creation

Use Current Frame as Drawing Name: Automatically names the drawing 
corresponding to the frame position. This avoids numbering conflicts while 
animating.

For example, using the default preferences, you start with the first drawing on 
frame 1, this drawing is called 1. You then draw the extreme position drawing on 
frame 10, this drawing is called 2. Next, the in-between pose is drawn on frame 5, 
this drawing is called 3 and so on.  

At the end, you have a sequence like this: 1-9-4-6-3-8-5-7-10-2.

Instead, using the Use Current Frame as Drawing Name option, each drawing is 
automatically named by its frame number and the sequence looks like: 1-2-3-4-5-
6-7-8-9-10.

Extend Exposure of Previous Drawing: When drawing on a blank frame, a new 
drawing is created and the timing is extended from the previous exposed drawing.

Zoom Levels

You can set the minimum and maximum zoom levels to view the Xsheet, 
depending on the number of columns and rows in the project. Once you set a 
level, close and reopen the Xsheet so the new values take effect.

Minimum Zoom Level: Lets you set the lowest level of zoom. Choose a value 
between 1 and 6.

Maximum Zoom Level: Lets you set the highest level of zoom. Choose a value 
between 14 and 20. 

NOTE: You can set a keyboard shortcut to view the entire Xsheet.
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Function Editors

Show Grid: When selected, the grid is displayed by default when opening the 
Function Editor.

Use Constant Z By Default: When selected, the Constant Z option will be 
enabled by default in the Function Editor.

Constant Z means that even when creating Motion keyframes, the Z function will 
use Stop-Motion keyframes and will not be interpolated, this can be very useful 
for cut-out animation. The Constant Z feature only works with 3Dpaths.

You can also enable the Constant Z option directly in the Function Editor or 
Function view for specific functions.

Gestural Drag
Default Setting for Gestural Drag: This is the default value enabling gestural 
dragging of cells in the Xsheet view. 

Apply/Next

From Left to Right: When clicking the Apply/Next button in the Xsheet view 
Column Properties, the next column to be displayed in the Column Properties will 
be the one on the right.

From Right to Left: When clicking the Apply/Next button in the Xsheet view 
Column Properties, the next column to be displayed in the Column Properties will 
be the one on the left.

New Element
Bitmap Format: By default, when you create a new empty bitmap column, it will 
use the file format indicated in the field as the new column format. The default 
value is SCAN, which means that it is set for scanned-in drawings.
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Drawing Tab

Parameter Description

Light Table

Light Table: Opacity (0,0-1,0):The maximum opacity value for the light table 
display (0 = transparent).

Light Table: Wash (0,0-1,0): The washed-out value for the light table display  
(0 = transparent).

Light Table: Enable Shade: When enabled, the drawings appearing on the 
Light Table are displayed in washed out colours in the Drawing view. When 
this option is disabled, the drawings appearing in the Light Table are displayed 
using normal colours. This option is for the Drawing view only.

Light Table: Shade in Camera View: When enabled, the drawings appearing 
on other layers are displayed in washed-out colours in the Camera view. When 
this option is disabled, the drawings appearing on other layers are displayed 
using normal colours. This option is for the Camera view only.

Enable Onion Skin for Other Elements: When both the Onion Skin and Light 
Table options are enabled, the drawings appearing in the Light Table also 
display their previous and next onion skinned drawings. This option is for the 
Drawing view only.
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Onion Skin Render Style:

• Normal: The onion skinned drawings are displayed in washed out 
colours.

• Enable Shade: The previous onion skinned drawings are displayed in 
washed out red shades and the next onion skinned drawings are 
displayed in washed out green shades.

• Outlines Only: The onion skinned drawings are displayed as outlines 
only.

Onion Skin: Maximum Wash Value (0,0-1,0): The maximum washed-out 
value for onion skinned drawings.

Onion Skin: Minimum Wash Value (0,0-1,0): The minimum washed-out 
value for onion skinned drawings.

Onion Skin: Maximum Opacity (0,0-1,0): The maximum opacity value for 
onion skinned drawings. (0 = transparent).

Onion Skin: Minimum Opacity (0,0-1,0): The minimum opacity value for 
onion skinned drawings. (0 = transparent).

Options

Grid On By Default: When opening the Drawing view, the grid displays 
automatically.

Select Tool is Lasso: When this option is enabled, the Select tool behaves as 
a lasso selector. When this option is disabled, the Select tool behaves as a 
rectangle selector.

Brush Size Cursor: When this option is enabled, the brush tool displays the 
brush size as a circle around the cursor.

Auto Gap Closing in Pixel Units: Disabling this option will cause your gap to 
be zoom dependent. Zoom dependent means that the more you zoom in, the 
smaller the gap you can close with the Close Gap tools. By enabling this 
option, you choose to make the gap display available in pixel units, which is 
not zoom dependent.

Default Multiwheel Colour Picker: Displays the Multiwheel Colour Picker 
window instead of the regular Colour Picker.

Auto Save Pencil Styles: When this option is enabled, new pens and pen 
styles are automatically saved.

Sticky Eye Dropper: Keeps the Colour Picker’s Dropper tool active until it is 
released by clicking on the Dropper icon again.

Desk Location: Defines the location of the Desk panel in the Drawing view.

Default Pencil Line Tip: Sets the default pencil line tip to either Round, Flat, 
or Bevel.

Morphing Quality: Sets the default quality value for the morphing sequences. 
If you change this value, it will not affect the morphing sequence which was 
created previously. After a morphing sequence has been created using this 
default quality value, its quality can be changed manually by using the 
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Morphing Tool Properties.

Auto Gap Closing on Startup: The values for automatic gap closing while 
painting drawings are: 0 = Disabled, 1=Small, 2=Medium, 3=Big.

Settings

Create New Colour Pots Using Default Colour: Set the default colour for 
creating a new colour swatch. Enable the option so that this default colour is 
used each time you add a new colour in your palettes. This option is useful for 
when you create new colour pots so that a more recognizable colour is created 
and not just a duplicate of the currently selected colour. Choosing a colour that 
is the opposite of your intended colour palette is recommended, such as grey if 
your palette will be filled with bright, primary colours.

Zoom

Enable Paper Zoom: Enabling this option allows you to set the 100% Zoom 
level onscreen, in order to physically match the measurements of your paper 
drawing.

Number of Pixels per Inch: Enter the PPI for your monitor. To obtain the PPI 
of your screen, divide the height or width of your monitor's resolution setting by 
the corresponding physical height or width  of your monitor screen (resolution 
height divided by physical height, or resolution width divided by physical width) 
in inches.

Quick Close Up Zoom Factor: Sets the zoom level for the Quick Close up 
Zoom keyboard shortcut. 

Maximum Zoom Factor: Sets the maximum zoom level for the paper zoom.

Default Canvas for Bitmap 
Layers

Sets the default values for the resolution, width and height of the canvas when 
working with bitmap layers in a new scene. This prevents you from creating 
unusually large bitmap canvases.

Template Tab

Parameter Description

Paste/Drag & Drop

Always Create New Drawings: By default, when you import timeline 
templates in the right section of the Timeline view, to stack them, the system 
will analyze and create only the non-existing drawings and only expose the 
existing ones. When enabled, this option automatically creates new drawings 
for every one of them that is exposed.

Palettes:

• Ask User: When dropping a template into a scene, the system will ask 
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if you want to link the palette to the original or create a local copy in the 
scene.

• Use Original Palette: The system will automatically link drawing 
elements to the original palette file. If the original palette is not 
encountered a local copy will be created.

• Use Copy of Palettes: The system will automatically create a local 
copy of the palette in the scene.

Editing Template
Generate Thumbnails Automatically: Automatically create thumbnails for 
the template when you want to see the thumbnails in the Library or when sav-
ing a template modification.

Timeline Tab

Parameter Description

Defaults

Show Groups: Displays the Group layers in the Timeline.

Show Effects: Displays the Effect layers in the Timeline.

Show Sound: Displays the Sound layers in the Timeline.

Show Sound Waveforms: Displays the imported sounds waveform in the 
Timeline.

NOTE: You can always toggle the visibility of the waveform in the Timeline view 
by adding the Show Sound Waveform  button from the Toolbar Manager. This 
button will work whether you have the Show Sound Waveform option enabled or 
disabled in the Preferences panel.

Show End of Scene Marker: Displays the red bracket that delineates the end of 
your scene in the Timeline view. If you know that many different hands will be 
working on your scene, you may want to deselect this option so the scene length 
is not increased or decreased by accident.
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Reduce Indentation: When this option is enabled, the horizontal indentation for 
parented nodes in the Timeline is reduced to optimize the amount of space taken 
in the Timeline. When you have a cut-out character and there is a long cascade of 
parented nodes, you can enable this option so the Timeline (left side) does not 
have expand too wide to see all your nodes.

Always Display Unconnected Nodes: Enable this preference if you prefer to 
see elements in the Timeline that have not yet been connected to a particular 
Display, even when in Normal View mode. This preference is not on by default.

Paste/Drag & Drop

Add Keyframes at Beginning and End: Copies and pastes a set of frames that 
includes an interpolated sequence between two keyframes, but only extracts a 
partial section. Under normal circumstances, cutting and pasting a function 
without either the start or end keyframe would render the function null. This option 
caps the partial function with a new keyframe when you perform the paste.

Overwrite exposures and keyframes during drag and drop: If the area on 
which you are dropping a selection contains exposures and/or keyframes, they 
are overwritten by the content you are selected by dragging.

Sound Tab

Parameter Description

Settings

Analog Sound Scrubbing: Switches from digital to analog sound scrubbing.

Analog Jog Speed: Lets you control the sensitivity of the jog slider or dial. 
Choose a value between 1 and 20. The higher the jog speed value, the slower 
you can scrub to have the sound play at an average pace.

Analog Jog Dampening: Lets you choose a value between 1 and 100 for the 
Analog Jog Dampening. The higher the value, the less precise Harmony is at 
responding to the jog's changes in speed. However, the more smooth the play 
back is using the jog slider or dial.
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OpenGL Tab

Parameter Description

Settings

Conservative Texture Management: Turns on and off conservative memory 
management for bitmap texture files. Performance will improve when this is 
enabled. If disabled, you will have a better on-screen rendering of bitmap files at 
the expense of slower performance.

Smooth Textures: Smooths out the pixels of bitmap images when zooming in; 
this improves bitmap image quality.

Alternate Gradient and Cutter: This is an alternative way to disable write in the 
OpenGL Backbuffer, required for some video cards (i.e. GeForce FX5200). Do not 
enable this option unless you are experiencing problems with gradients and 
cutters in OpenGL.

Use PBuffer for Picking: This will use an off-screen buffer for picking, resulting 
in a quicker response. This option should not be enabled if using a small capacity 
video card (32MB).

Support Triple Buffer: Enable this option for a better compatibility with Windows 
Vista if your video card driver does not allow to disable the triple buffering option. 
Not enabling this option may result in a dashing line when drawing a brush stroke.

Support Desktop Effects: Enable this option for better compatibility with 
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Windows 7, Windows Vista and Mac OS X desktop effects. This will prevent 
graphic compositing problems from happening when the full-scene anti-aliasing 
option is enabled.

Enable Mipmapping on Bitmap Layers: Generate anti-aliased mipmap 
textures. Disable this option for increased performance when working on Bitmap 
layers with non-standard graphic cards. 

Maximum Texture Size: The size that the bitmap file will be reduced to when 
using the Conservative Texture Management.

Texture Memory: The amount of temporary memory used to store bitmap texture 
files.

Vector Drawing Maximum Texture Size: This is the size that the .tvg file will be 
reduced to for better performance when in OpenGL render mode.

Full Scene Antialiasing

The Full Scene Antialiasing is generated by your computer’s graphic card. It 
provides a smooth line display in OpenGL. This antialiasing will not only antialias 
your drawings but all the different views in the interface.

This option lets you see smooth lines as you draw as well as an antialiased 
drawing area. You can change the value of the Full Scene Antialiasing using the 
Preferences dialog box to fit the current level used in the Camera or Drawing 
view.

Enable (Requires Relaunch): By default, this option is off. Select to turn on the 
Full Scene Antialiasing option. You'll need to restart Toon Boom Harmony.

Number of samples (For Mac OS): Enter the number of samples you want to be 
used for the antialiasing process. The number of samples is basically equivalent 
to the amount of time a pixel will be enlarged to calculate the antialiasing. This 
technique is called supersampling. The higher the number of samples, the better 
the antialiasing quality will be, but the longer it will take to calculate. The 
recommended value is 4.

NOTE: If you are using Windows or Linux, you must enable your graphic card’s 
antialiasing parameter. Refer to user guide of your graphics card. For example, 
the parameters for an NVIDIA GeForce card may look like this: 

Playback Images
Enable Playback Caching: Enable image caching for OpenGL playback.

Playback Cache Size (in Mb): Cache size in for playback images in Mb.
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Drawings

Enable Textures in Pencil Lines: Disabling this will produce a drawing 
performance improvement in OpenGL views. 

Enable Variable Line Thickness: Turns on and off the rendering of the variable 
line thickness option of the Element Node. 

Effects

Enable Tone and Highlight: Turns the Tone and Highlight effects on and off in 
the Camera, Top and Side views.

Enable Cutter: Turns the rendering of Cutter effects on and off in the Camera, 
Top and Side views.

Enable Composite Passthrough for All Effects: Controls the behaviour of 
composite passthrough in conjunction with effects that require a matte. This 
preference can be used in specific cases where certain nodes interfere with the 
OpenGL display of elements in the Camera view. This preference is off by 
default.

Enable Colour Override: Turns the rendering of the Colour-Override effects on 
and off in the Camera, Top and Side views.

Enable Glue Node: Turns the rendering of the Glue effects on and off in the 
Camera, Top and Side views.

Render Tab

Parameter Description

Preview Options

Enable Blur: Renders blur effects derived from the Blur-Directional, Blur-Radial, 
and Blur-Variable in the Render View window.

Enable Line Texture: Renders line texture in the Render view.

Enable Focus: Renders focus effects from the Focus-Apply and Focus-Set 
nodes.

Preview Images

Cache Size in RAM (in Mb): Cache size in RAM for intermediate preview 
images (Mb).

Cache Path and Capacity on Disk (in MB): If this field is left empty,          Harmony's 
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temporary directory will be used to offload intermediate images. There is no disk 
usage limit for the temporary directory.

When you specify a folder, you must type in the capacity (in MB) inside the 
path. Use the following method: path;capacity in MB;
example: C:\user\tmp_image_folder;2000;

NOTE: The specified folder must already exist. If there is an error in the path, 
Harmony’s temporary directory will be used. You can also specify a RAM drive 
in the path.

Multi Threading

This lets you specify the level of parallel processing done during the final image 
calculation (soft-rendering). Allowing parallel processing speeds up the soft-
render process.

Number of Rendering Threads: Lets you specify the number of parallel 
processes during the soft-render process. A value of 1 disables the multi-
threading process because it specifies that only one rendering thread will be used 
during the process. The maximum number of threads is 64. The recommended 
starting value is 2 threads per CPU core, meaning that if you are using a 2 Quad 
Core CPU, the preferences should initially be set to 16 threads.

GPU
Enable Graphic Card Acceleration: Optimizes the rendering blurs by using the 
GPU's acceleration capabilities. This option is on by default.  Not all cards support 
this acceleration.

Advanced Tab

Parameter Description

Advanced Options Support Overlay and Underlay Arts: When enabled, options to manipulate 
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overlay and underlay arts are available. 

Advanced Display: Enable or disable the Advanced Display mode.

Advanced Palette Lists: Lets you switch your palette list to Advanced Palette 
Lists mode for creating and storing palettes in the Scene or Element Palette 
List.

Restore Current Selected Drawing on Undo: If a drawing other than the 
current one is being affected by an Undo command, the affected drawing is 
displayed.

Advanced Element Mode: Displays more options in the Add Column dialog 
box and the Column Properties dialog box.

• Auto-rename Elements: Controls whether to rename the element 
whenever the corresponding node name in the Node view or layer name 
in the Timeline view is changed.

Support CMYK in PDF/Illustrator Import: Lets you import .pdf and .ai files 
that were created or exported in CMYK mode. The colours of the resulting 
imported image may still not look 100% faithful to its CMYK original due to the 
RGB conversion. It is recommended that you convert these files to RGB 
images before importing them into Toon Boom Harmony. Disabling this option 
will cause all the colours of the imported image to be displayed as red to 
indicate that the file was not converted to RBG before import.

PDF/Illustrator Import as Separate Layers: Imports  the different 
groups/elements of the .pdf or .ai file as separate layers. For Illustrator files, 
the import will use the top level group as separate layer names. Deselect this 
option to import pdf or .ai files as a single layer.

Element Node "Animate Using Animation Tools" Default Value: If you 
know that you prefer to work in the style of version 7.3 or earlier, or if you intend 
to substitute many drawings throughout your animation, you might wish to 
deselect this option. This way, you won't have to do it every time (through the 
Layer Properties) for each new drawing layer that you create.

Compress Saved Keyframes: Compresses keyframe values when there are 
no changes between adjacent keyframes. The resulting project is not 
compatible with versions of Harmony prior to version 11. 

Tablet Support
Use Qt Wintab Tablet Support (Requires Relaunch): If you are using a 
tablet other than Wacom, deselect this option (and relaunch) if you are having 
issues with offset or pressure sensitivity.

Unicode

Allow Unicode Names: Lets you use up to 120 ASCII characters for names of 
environments, jobs and scenes. This means you can use characters for 
languages, such as Japanese, Chinese, French, Spanish, and others, 
characters for names in your database setup—see Advanced Tips and 
Guidelines on page 1.
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Deformation Tab

Parameter Description

Scale Controls The Scale controls let you customize the appearance of the Deformation-Scale 
and Deformation-Uniform-Scale controls by setting the distance from the 
deformer axis.

Display Scaling Node in Pixel Size: This option is disabled by default. The 
distance between the controls and the deformer axis is calculated using fields 
as a value. Select this option to change the value to pixels.

Scaling Pixel Size: The default value is 64 pixels, meaning the distance 
between the controls and the deformer axis is 64 pixels. You can enter any 
pixel value.

Scaling Field Size: The default value is 2 fields, meaning the distance 
between the controls and the deformer axis is 2 fields. You can enter any field 
value.

Deformation Convert 
Deformed Drawings

Texture Resolution when Converting Gradient and Textures: Sets the 
size of the bitmap texture used during the conversion of deformed drawings to 
drawings. The maximum value accepted is 2048 pixels.

Particle Tab

Parameter Description

OpenGL

Always Show Particles as Dots: Displays the particles as dots in the 
OpenGL preview mode. This makes the playback speed faster for a heavy 
scene.

Horizontal Resolution of Image Fracture Input: This is the size, in pixels, of 
the proxy bitmap image rendered in OpenGL when using the Image Fracture 
particle. A smaller image size increases the playback speed in heavy scenes.
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Remove Dirt Dialog Box
The Remove Dirt dialog box lets you select small dots and hairs on a drawing for removal.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. These 
lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

For tasks related to this dialog box, see Dirt Clean Up on page 1.

How to access the Remove Dirt dialog box

 1. Do one of the following:

‣ From the top menu, select Drawing > Clean Up > Remove Dirt.

‣ From the Camera or Drawing View  menu, select Drawing > Clean Up > Remove Dirt.

‣ Press Shift + D.

Parameter Description

Slider

Lets you adjust the amount of detail removed from the layer. 

Raising the Remove Dirt level will select bigger dots. When selecting larger dots, 
be careful not to lose small details like pupils and nostrils. Once you have chosen 
the level, you can apply it to the current drawing or the entire animation sequence. 
This is a quick way to get rid of most dirt and dust.

During this process, the dirt that will be removed is highlighted in red.

Apply to all drawings Applies the operation to all drawings in the layer.

Remove Hair Dialog Box
The Remove Hair dialog box lets you remove any small strokes created in the Colour Art layer from very thick lines 
or filled zones. Increasing the Remove Hair level value will select larger strokes for removal from the drawing.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. These 
lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

For tasks related to this dialog box, see Dirt Clean Up on page 1.

How to access the Remove Hair dialog box

 1. In the Timeline or Xsheet view, select the drawing containing the drawing to clean.

 2. From the top menu, select View > Show > Show Strokes to display the invisible lines or press K.

 3. In the top menu, select Drawing > Clean Up > Remove Hair.
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Parameter Description

Slider Lets you adjust the number of length of hairs selected. 

Apply to all drawings Applies the operation to all drawings in the layer.

Render Write Nodes Dialog Box
The Render Write Nodes dialog box lets you configure your scene to render locally or sent it to a render farm so 
other computers can render your scenes while you continue working on your station. 

The Harmony Server rendering processes are named:

• Local Rendering is done directly on the user machine using its CPU. To perform local rendering you must 
use Stage. 

• Batch Rendering lets you send a scene to render while you continue working in Stage. This way, you do 
not have to wait for the application to complete the render process. 

For tasks related to this dialog box, see Batch Rendering on page 1.

How to access the Render Write Nodes dialog box

 1. Do one of the following:

‣ From the top menu, select File > Export > Render Write Nodes.

‣ Press Ctrl + Shift + Y (Windows/Linux) or ⌘  + Shift + Y (Mac OS X).

The Render Write Nodes dialog box opens.

Parameter Description
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Range

All Frames (1-60) Sends all the frames in the scene to be rendered.

Selected Frames Sends a range of frames to be rendered. 

Batch Composite Options

Debug

Chunk
Splits the frames into sets of frames or QuickTime movie into small chunks. 
Note that when the render farm (server) is done rendering all the small movie 
chunks, it will put them all back together to create one single movie file.

Size (Frames)
Lets you enter the number of frames for each chunk in the Size (Frames) field. 
For example, if your scene is 100 frames long and you enter a value of 20, 
there would be five entries in the queue of 20 frames each. 

Camera
Lets you select the camera for rendering the scene's images. 

These are the Camera nodes you created in your scene. 

Resolution

 

By Name: 

By Value: 

Field Composite Options

Add Pulldown Uses the 3:2 pull-down technique. 

Automatic Combine Combines even and odd fields on a scene's images. 

Second Field First Always starts with the second field before combining with the first. 

Preview

Save Dialog Box
The Save dialog box lets you save a scene for the first time in Harmony Server.
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For tasks related to this dialog box, see Saving a Scene on page 1.

How to access the Save dialog Box

 1. Make sure you have the necessary rights to save the current scene version. If you do not, you can acquire 
the rights by selecting File > Rights to Modify Scene Version or Rights to Modify Scene. 

 2. From the top menu, select File > Save or press Ctrl + S (Windows/Linux) or ⌘  + S (Mac OS X). 

When saving the scene for the first time, the Save dialog box opens, prompting you to name the version.

Parameter Description

This Version Lets you enter a relevant name for the current version.

New Version

Overwrite Existing Version

Description Enter a short description of the current version.

Mark as Current

Scene Settings Dialog Box
The Scene Settings dialog box lets you parameters for your scene. 

When you created your new scene, you set up the resolution and the alignment. However, if you want to change 
these initial settings later, you can do it using the Scene Settings dialog box. The different Scene Settings options 
are separated into four tabs.

How to access the Scene Settings dialog box

 1. From the top menu, select Scene > Scene Settings.

The Scene Settings dialog box opens.

80



Harmony 12.2 Premium - Paperless Animation Guide (Server)

Resolution Tab

Parameter Description

Resolution Presets

You can select your project’s resolution (camera frame size) from this preset list.

‣ HDTV: High definition television delivers a higher quality image than 
standard television (4:3) does, because it has a greater number of lines of 
resolution. To take advantage of the superior quality your output device 
must be compatible with HDTV technology to make this resolution setting 
useful.

‣ HDTV_Vertical: The "vertical resolution" of HDTV_Vertical refers to how 
the images will be aligned in relation to the actual scene frame (default 4:3 
grid). Note that the camera resolution and the scene frame are not the 
same. When working with 12 or 16 field drawing grids, the grid is a different 
aspect ratio from the camera frame. When you fit vertically, you fit the 
images with the top and bottom of the scene grid.

‣ film-1.33: Use this resolution setting for the academy film format that 
conforms to the standard 4:3 aspect ratio.

‣ film-1.66:  Use this resolution setting for the widescreen film format that 
conforms to the 16:9 aspect ratio.

‣ film-1.66_Vertical: This is essentially the same as film-1.66. Refers to 
how the drawing is fit into the scene frame. When working with 12 or 16 
field drawing grids, the grid is a different aspect ratio from the camera 
frame. When you fit vertically, you fit the images with the top and bottom of 
the scene frame.

‣ NTSC: This is the standard analogue television broadcasting system used 
in North America and conforms to the North American standards on how 
rectangular pixels are displayed for computer and television screens.

‣ PAL: This resolution works best with the European format for television 
and computer screens, as the rectangular pixels are displayed at a 
different orientation.

‣ Low: This format is ideal for videos destined for the web, where size and 
fast download of a video file might take precedence over quality.

‣ Cloud Preview: This is the resolution used by Web Control Center to 
create its preview.

Selected Resolution Preset Displays the selected resolution preset.

Save Resolution Setting

Click the Save Resolution button after you define your new resolution to save it as 
a preset.

If you are working in Harmony Server, you will be prompter a dialog box asking 
you to name the new resolution as well as the level at which you want to save the 
resolution,conf file.
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Pixel Dimensions

Displays the pixel dimensions for your project resolution.

If you decide to type in the pixel dimensions, or use the up and down arrows to 
change the pixel increments, you will have to save your custom selection in order 
to save it as a new preset. It will then appear in the resolution selection list. It 
doesn't modify the current resolution preset.

Aspect Ratio
Displays the ratio between the horizontal and vertical dimensions of the camera 
framing. Each resolution setting has a preset aspect ratio that cannot be changed.

Frame per second

Sets the frame rate for your project. The higher the frame rate, for example 30 fps, 
the faster the animation will pla. The lower the frame rate, for example 12 fps, the 
slower your animation will play. Avoid going under 12 frames per second as your 
animation will have a choppy playback. The human eye requires a minimum of 12 
frames per second to perceive a fluid animation.

Field of View

Use these options to define the FOV (field of view) of the camera (angle of the 
camera cone) and how the drawing elements (and drawing grid) align to the scene 
grid. The drawing grid is always scaled proportionally to a 4:3 ratio (unless you 
change the scene alignment), therefore changing the Field of View setting may 
not show a visible difference if your project resolution is also 4:3, such as NTSC.

‣ Horizontal Fit: The camera resolution is set to fit the left and right edges of 
the scene grid.

‣ Vertical Fit: The camera resolution is set to fit the top and bottom edges of 
the scene grid. 
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‣ Custom Fov: After selecting this option, use the  now-active field to the 
right to enter in a value, in degrees, of the angle that you want the camera 
cone to be. Increasing this value  will make the camera cone wider (the 
angle is more obtuse), widening the FOV and making the grid and all 
elements appear farther away. Decreasing the default value  will create the 
opposite effect.

Projection

The Projection settings allows you to modify the type of camera your scene is 
using. You can either use a perspective camera (regular camera) or orthographic 
camera (no perspective).

‣ Perspective: The Perspective option is the default and most common 
option. Objects placed closer to the camera will be displayed bigger and 
objects placed further away will be displayed smaller.

‣ Orthographic: The Orthographic option is specific to the gaming pipeline. 
It changes the camera from Perspective to Orthographic, meaning that 
there is no more perspective in the Camera view. Objects, when moved in 
depth will not change size. There is more information available about this 
option in the Gaming user guide. In order  to create scenes with the 
Orthographic camera by default, you need to create a new custom scene 
resolution.
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Alignment Tab

Parameter Description

Alignment

The Alignment presets give you two preset options:

‣ 4:3 12 Fields: Defines the units of your project to have a 4:3 ratio and 
sets up 12 of these units to run both vertically and horizontally in four 
cardinal quarters (NW, NE, SW, SE). This Alignment preset is visible in 
the FOV and drawing grids.

‣ Square 12 Fields: Defines the units of your project to have a 1:1 or 
square ratio and sets up 12 units to run both vertically and horizontally in 
four cardinal quarters (NW, NE, SW, SE). This Alignment preset is 
NOT visible in the FOV and drawing grids.

Units Aspect Ratio

In the Units Aspect Ratio fields, enter the aspect ratio of the grid you will use. 
The aspect ratio describes the shape of the grid unit. A square grid unit would 
have the ratio 1:1, whereas a grid unit of aspect ratio 4:3 is a unit with one side 
1.33 times as big as the other side.

If the aspect ratio you want to use is 1:1, enter 1 in the Left/Right field (X-axis) 
and 1 in the Up/Down field (Y-axis). The default Aspect Ratio is set to 4:3 as it 
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is the one used by traditional animators, who are accustomed to working with 
the grid system described above. 

Number of Units

In the Number of Units fields, enter the number of horizontal, vertical and depth 
units for your scene’s grid.

Animators who prefer to work traditionally will understand the default setting of 
24 units horizontal by 24 units vertical as it, once again, corresponds to the grid 
above. Twelve is a common setting for the field depth.

Those who prefer to work in pixels should enter the pixel dimensions (3) of their 
project. This way if you want to move something over 600 pixels you just need 
to type in 600 units.

Coordinates at Centre

In the Coordinates at Centre, you can enter a new coordinate for the centre of 
your scene.

By default, the (0,0) centre is set in the middle of the grid as shown in the grid 
above. If you want to change the centre of your grid, for example to the upper 
left corner, you would enter (-12, 12), -12 units across and 12 units up. That is 
of course unless you changed the number of units to match the pixel 
dimensions of your scene. Then you would enter negative half the width and 
positive half the height.

Save
Saves your current Alignment settings and be able to select them later from the 
list.

NOTE: If you change your scene‘s alignment from 4:3 12 Fields to Square 12 Fields part way though your project, 
you may find that the animation grid becomes offset. To correct this, choose the following setting from the Layer 
Properties panel‘s Advanced tab: Alignment > Alignment Rule > Centre First Page.

Bitmap Resolution Tab

Parameter Description

Scene Resolution This is the scene resolution preset name and size in pixels.

Width

This is the width of the resolution for the bitmap that will be created. This is not 
the actual size of the bitmap. TVG drawings (Toon Boom drawing native format) 
have an infinite size. Bitmap TVGs are composed of small tiles. Therefore it does 
not mean that because you have artwork at the four corners of your camera frame 
or even quite far outside of your drawing that your bitmap image will be very large 
and heavy. By default, it is set to the same width as the scene resolution.

Height
This is the height of the resolution for the bitmap that will be created. By default, it 
is set to the same height as the scene resolution.

Resolution Factor

This is the size of the bitmap resolution in relation to the scene resolution. If you 
increase the percentage, the width and height fields will increase accordingly. If 
you plan to animate the camera and zoom into your background, you will need to 
set a higher resolution so that the smaller area in which you will zoom will be 
100% of the scene resolution.
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Advanced Tab

The Advanced tab contains an option for Toon Boom Digital Pro release 7.3 and Harmony release 7.3. 

Since version 7.8, the method in which Z-Ordering is calculated has been optimized. Enable this option if you 
want to use the version 7.3 system.

Toon Boom Digital Pro and Toon Boom Harmony 7.3 allowed smaller values on the Z-axis such as 0.0001. Since  
version 7.8, the Z-ordering calculation is now optimized and allows only larger values such as 0.001.

Scripts Manager Dialog Box
The Scripts Manager dialog box lets you link a script to a toolbar button for quick and easy access. Once you 
select a script, you can add it to the toolbar, load a custom icon and add a tooltip.

For tasks related to this dialog box, see Linking a Script to a Toolbar Button on page 1.

How to access the Scripts Manager Dialog Box

 1. In the Scripting toolbar, click the Manage Scripts  button.

The Scripts Manager dialog box opens.

Parameter Description

Files A list of the available JavaScript files.

Functions A list of the available functions for the selected script.

In Toolbar Adds the selected script to the toolbar.

Execute Runs the script you selected. Press Esc to interrupt the execution of the script.

Customize Icon Lets you load a custom icon for the function. You can browse for a *.png, 
*.jpg or *.xpm file.

Customize Tooltip Lets you type in a tooltip for the function. When you hover over the button in the 
toolbar, your tooltip will appear.
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Select Colour Dialog Box
The Select Colour dialog box lets you set the colour of layers and columns.  Using colours for layers and columns 
helps to differentiate them visually, making them easy to identify. The colours you choose will be reflected in the 
Node view.

You can select a colour by choosing from a basic set of colours, using the colour wheel or by specifying the HSV or 
RGB values. Once you have selected a colour, you can adjust its intensity and save it as a custom colour that you 
can reuse.

For tasks related to this dialog box, see Changing the Colour of a Layer or Column on page 1.

How to access the Select Colour dialog box in the Timeline view

 1. In the Timeline view, click the Change Track Colour  button of the layer you want to modify. 

The Select Colour dialog box opens.

How to access the Select Colour dialog box in the Xsheet view

 1. In the Xsheet view, select one or more columns to modify.

 2. Right-click on the column’s header and select Colour > Change Columns Colour.

The Select Colour dialog box opens.

Parameter Description

Basic colours The basic set of colours in the system? 

Custom colours Displays the custom colours you created. 

Add to custom colours Lets you add the selected colour to the Custom colours list above.

Colour wheel Lets you select a colour by dragging the T-shaped pointer.

Value slider Once you select a colour, you can drag the slider to change the intensity and see 
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it previewed in the Colour Preview window below.. 

Colour Preview Displays the colour you are currently selecting. To apply the colour, click OK.

Hue, Saturation, Value
Lets you set the hue (colour), saturation (amount of colour) and brightness (value) 
of the colour.

Red, Green, Blue Lets you set the red, green and blue values.

Sequence Fill Dialog Box
The Sequence Fill dialog box lets you create a numbered sequence over a selection. The sequence can be 
forward, backward, single, double or higher increment, as a cycle, and so on. The selection can be over one cell 
or a cell range in one column or more or an entire column or many entire columns.

For tasks related to this dialog box, see Filling a Selection with a Sequence.

How to access the Sequence Fill dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 2. Do one of the following:

‣ From the top menu, select Animation > Cell > Sequence Fill. 

‣ In the Timeline view, right-click and select Exposure > Sequence Fill.

‣ In the Xsheet toolbar, click the Sequence Fill  button (you may have to customize the toolbar to 
display it).

‣ Press Ctrl + M (Windows/Linux) or ⌘  + M (Mac OS X)).

The Sequence Fill dialog box opens.
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Parameter Description

Starting Value The first number in the sequence.

Increment
Lets you type the number by which the drawing number will increase from frame 
to frame. For example, an increment of 1 gives you: 1-2-3-4; an increment of 2 
gives you: 1-3-5-7; and -2 gives you this: 8-6-4-2.

Hold The exposure holding value.

Cycle

End Frame

Padding

Add Key Exposure After Inserts a key exposure after the frame following the last cell. 

Set Ease for Multiple Parameters Dialog Box
The Edit Set Ease for Multiple Parameters dialog box lets you apply ease to multiple functions and keyframes. You 
can display the function curve and modify the Bezier or Ease curve—see Adjusting the Velocity on page 1.

How to access the Set Ease for Multiple Parameters dialog box

 1. In the Timeline view, select a keyframe on one or more layers.

 2. Do one of the following:

‣ In the Timeline view, right-click and select Set Ease For Multiple Parameters. 

‣ In the Timeline toolbar, click the Set Ease For Multiple Parameters  button.

The Set Ease For Multiple Parameters dialog box opens.
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Parameter Description

Filters

Motion

 

Motion: Applies the easing parameters to the selected Position X, Position Y, 
Position Z and 3D Path functions.

Rotation: Applies the easing parameters to the selected Angle functions.

Scale: Applies the easing parameters to the selected Scale functions.

Skew: Applies the easing parameters to the selected Skew functions.

Morphing: Applies the easing parameters to the selected Morphing Velocity 
functions. Note that it applies to the Morphing velocity function found in the 
Layer Properties window, not the basic morphing ease in the Tool Properties 
view.

Other: Applies the easing parameters to all the other the selected functions, 
such as all functions created to animate effect parameters.

Left and Right Time Ratio
Lets you type the percentage value corresponding to the length of time you 
want the easing to last. Stay between 0% and 100%. If you go beyond 100%, 
your motion will overshoot. 

Left and Right Value Ratio
Lets you type the percentage value of how strong you want the easing out to 
be. Stay between 0% and 100%. If you go beyond 100%, your motion will 
overshoot. 

Apply/Previous
Applies the easing parameters to the selected keyframes and then selects the 
previous keyframe in the timeline.

Apply Applies the easing parameters to the selected keyframes.

Apply/Next
Applies the easing parameters to the selected keyframes and then selects the 
next keyframe in the timeline.

Close
Close the dialog box. If you did not apply the modifications, they will be 
cancelled.
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Show Hidden Columns Dialog Box
The Show Hidden Columns dialog box lets you display all the columns contained in the exposure sheet. It can be 
used to hide individual columns.

For tasks related to this dialog box, see Showing and Hiding Columns on page 1.

How to access the Show Hidden Columns dialog box

 1. In the Xsheet view, do one of the following:

‣ Click the thick grey line that represents a hidden column. 

‣ Right-click on the column header and select Show Hidden Columns.

‣ Press Alt + Shift + H.

The Show Hidden Columns dialog box opens.

Parameter Description

Show Lets you select the hiddens columns to display in the Xsheet view.

Name Name of the drawing.

Type

Check Selects all columns.

Uncheck Deselects all selected columns.

Sound Settings Dialog Box
The Sound Settings dialog box lets you set the compression settings for the movie you will export.

For tasks related to this dialog box, see Exporting a QuickTime Movie on page 1.
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How to access the Sound Settings Dialog Box

 1. From the top menu, select File > Export > Movie.

 2. In the Export to QuickTime Movie dialog box that opens, click Movie Options.

 3. In the Movie Setting dialog box that opens, click Settings in the Sound section.

Parameter Description

Compressor

Lets you select a compression type. The default setting is None. This will 
preserve your original sound file without the loss of information. However, an 
uncompressed sound file will inevitably add “weight” to the overall size of your 
video export.

Rate

Lets you select a rate. 
It is best to check and match the original properties of your sound file. For 
example, if your file has an audio sample rate of 48 kHz and you choose a con-
version rate of 22.05 kHz, the sound will play at the same speed, but with 
higher frequencies missing. For a standard film sound quality, choose 44.1 
kHz, or 48 kHz for DVD quality. Anything less will make the sound “dull” or 
less bright. For things like recorded voice, this doesn't matter so much, but for 
music it can make an audible difference. If file size is a consideration, such as 
with videos for the Internet, then a lower rate might be more practical.

Size and Use

Size and Use are related. It is advisable to check your original sound file 
properties. If the file was recorded in one channel (mono), there is no point in 
choosing the two channel (stereo) option. Although Mono can support a 16-bit 
channel, the extra information is unnecessary. Mono is generally paired with 8-
bit and Stereo with 16-bit.

Standard Video Compression Settings Dialog Box
The Standard Video Compression Settings dialog box lets you set the compression settings for the movie you will 
export.
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For tasks related to this dialog box, see Exporting a QuickTime Movie on page 1.

How to access the Standard Video Compression Settings Dialog Box

 1. From the top menu, select File > Export > Movie.

 2. In the Export to QuickTime Movie dialog box that opens, click Movie Options.

 3. In the Movie Setting dialog box that opens, click Settings in the Video section.

Parameter Description

Compression Type
Lets you select a codec. The availability of certain compression settings depends 
on the Compression Type selected. For example, Animation is the default 
compression type and as a result the Data Rate option is greyed out. 

Motion

Frame Rate

Lets you select a frame rate. By default, it is set to match the frames-per-second 
(fps) of your Harmony project. If you choose a lower frame rate, your export 
playback will be faster than your actual project. The reverse is also true for a 
higher frame rate. 

Key Frames

Automatic: 

Every: Inserts keyframes. This is the option is recommended by QuickTime. For 
further details, refer to the QuickTime documentation.

All: 

Frame Rendering: 

Frames: Lets you set the number of keyframes to insert.

Compressor

Depth Lets you select a depth based on your movie’s needs. For example, Millions of 
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Colours+ houses an alpha channel.

Quality
Lets you choose a quality setting. The higher the quality of the export, the larger 
the resulting file.

Data Rate

Date Rate

Automatic: Lets the system automatically select the most optimal bit rate.

Restrict To: Lets you enter a rate to save space and allow for faster downloading 
at a cost to the quality of the export. 

Optimized For: Lets you select the intended viewing method.

Preview Displays a preview of the movie to be exported.

Timeline Scene Marker Dialog Box
The Timeline Scene Marker dialog box lets you create and manage scene markers in the Timeline view. Scene 
markers are visual indicators displayed at the top of the Timeline view in the frame counter area. You can use it to 
denote anything relevant to your work. You can indicate the frames you want to clean up, a change in action, an 
impact, or where you intend to apply an effect. You can also add a note to a scene marker, which is displayed 
when you hover over the scene marker.

For tasks related to this dialog box, see Setting Scene Markers on page 1.

How to access the Timeline Scene Marker dialog box

 1. In the frame counter area of the Timeline view, do one of the following:

‣ Drag to select the frame range to mark.

‣ Right-click and select Scene Markers > Mark Current Frame.

Parameter Description

Colour swatch
Opens the Mark Colour dialog box where you can select a colour for the scene 
marker.

Note (Tooltip)
Lets you type in a name for your scene marker. Making the name meaningful 
will help you to quickly identify scene markers especially when there are many 
of them in the frame counter area of the Timeline view.

Toolbar Manager Dialog Box
The Toolbar Manager dialog box lets you customize the toolbar in any of the views. You can add your favourite 
tools to a toolbar for an efficient workflow.

For tasks related to this dialog box, see Managing the Toolbars on page 1.
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How to access the Toolbar Manager dialog box

 1. Right-click on a toolbar in any view and select Customize.

Parameter Description

Available Tools Displays the complete list of tools available for customizing a toolbar.

Toolbar Displays a list of the tools currently available on the toolbar.

Default Restores the toolbar with its default items.

Vectorization Parameters Dialog Box
The Vectorization Parameters dialog box lets you vectorize pencil drawings, along with any red, blue or green pencil 
marks you may have used to indicate highlights and shadows. The drawing will be vectorized into pure red, blue, 
green and black (RGB values), while creating colour art zones wherever lines connect. After painting in your tones 
and highlights, change your pure RGB colours to transparent (0 Alpha) in the Colour Picker window and watch the 
indicator colour zone lines disappear.
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For tasks related to this dialog box, see Custom Vectorization Parameters  on page 1.

How to open the Vectorization Parameters dialog box

 1. From the top menu, select File > Import > From Scanner.
You can also open it from any other import option that allows you to customize the vectorization para-
meters (i.e. from the scanner).

 2. In the Scan Drawings window, do the following:

‣ In the Layer section, decide on the layer options.

‣ In the Import Options section, select the Convert to Toon Boom Vector Drawing option

‣ Click Preview.

 3. In the Vectorization section, click the Vectorization Parameters button.

Options Tab

The Options tab contains the main vectorization settings. More settings are available in the Help tab.
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Parameter Description

Input The input filters are applied to the bitmap image before it is vectorized.

One Pass
One threshold value is applied to both the Line and Colour Art. For drawings with 
distinct vector-style lines of mattes, you only need one pass.

Two Passes
Applies a different threshold value to each layer. For greyscale drawings, you 
may want to perform the vectorization process twice to apply different threshold 
values to the Line and Colour Art layers.

Threshold
Determines which values in the scanned image are considered part of the Line or 
Colour Art layer and what will be eliminated from the vectorized drawing; 0% is 
white and 100% is black. The threshold is between these two values.

Expand Bitmap
Lets you enter a value to scale the bitmap to detect small variations in the line. 
Use this option if you scanned a greyscale image and want to preserve small 
variations in the texture to apply to the line art.

Jag Filter
Lets you enter a value to scale back the bitmap to remove some of the line’s 
roughness. This is useless when you have a drawing that appears quite rough; 
the Jag filter will eliminate excess strokes in the final drawing.

Line Art Threshold (%)

Colour Art Threshold 
(%)

Output The output filters are applied during the vectorization process.

No Colour Art Does not generate filling zones in the Colour Art layer.

No Texture
Does not generate texture in the Line Art layer in the final images. Select this 
option to create solid lines in the final line art.

Generate Matte in 
Underlay Layer

Creates an opaque zone behind your drawing’s lines to avoid seeing through the 
layers.

Colour as Texture Converts colour values into a texture layer.

Optical Registration
The optical registration options are used to automatically align drawings based on 
the position of the peg holes on the animation paper. The peg holes must appear 
in the scanned drawings for the optical registration to work.

DPI Lets you enter the dots-per-inch value of your image. You must enter the same 
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value as the DPI used to scan the image.

Peg Side
Lets you select the position of the peg holes on your drawings. Identify whether 
they are on the top, bottom, left or right.

Strictness

Determines how exact the location of the peg holes must be for the software to 
recognize them. There are two values to choose from:

Strict: The peg holes must be in a tightly defined area to be recognized.

Loose: The peg holes can be recognized somewhere in a larger area. This is the 
recommended setting.

Field Chart Lets you indicate the size of the animation paper, 12 or 16.

Post Processing The Post Processing filters are applied to the final vector images.

Remove Holes Removes holes of a specified value that might make painting difficult.

Remove Dirt Removes stray marks and dirt of a specified value. Try a value around 500.

Remove Hair Size Removes small strokes that have no line art.

Remove Hair: Number 
of Passes

The number of times the drawing will be analyzed to identify hair marks.

Miscellaneous

Close Gaps Closes gaps in the Colour Art so you can paint it.

Smooth Passes for Line 
Art Before Breaking 
Triangles

The number of times the smoothing operation runs before creating the triangles 
that break lines in the drawing. If unnecessary triangles are appearing in the 
drawing, increase this value.

Smooth Passes for Line 
Art

The number of times the smoothing operation is performed after the triangles have 
been created. This further smooths the line art.

Preview

Show Strokes Shows the strokes in the Vectorized Image panel.

Stroke Thickness Shows the size of the strokes.

Help Tab

The Help tab contains the most advanced vectorization settings which you type in the Advanced Option fields at 
the bottom of the Vectorization Parameters dialog box.
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File IO Options

-file <filename (including extension)> [ options ]

-infile <filename (including extension)>; same as -file

-outfile <filename>; alternate output file

-informat <format>; the input format. Used if reading from stdin

-debug; turn on debug mode

-noforce; don't force output if image is inconsistent

-version; print version information and quit

-output_version <version>; output files of this version. Valid versions can be: 0 or 604

-force_unamed_palette_for_texture; will generate a texture in TVG's internal palette

Registration Options 

-register <dpi side strictness>; perform optical registration.

• Side can be one of left, right, top, bottom or l, r, t, b.

• Strictness can be either loose, strict or l, s.

-register_center_peg_holes; will use only round holes in 16 fields page

-rcph; short form of register_center_peg_holes

-registration_looseness_factor <factor>; registration looseness factor (default 2.000000)

-rlf; short form of registration_looseness_factor

-rdebug; output registration debug messages

-pegpitch <inch (default 8.000000)>; distance between peg bars

-threshr < (default 0.500000)>; threshold for optical registration; range 0.0 to 1.0

-rmargin <inch (default 1)>; region size where to look for peg bars 

-peg_distance_from_center <inch (default 5.25)>; peg distance from centre of the image 
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-pdfc; short form of -peg_distance_from_center 

-out_peg_position <side (default same)>; wanted position of the peg on the drawing.

• Can be one of right, left, top, bottom (or r, l, t, b) or same.

• A rotation will be performed if it is different from the side passed to -register.

-output_peg_matrix; output the peg transformation matrix on standard output.

-scanner_calibrate; < (default 1.0000 1.0000) > x and y scale factors to be applied to scanner image.

Filtering Options 

-pixel <pixel_shape (default '4x3')>; Valid values: 4x3

-gap <worldUnits (default 10)>; close gaps up to this big

-pencil; generate line art only

-keep_dirt; don't filter out dirt

-thresh <threshold (default 0.2)>; range 0.0 to 1.0

-rmv_hairs <worldUnits (default 1)> <passes (default 1)> 

• remove hairs of size smaller than "size" in "passes" passes 

-rmv_holes <area (default 7)>; remove holes smaller than "area" 

-rmv_dirt <area (default 1)>; remove dirt smaller than "area" 

• try values between 100 and 500 for rmv_holes and rmv_dirt. The area is in world units squared

-rmv_triangles <worldUnits (default 30.000000)>; remove triangles at "pixels" 

• distance from each other. Use -no_break to remove all triangles

-no_texture; don't generate textured strokes

-color_as_texture; will vectorize the alpha channel and put the RGB colour in a textured colour

-noclosegap; disable all gap closing algorithms

-no_break; disable the breaking of line art

-jag_filter <pixels (default 0>; expand the pixels in the vectorization bitmap

-expand_bitmap <pixels (default 0>; expand the pixels in the vectorization bitmap

-fit_errorc <error (default 1.000000>; fitting error for the colour art

-fit_errorl <error (default 1.000000>; fitting error for the line art

-smoothl <passes (default 1>; number of smooth passes for line art

-smoothc <passes (default 1>; number of smooth passes for colour art

-first_smooth <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothl <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothc <passes (default 0>; number of smooth passes for line art in colour art pass (needs -2pass)
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-2pass; specify two sets of parameters; one for line art "l", one for colour art "c"

(-thresh, -rmv_holes and -rmv_dirt will be overridden by -threshl, threshc, -rmv_holesl,

-rmv_holesc, -rmv_dirtl and -rmv_dirtc)

-threshl <threshold for line art (default 0.5)>; range 0.0 to 1.0

-threshc <threshold for color art (default 0.5)>; range 0.0 to 1.0

-jag_filterl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art

-jag_filterc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-expand_bitmapl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art

-expand_bitmapc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-rmv_holesl <area (default 7)>; remove line art holes smaller than "area" 

-rmv_holesc <area (default 7)>; remove colour art holes smaller than "area" 

-rmv_dirtl <area (default 1)>; remove line art dirt smaller than "area" 

-rmv_dirtc <area (default 1)>; remove colour art dirt smaller than "area" 

try values between 100 and 500 for rmv_holesl, rmv_holesc, rmv_dirtl and rmv_dirtc. The values are in world 
units squared 

-margins <inch (default 0.25)>; remove margin around bitmap 

-top_margin <inch (default 0.25)>; remove margin at top of bitmap 

-bottom_margin <inch (default 0.25)>; remove margin at bottom of bitmap 

-left_margin <inch (default 0.25)>; remove margin at left of bitmap 

-right_margin <inch (default 0.25)>; remove margin at right of bitmap 

-remove_peg_bars; remove the peg bar holes

-field_size <fields (default 12 or use value in scan file)>; set the drawing to this field size

-fs; short hand for -field_size

-peg_bar_size <inch (default 1)>; the size of the peg bar region

-noframe; do not put a frame around the colour art

-frame_fields <default -1.000000>; put a frame of the specified dimension around the colour art

-downscale_input <default 1>; downscale the raw input by this integer factor

-downscale_texture <default 1>; downscale the output texture by this integer factor

-buildmatte; generate a matte on underlay for line test

-buildmatte_colourart; generate a matte on colour art for line test

NOTE: -buildmatte and -buildmatte_colourart are mutually exclusive
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-copystrokes; copy original strokes when building matte.

Options for bitmap that has no registration information 

-pixel_margins <inch (default 0)>; remove margin around bitmap 

-top_pixel_margin <inch (default 0)>; remove margin at top of bitmap 

-bottom_pixel_margin <inch (default 0)>; remove margin at bottom of bitmap 

-left_pixel_margin <inch (default 0)>; remove margin at left of bitmap 

-right_pixel_margin <inch (default 0)>; remove margin at right of bitmap 

-dpi <(default -1)>; dpi information of input bitmap 

RGB Keying Options 

-rgb; generate separate zones for red, green and blue lines

-rgb_alpha <value (default 255)>; generate red, green and blue colour with alpha of this value

-no_red; ignore red colour in vectorization

-no_green; ignore green colour in vectorization

-no_blue; ignore blue colour in vectorization

-flatten; flatten the drawing after generating colours

-rmv_rgb_dirt <threshold area default 0.0>; remove red, green and blue regions smaller than area

-expand_bitmap_rgb <pixels (default 0>; expand the pixels in the vectorization bitmap for rgb

-threshrgb <value> <threshold for rgb vectorization default 0.200000>;

-threshsv <saturation threshold default 0.500000> <value threshold default 0.500000>; thresholds on saturation 
and value to consider a pixel to be grey

Colour Vectorization Options 

-color_vectorize; perform a colour vectorization

-file2 <colour art filename>; specify the colour art bitmap

-penstyle <center alpha (0.0-20.0)> <edge alpha (0.0-20.0)> <gamma (0-10)><centre pressure effect (0.0-1.0)> 
<edge pressure effect (0.0-1.0)><texture bitmap downscaling (0.2-20)> <texture bitmap file (valid filename or "" if 
no file)>; generate brush texture for the line art

-pressure_variation <strategy (0, 1 or 2)> <min pressure (0.0-1.0)> <max pressure (0.0-1.0)> <max variation 
(0.0-1.0)>; specify a pressure strategy for the centre line. 

-blur_radius <pixels (default 0)>; blur the penstyle texture generated

-color_contour_smooth_passes <times (default 3)>; perform number of smooth passes on contour before 
computing texture

-ccsp <times (default 3)>; short for -color_contour_smooth_passes

-color_rmv_holesl <world units (default 0.000000)>; remove holes of this size when computing texture
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-color_fill_holesl <world units (default 0.000000)>; fill holes of this size for colour line art

Bubble Usage (implemented only for colour vectorization's line art)

-create_bubbles; add bubbles into the LineArt. Implemented for colour vectorization only 

-bubble_gap <value (default 3)>; max number of colour art points between 2 bubbles

-bubble_length <value (default 10)>; max number of circles in a bubble

-min_radius <value (default 1.5000)>; min radius of a circle in a bubble relative to the line thickness (must be >= 
1.0)

-max_radius <value (default 3.5000)>; max radius of a circle in a bubble relative to the line thickness (must be >= 
1.0)

-uniform_gap; the space between bubbles is constant 

4 Colour Vectorization

-4colours [key:value] ... [key:value] ; The key value list can be empty. The list of keys is:

rgbdiff:value ; between [0.0-1.0] or [0-255]

dark:value    ; between [0.0-1.0] or [0-255]

grey:value    ; between [0.0-1.0] or [0-255]

white:value   ; between [0.0-1.0] or [0-255]

dirt:value    ; dirt area. 200 is a good value

rt:value      ; between [0.0-1.0] or [0-255]

gt:value      ; between [0.0-1.0] or [0-255]

bt:value      ; between [0.0-1.0] or [0-255]

NOTE: There must be no space between the colon and the key/value. For example: -4colours rgbdiff:20 dark:20 
grey:120 white:250 dirt:200 rt:240 gt:240 bt:240

Xsheet Column Width Dialog Box
The Xsheet Column Width dialog box lets modify the width of a column in the Xsheet view and use it as the default 
column width.

For tasks related to this dialog box, see Modifying the Look of the Column on page 1.

How to access the Xsheet Column Width Dialog Box

 1. In the Xsheet view, select a column.

 2. From the Xsheet menu, select View > Set Columns Width.

The Xsheet Column Width dialog box opens.
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Parameter Description

Columns Width (pixels) Lets you set the width of the selected columns (in pixels).

Apply
Applies the value you entered to the selected column without closing the dialog 
box.

Set As Default Uses the value you entered as the default for all columns in the Xsheet.
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Chapter 2: Layer Properties
Intro...

Drawing Layer Properties
The Layer Properties editor or view lets you adjust the properties of a layer in the Timeline view or a node in the Node 
view. The Layer Properties can be viewed as a floating window or as a view (docked).

Each layer has its own set of properties that can be modified, including effect and peg layers. Display the Layer 
Properties editor or view if you want to modify some of the layer’s properties, such as the name or the antialiasing 
quality. 

How to access the Layer Properties editor

‣ Double-click on a layer in the Timeline view or a node in the Node view.

‣ Right-click on a layer in the Timeline view or a node in the Node view and select Layer Properties.

‣ Select a layer in the Timeline view or a node in the Node view and press Shift + E.

How to access the  Layer Properties view

 1. Do one of the following:

‣ Select the view you want to add from Windows > Layer Properties.

‣ In the top-right corner of a view, click the Add View  button and select Layer Properties from the list.

By default, the Layer Properties view appears as a tab.
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Transformation Tab

The Transformation tab contains parameters for adjusting the position, scale, rotation, skew and pivots of an 
element.

When the Enable 3D option is selected, additional parameters appear in the Rotation and Pivot sections to rotate 
objects on 3 axis in the 3D space.
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Parameter Description

Enable 3D Displays additional parameters for working with 3D objects.

Position

3D Path: Lets you use a 3D path function to animate an element.

Separate: Lets you independently edit the different coordinate fields.

Path (x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

Path (y) Axis: Lets you type in a new North/South coordinate corresponding to 
the desired position.

Path (z) Axis: Lets you ype in a new Forward/Backward coordinate 
corresponding to the desired position.

Velocity: When the 3D Path option is selected, lets you set the speed at which 
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Scale

Locked: Resizes the element while keeping its ratio. The X and Y axes scale 
proportionally

Separate: Resizes the element allowing to modify the ratio (squash and stretch).

(x) Axis: Lets you type in the horizontal scale value.

(y) Axis: Lets you type in the vertical scale value.

Scale in Fields: Instead of using the standard scaling units, when this option is 
enabled, images are scaled using field units, based on the traditional animation 
field chart.

Ignore Parent Scaling: When this option is enabled, any scaling value applied to 
a parent layer is ignored in the current layer. This can be handy in cut-out rigs 
when you need to scale an arm without affecting the forearm. 

Rotation
Angle z: Lets you  type in a degree value for the rotation angle. Note that you can 
enter values greater than 360 and -360 degrees. If you enter 720, the object will 
rotate twice.

Skew Skew: Lets you type in a degree value between -90 to 90 for the skew angle.

Pivot

(x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

(y) Axis: Lets you ype in a new North/South coordinate corresponding to the 
desired position.

Drawing Pivot

Use Embedded Pivots: 

Harmony has three types of pivots:

• Permanent Pivot
This is a permanent pivot, sometime referred to as peg pivot, that is 
applied to the entire drawing or peg layer. If you modify its position, it will 
be changed for the entire layer, modifying the animation, scale and rotation 
interpolation. The permanent pivot is set using the Rotate, Translate or 
Scale tool. The Transform tool will only move that pivot temporarily for 
positioning purposes, but the animation interpolation will be done from the 
original permanent pivot's position. The Transform tool is designed to 
move the pivot temporarily during the animation process. It also permits 
you to select multiple pegs and apply a common temporary pivot.

To permanently move a peg pivot, use the Rotate  or Scale  tool. You can 
also directly type the values in the Layer Properties window in the Pivot 
section's (x) Axis and (y) Axis fields.

In the Layer Properties window, in the Drawing Pivot section, select the 
Don't Use Embedded Pivot option to use the permanent pivot.

• Drawing Pivot
The Drawing pivot is contained within each drawing. In one layer, each 
drawing can have its own pivot. If you have many different views of a 
character within one layer, the pivot can be different and the animation will 
adjust to the pivot. The Drawing pivot can also be referred to as embedded 
pivot. If you are not mixing different views within the same layers or are 
using pegs to animate your layers, it is recommended to use the 
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permanent pivot.

You can set a different pivot for each one of your drawings. For example, if 
you have a series of drawings from different views, they are not likely to 
rotate from the same location. In that case, you can set a different pivot for 
these drawings by using the Drawing Pivot  tool.

In the Layer Properties window, in the Drawing Pivot section, select the 
Apply Embedded Pivot on Drawing Layer option to use the drawing 
pivot directly on the drawing layer. If you want to apply the drawing pivot to 
a parent peg to force the peg to follow the drawing pivot variations, enable 
the Apply Embedded Pivot on Parent Peg option.

• Symbol Pivot
The Symbol pivot is similar to the Drawing pivot. Each symbol cell can 
have its own pivot and act the same as the Drawing pivot. The Symbol 
pivot can also be referred to as embedded pivot. Inside a symbol, each 
drawing can have its own pivot. If you are not mixing different views within 
the same layers or are using pegs to animate your layers, it is 
recommended to use the Peg pivot.

For a simple character rig, it is recommended to set the Peg pivot (even on 
drawing layers) using the Rotate  tool.

Drawing Tab

The Drawing tab contains parameters for the element and timing columns, designating art layers, and setting bitmap 
options.
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Parameter Description

Element Columns

Full Name: Select which element to connect to the node from the list of 
elements that already exist in your scene.  

Drawing Path: Displays the full path to the current drawing.

Timing Columns

Name: Path to the file you want to link to.  

Timing Column: Link to the column that contains the desired timing.  

Extension: When linking to a background file, enter its file name extension.  

Field Chart: If you are importing traditional animation, select the size of the 
paper on which the animation was drawn.

Art Layers

Overlay Art Enabled: Enables the Overlay Art display.

Line Art Enabled: Enables the Line Art display.

Colour Art Enabled: Enables the Colour Art display. 

Underlay Art Enabled: Enables the Underlay Art display.  

Overlay Art Type: Allows you to set the Overlay Art as Vector or Bitmap type.

Line Art Type: Allows you to set the Line Art as Vector or Bitmap type.

Colour Art Type: Allows you to set the Colour Art as Vector or Bitmap type.

Underlay Art Type: Allows you to set the Underlay Art as Vector or Bitmap 
type.

Bitmap File Options

When an image is created with an external software and that image has some 
transparency, there are several formats the software can use when writing the 
RBG channels. The purpose of the four import options for the transparency is 
for the user to tell Harmony how to interpret the RGB channels of the imported 
image. The correct option has to match the ouput format of the software that 
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was used to create the image in the first place. For instance, if the you used 
Adobe Photoshop and exported an image as Straight, then it should be 
imported in Harmony as Straight in order to get the correct result. 

Note that if the image has no alpha channel or if it does have an alpha channel 
and all the pixels are 100% opaque, it does not make any difference which 
option is selected. 

Colour: Controls the production of colour information from bitmap images. If 
this module reads 3 or 4-channel bitmaps, this selection determines whether 
the colour should be read or ignored. If this module reads 1-channel bitmaps, 
this selection determines whether the channel should be read as colour. When 
this option is selected with 1-channel images, the resulting image will be a 
greyscale image.  

Transparency: Controls the production of alpha information from bitmap 
images. If this module reads a 1 or 3-channel image, this option will create a 
matte from the colour values in the image. If the module reads a 4-channel 
image and this option is not selected, the alpha information in the image will be 
ignored.

Transparency Type  

Premultiplied with Black: Semi-transparent pixels in the original image are 
blended with black. 

Premultiplied with White: Semi-transparent pixels in the original image are 
blended with white. 

Straight: Semi-transparent pixels in the original image are left as is 
(unmatted). 

Clamp Colour to Alpha: Semi-transparent pixels in the original image are 
blended with black. On import, each of the RGB channels is clamped so that a 
color value never exceed the alpha value for a given pixel. When the RGB 
values are multiplied with the alpha value, that is to say, if you have a pixel of 
value R=247, G=188, B=29 and the alpha is 50% or the image has a 50% 
transparency, then the actual RGB values output would be half of the amounts 
listed above.

Drawing Tab

The Drawing tab contains parameters for the element and timing columns, designating art layers, and setting bitmap 
options.
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Parameter Description

Element Columns

Full Name: Select which element to connect to the node from the list of 
elements that already exist in your scene.  

Drawing Path: Displays the full path to the current drawing.

Timing Columns

Name: Path to the file you want to link to.  

Timing Column: Link to the column that contains the desired timing.  

Extension: When linking to a background file, enter its file name extension.  

Field Chart: If you are importing traditional animation, select the size of the 
paper on which the animation was drawn.

Art Layers

Overlay Art Enabled: Enables the Overlay Art display.

Line Art Enabled: Enables the Line Art display.

Colour Art Enabled: Enables the Colour Art display. 

Underlay Art Enabled: Enables the Underlay Art display.  

Overlay Art Type: Allows you to set the Overlay Art as Vector or Bitmap type.

Line Art Type: Allows you to set the Line Art as Vector or Bitmap type.

Colour Art Type: Allows you to set the Colour Art as Vector or Bitmap type.

Underlay Art Type: Allows you to set the Underlay Art as Vector or Bitmap 
type.

Bitmap File Options

When an image is created with an external software and that image has some 
transparency, there are several formats the software can use when writing the 
RBG channels. The purpose of the four import options for the transparency is 
for the user to tell Harmony how to interpret the RGB channels of the imported 
image. The correct option has to match the ouput format of the software that 
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was used to create the image in the first place. For instance, if the you used 
Adobe Photoshop and exported an image as Straight, then it should be 
imported in Harmony as Straight in order to get the correct result. 

Note that if the image has no alpha channel or if it does have an alpha channel 
and all the pixels are 100% opaque, it does not make any difference which 
option is selected. 

Colour: Controls the production of colour information from bitmap images. If 
this module reads 3 or 4-channel bitmaps, this selection determines whether 
the colour should be read or ignored. If this module reads 1-channel bitmaps, 
this selection determines whether the channel should be read as colour. When 
this option is selected with 1-channel images, the resulting image will be a 
greyscale image.  

Transparency: Controls the production of alpha information from bitmap 
images. If this module reads a 1 or 3-channel image, this option will create a 
matte from the colour values in the image. If the module reads a 4-channel 
image and this option is not selected, the alpha information in the image will be 
ignored.

Transparency Type  

Premultiplied with Black: Semi-transparent pixels in the original image are 
blended with black. 

Premultiplied with White: Semi-transparent pixels in the original image are 
blended with white. 

Straight: Semi-transparent pixels in the original image are left as is 
(unmatted). 

Clamp Colour to Alpha: Semi-transparent pixels in the original image are 
blended with black. On import, each of the RGB channels is clamped so that a 
color value never exceed the alpha value for a given pixel. When the RGB 
values are multiplied with the alpha value, that is to say, if you have a pixel of 
value R=247, G=188, B=29 and the alpha is 50% or the image has a 50% 
transparency, then the actual RGB values output would be half of the amounts 
listed above.

Controls Tab
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The Controls tab contains animation control options.

Parameter Description

Animation

Animate Using Animation Tools: By default, a drawing layer can be animated 
using the same parameters as a peg, but you can disable this feature. Being 
able to switch your drawing layers so they can no longer be animated without a 
peg has certain advantages. In cut-out animation, it is easier to separate your 
drawing exposure and keyframes to change timing easier and rearrange 
keyframe position in the Timeline view. This feature is also available for 
backward compatibility when bringing in templates created in older versions of 
the software, so as not to lose their offset keyframes or drawing substitution 
keyframes.

Angle Limit Values

Lets you set a maximum and minimum rotation angle for a drawing. This option 
is used mainly for a cut-out character when you do not want an elbow to bend 
too far in or out. 

 Enable Min/Max Angle: Activates the minimum and maximum angle 
constraints. 

Min Angle: Type the minimum angle you want the drawing to rotate too. 

Max Angle: Type the maximum angle you want the drawing to rotate too.

Spline Offset

In the X, Y and Z axis fields, type the coordinates of where you want to offset 
the visual trajectory. By default, the trajectory is displayed at the centre 
drawing, using the layer's pivot position. If you want to move it so it 
corresponds better with your drawing, either type new coordinates or use the 
Spline Offset  tool available in the Advanced Animation toolbar.  

To display the trajectory in the Camera view, select your drawing and select 
View > Show > Control. You can also press Shift + F11 (Windows/Linux) or 
⌘  + F11 (Mac OS X).

Advanced Tab 

The Advanced tab contains options for setting the alignment of drawings, clipping, line thickness, vector render 
options, and more.
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Parameter Description

Alignment

Alignment Rule: The alignment rule selections are intended to deal with drawings 
that were created on paper of a different size or orientation from the default 
alignment rule (set up in the Scene Settings dialog box) or imported bitmap 
images. The drawings are then scaled to match the Harmony alignment 
rectangle. Note that alignment rules are not based on the camera frame, but on 
the scene frame. Refer to the Fundamentals Guide to learn more about scene 
alignment and scene settings.

• Left: The default alignment for drawings; aligns the drawings to the left 
side of the scene’s alignment rectangle. Harmony scales the drawings to 
match their height to the alignment rectangle of the scene.

• Right: Aligns the drawings to the right side of the alignment rectangle. 
Harmony scales the drawings to match their height to the height of the 
alignment rectangle of the scene.

• Top: Aligns the drawings to the top of the alignment rectangle. Harmony 
scales the drawings to match their widths to the width of the alignment 
rectangle of the scene.

• Bottom: Aligns the drawings to the bottom of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.
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• Centre Fit: Centers the drawings.

• Centre Fill: Centers the drawings and then scales them so the width or 
height fills the available space.

• Centre LR: Aligns the drawings in the left-right centre of the alignment 
rectangle. Harmony scales the drawings to match their height to the height 
of the alignment rectangle of the scene.

• Centre TB: Aligns the drawings in the top-bottom centre of the alignment 
rectangle. Harmony scales the drawings to match their widths to the width 
of the alignment rectangle of the scene.

• Stretch: Scales the drawings so they fit within the alignment rectangle of 
the scene. This is particularly useful for images that you will manipulate 
with a Quadmap node. If the drawings in the Quadmap node do not have 
the same aspect ratio as the alignment rectangle of the scene (from the 
Scene Settings dialog box), the handles on the quadmap will not appear on 
the corners of the image, making it difficult to manipulate the quadmap. In 
this case, you would set the drawing layer of the quadmap images to 
Stretch to make the handles appear on the corner of the image. This can 
have the effect of distorting the images, but it is not an issue with images 
that will be distorted through the Quadmap node anyways.

• As Is: Leaves the drawings aligned as they are. 

• Centre First Page: Aligns the centre of the first part of a standard pan cel 
with the centre of the field chart.

Turn Before Alignment: Rotates  the drawings in the selected element 90 
degrees to the left before scaling and aligning them according to the alignment 
rule, and before performing any offset, rotation or scaling for the element or peg. 
This and the Alignment Rule are intended for drawings that were created on paper 
of a different size or orientation than the other paper in the scene, and requires 
alignment  so they are treated accurately.

Flip Horizontal: Flips the drawing on the X-axis.

Flip Vertical: Flips the drawing on the Y-axis.

Clipping

No Clipping: Select this option if you do not want to clip the images in this node 
before an effect is applied to it.

Clipping Factor (X)/(Y): This is an option for rendering images that are larger 
than the final frame. With this option enabled, images can be moved by an Apply 
Peg Transformation node without black entering into the composite as a result 
of early clipping. In addition, this option is useful for images that have a blur that 
should appear in the frame even though the image itself is not in frame—see Apply 
Image Transformation and Apply Peg Transformation.

Line Thickness

As you move the camera in your scene along the Z-axis, notice that, logically, the 
lines of the elements become thicker the closer the camera gets to the drawing. If 
you prefer the lines to remain the same size or become thicker at a different 
speed, you can use the thickness feature to adjust your brush stroke and pencil 
line thickness. You can modify the size of the lines even if the camera is not 
animated.
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To learn how to use this feature, see Camera Truck-ins and Line Thickness.

Adjust Pencil Lines Thickness: Lets you work with pencil lines and adjust their 
thickness. You will not see any changes to lines in the Camera view OpenGL 
mode. You must switch to the Render mode.

Normal Thickness: Disables all overrides on the brush stroke line thickness. 
This option must be enabled in order for the pencil line thickness parameter and 
pencil lines to appear. If you want to modify the brush stroke thickness, deselect 
this option. To enable brush strokes to work with the line thickness feature, you 
must first create central strokes in the Colour Art layer. The central strokes 
control the line variation of your brush strokes in the Line Art layer. Select 
Drawing > Create Colour Art from Line Art.

Zoom Independent Thickness: Select this if you want your line thickness to 
remain constant independently from the camera move. Everything else will 
increase in size, but the line thickness will stay the same.

Proportional: Enter a multiple by which you want to increase the line thickness 
base on its original thickness. A value of 1 will result in no change; a value of 0 
(zero) will hide the lines.

Constant:  Enter a value in pixels (based on a 720x540 screen resolution) to 
indicate the amount of pixels you want to add around the existing line.

Minimum: Enter a value in pixels (based on a 720x540 screen resolution) for the 
minimum line thickness allowed.

Maximum: Enter a value in pixels (based on a 720x540 screen resolution) for the 
maximum line thickness allowed.

Vector Render Options

• Antialiasing Quality: A smoothness (antialiasing) setting applied to the 
final rendered image. 

• Low: No antialiasing 

• Medium Low: Basic antialiasing

• Medium: Improved antialiasing (blurs the textures)

• High: High quality antialiasing (does not blur the textures)

Higher quality images require more time to render and more system 
memory. Choose a lower quality if you are rendering a pencil test.

• Antialiasing Exponent: Controls the size of the area around the final 
image edges used in the antialiasing process. A higher value uses less 
area, resulting in sharper edges, while a lower value uses more area, 
resulting in softer edges. If the Antialiasing Quality value is set to Low (no 
antialiasing) or Medium Low, this value is ignored. Values: Between 0 and 
1.

• Texture Filter: This option changes the way coloured pixels of TVG 
textures are calculated when rendered for different degrees of accuracy. 

• Bilinear: This option takes the four pixels around each point and 
makes a bilinear interpolation between them. (Medium Quality)

• Nearest: This option chooses the colour of the closest pixel to a point. 
(Lower Quality)
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• Nearest (Filtered): This option is an improved version of Bilinear and 
improves the quality when zooming on a texture. (Best Quality)

Miscellaneous

• Depth: Overrides the order of cables in the node system to determine the 
forward/backward order in which this element is rendered. The Z position 
value overrides the depth value.

• Morphing Velocity: Creates a velocity function curve for morphing 
sequences in the layer. This function modifies the interpolation percentage 
between the 2 drawings. If set, the morphing between the two drawings 
will not be linear over time between the two drawings but will be modulated 
according to this curve.  This can be used to create a periodic morphing 
over a long period of time.

• Opacity: Lets you quickly change the transparency of the selected 
element. Opacity settings here will be reflected in both OpenGL preview, 
and full render.  
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Chapter 3: Menus
There are several types of menus in Harmony: main menus, quick-access menus and view menus.

• Main Menus on page 119

• Quick-access Menus on page 142

• View Menus on page 143

Main Menus
The main menus contain most of the commands. Depending on the view you're working in and the element, some 
commands are available and others not. The main menu is always located at the very top of the interface.

On Mac OS X, there is also a Stage category that contains the following commands:

• Preferences

• About

• Quit

Animation Menu

The Animation menu lets you access tools, adjust animation timing, set deformation, morphing and IK parameters, 
lock or unlock layers, and select elements in the Xsheet and Timeline views.

How to access the Animation menu

‣ At the top of the interface, select Animation.

Command Description

Animate

Enables the Animate mode which lets you keyframe drawing layers to 
create computer-generated animation. When working in the Animate 
mode, you can animate a layer's position and then turn off the mode to 
reposition a layer for the entire scene. When the Animate mode is 
disabled, keyframes are created on selected layers at the current 
frame. Depending on what transformations were performed (rotation, 
translation, skew), the new keyframes are added on the corresponding 
parameters (function curves).

Stop-Motion Keyframe

Sets a stop-motion keyframe which there is no computer-generated 
motion between two keyframes. The segment is constant or flat. The 
drawing remains still until the playback reaches the next keyframe, 
then the drawing pops to its new location.

Delete Keyframe Deletes the selected keyframe.

Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate 
and skew as one unit, which is useful for cut-out characters.
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Inverse Kinematics
Lets you pull on a character's extremities, such as the hands and feet, 
and have the rest of the body follow. Can be used on any piece con-
nected in a hierarchy. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale 
an object up to make it larger or down to make it smaller. Press Shift to 
scale the element while maintaining its proportions.

Skew Slants the selected element.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you 
move them towards or away from the camera.

Spline Offset

Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If 
your elements were drawn in a different location than the centre of the 
drawing area, it will look like the trajectory is not aligned with your 
drawing. Also, if you have several elements attached to one trajectory, 
you might want your trajectory to be at a different location to represent 
the group's motion better.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every 
drawing included in a layer. 

Cell

Increase Exposure

Adds one more exposure to a selected cell; repeating this action adds 
an extra cell each time. This is an efficient way to extend a drawing's 
exposure and is always set in Insert mode. Increasing an exposure 
pushes the existing exposure forward.

Decrease Exposure

Decreases exposure of a selected cell by one; repeating this action 
decreases one exposure adds an extra cell each time. This is an 
efficient way to shorten a drawing's exposure. Decreasing an exposure 
pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure

Lets you enter the frame up to which you want to extend the exposure. 
You can expose the drawing in the frames and replace the drawings 
that were originally there or move the subsequent frames forward in 
time.

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key Exposure
Removes only the key exposure (key frames) not all the exposures. 
The existing key exposure is replaced by the preceding exposure.

Remove Duplicate Key Exposure

When working with drawings to adjust the timing of a mouth in a 
lipsync, for example, and forcing the use of specific key exposures, 
unnecessary key exposures will be created. You can delete these 
duplicates without affecting the rest of the drawing. The first drawing of 
the selection will be used for the range.
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NOTE: Duplicate key exposures may occur when pasting with the 
Enforce Key Exposure option selected.

Fill Empty Cells

Lets you fill empty cells to extend the exposure of single frame 
drawings to fill the range of empty cells after each one.When creating 
drawings on  cells that are not side-by-side, the exposure of the first 
drawing no longer fills automatically. You must select the frame range 
where you want your drawings to hold their exposure up to the next 
drawing and use the Fill Empty Cells command.

Insert Blank Cell Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and Pull
Replaces the exposure from the selected cell with exposures that 
follow it.

Fill Selection

Lets you fill the same value over an entire selection. The selection can 
be over one cell, a cell range in one column, a cell range over many 
columns, an entire column, or many columns. You can use numbers, 
words, letters, or any alphanumeric value.

Sequence Fill

Lets you create a numbered sequence over a selection. The sequence 
can be forward, backward, single, double or higher increment, as a 
cycle, and so on. The selection can be over one cell or a cell range in 
one column or more or an entire column or many entire columns.

Fill Cells Randomly

Lets you fill in random values over a selection. You can give a 
maximum and a minimum value and create a range for Harmony to 
choose the random values from. The selection can be over one cell or a 
cell range in one column or more or an entire column or many entire 
columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Deformation

Set Curves and Offsets 
Independent from Parent

When you transfer a curve's position to its parent offset, first you must 
to set curves and offsets independent from parent.

Transfer Curve Values to Offset

Lets you transfer all of the information from first curve deformer to its 
parent Offset node. This is useful for a legacy scene created using 
Curve deformations where the Offset's position has been placed far 
away from the drawing to make sure it doesn't affect  the drawing's 
deformation. You can bring back the offset and give it the first curve's 
position. The Envelope deformation lets you animate the offset of each 
curve separately. The offset no longer needs to be placed far away.

Convert Elliptic Deformation ROI 
to Shape

After you have created a deformation chain using Elliptic as the Zone of 
Influence type, you can select your deformer and click on this button to 
convert it to a Shaped type. Control points will appear around the shape 
making it easy to customize.

NOTE: You can also convert the Elliptic zone of influence to a shape. 
From the top menu, select Animation > Deformation > Convert Elliptic 
Deformation ROI to Shape. This will create a much smaller  initial 
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zone of influence than if you were to convert it directly to a shape.

Convert Deformed Drawing to 
Drawings

Converts deformation animation to a drawing sequence so you can 
adjust it using the drawing tools to perfect something or add detail. You 
may also want to change the timing and set it on double frame instead 
of single frame.

Convert to New Drawing and Add 
Deformation Chain

Takes the pose/drawing and the deformer of the selected frame and 
converts it to a new pose/drawing with the corresponding deformer. 

Exposure Fill

Using Render Change

Modifies the timing (exposure) of the selected layer, lets you adjust the 
parameters to assign when the texture exposure changes will occur. 
You can adjust the type of filter to use for the motion detection, as well 
as threshold values to indicate what will be considered a big enough 
motion variation for an exposure change—see Exposure Fill Using 
Render Change on page 1.

Morphing

Create Morphing
Lets you control a morphing sequence by placing different types of 
hints to help Harmony morph the animation the way you want it.

Insert Morphing Key Drawing Creates a morphing keyframe from a selected morphing frame.

Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire 
sequence between the two keyframes.

Convert Morphing to Drawing

Lets you convert your morphing inbetweens to real drawings you can 
edit. This is useful when manually editing a morphing sequence or if 
you prefer to have animation timing in double frame (on twos) instead of 
single frame (on ones). 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush 
lines; in other words, on Contour vectors. It allows you to control the 
line thickness and contour position. Also, if a contour is not animated 
correctly, you can use hints to correct the animation. For example, if a 
flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough 
away from the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the 
proximity rule. The Zone Hint is placed in the centre of the colour zone. 
Sometimes a colour zone is not associated with the corresponding one 
by default. For example, in a splash animation there are many water 
droplets that are the same colour. Harmony automatically morphs the 
droplet to the nearest one. This is not always the one you may have 
predicted. A Zone Hint will force a colour zone to morph with another 
one.

Zone Hint points are cyan in colour.

Pencil Hint
A Pencil Hint  point is used to control a pencil line, also known as 
central vector. It can be used on drawings that were done using the 
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Pencil, Polyline, Ellipse, Line and Rectangle tools. Like the Contour 
Hint, the Pencil Hint snaps to the central vector. Make sure to place it 
far enough away from the line so you will see it snap when you move it.

Pencil Hint points are magenta in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an 
appearing shape. A shape will appear in the destination drawing when 
there is no corresponding shape in the source drawing. If you do not 
place an Appearing Point Hint to control the point of appearance, the 
shape will appear from its centre and expand outwards.

Appearing Point Hint points are violet in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a 
vanishing shape. A shape will vanish from the source drawing when 
there is no corresponding shape in the destination drawing. If you do 
not place a Vanishing Point Hint to control the point of disappearance, 
the shape will vanish into its centre.

Vanishing Point Hint points are green in colour.

Switch Between Morphing Key 
Drawings

Toggles between the two key drawings in your morphing sequence. 
This option is useful while setting hints. You can use the default 
keyboard shortcut F4 to toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous Frame
Goes to the previous frame of the selected frame in the morphing 
sequence.

Go to Next Frame
Goes to the next frame of the selected frame in the morphing 
sequence.

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest Hints
Automatically sets hint points on key drawings as a help tool. If you're 
not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.

Hide Hints
Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you 
would like to see.

IK Constraints

Set IK Nail Blocks the X, Y and Z positions.

Set IK Hold Orientation Blocks the angle.

Set IK Hold X Blocks only the X position.

Set IK Hold Y Blocks only the Y position.

Remove All Constraints Removes all nails except the minimum and maximum angles.

Lip-Sync

Change Mouth Shape to
Lets you change the mouth shape to one of the following: A, B, C, D, E, 
F, G, X.

Auto Lip-Sync Detection Generates a sound detection for lip-sync.

Map Lip-Sync Automatically maps drawings in an element to the mouth chart you 
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have generated for a sound. This can save time when you are lip-
synching a voice track.

Flip

Flip Horizontal
Flips the selection horizontally or vertically.

Flip Vertical

Flip Scale X

Once your drawing layer is rotated, the original horizontal and vertical 
axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-
axis of the layer and flips the element following it.

Flip Scale Y
Remembers the original Y-axis of the layer and flips the element fol-
lowing it.

Linear Motion Switches between a linear and curved corner.

Lock in Time
Indicates if the point is locked to a specific frame (keyframe) or only 
locked to a specific position and the curve can flow through it freely as 
other points are being added, moved, or adjusted (control point).

No Z Dragging
Keeps the Z value when you drag a character using the Transform or 
Translate tool.

Substitute Drawing Previous Replaces the drawing or cell's symbol on the current frame by the pre-
vious or next drawing.Substitute Drawing Next

Go to Previous Keyframe
Go to the previous or next keyframe.

Go to Next Keyframe

Select Previous Keyframe /Point
Select the previous or next keyframe/point.

Select Next Keyframe /Point

Select Child Skipping Effects
Lets you select the first element parented to the selected peg element 
in the Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element 
in the Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in 
the Timeline view.

Select Group Content Selects all of the contents of the group.

Select Parent Skipping Effects
Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the 
Timeline view.

Select Next Sibling
Lets you select the next element (below current element) in the 
Timeline view.

Lock

Lock Locks one or a multiple selection of layers. 

Unlock Unlocks one or a multiple selection of locked layers.
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Lock All Locks all the layers in the Timeline view. 

Unlock All Unlocks all the layers in the Timeline view. 

Lock All Others Locks every layer except the selected ones.

Reset

Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the 
transformation angle will be reset to 0 and if the Transform  tool is 
active, all the transformation values will be reset.

Reset All

Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the default 
position. All transformations are reset regardless of the tool you're 
using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often 
have a particular Z ordering for the different views of a character. You 
might want to reset the transformation, but not necessarily the Z 
position. 

Drawing Menu

The Drawing menu lets you access many tools related to drawing, painting, dirt removal, optimizing strokes, and 
more.

How to access the Drawing menu

‣ At the top of the interface, select Drawing.

Command Description

Drawing Tools

Activates a drawing tool including: 

Select, Contour Editor, Pencil Editor, Cutter, Smooth Editor, 
Perspective, Envelope, Reposition All Drawings, Drawing Pivot, 
Brush, Pencil, Text, Eraser, Dropper, Morphing, Line, Rectangle, 
Ellipse, Polyline, Paint, Ink, Repaint Brush, Close Gap, Stroke, Edit 
Gradient/Texture, Hand, Zoom and Rotate View.

These drawing tools are available on the Tools toolbar.

Clean Up

Remove Dirt
Opens the Remove Dirt dialog box where you can specify the number 
and size of dots removal from a selected drawing.

Remove Hair

Opens the Remove Hair dialog box where you can specify the number 
and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or 
filled zones. Increase the value to select larger strokes for removal 
from the drawing. 

Close Gaps
Closes small gaps in a drawing by creating small, invisible strokes 
between the two closest points to close the colour zone. You do not 
need to trace directly over the gap. You can draw it a few millimeters 
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away. The two closest points automatically close the gap.

Remove Art Inside Selection

Removes any art inside a selection. It is recommended that you clean 
your Colour Art level as well. If you have a stroke accumulation in the 
Colour Art, it can result in large output files, especially if you work in 
high definition resolutions. 

Remove Art Inside Selection on 
All Drawings

Removes any art inside all drawings selected with the Permanent 
Selection  option in the Select tool.

Remove Art Outside Selection

Removes any art existing outside a selection. It is recommended that 
you clean the Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, 
especially if you work in high-definition resolutions.

Remove Art Outside Selection on 
All Drawings

Removes any art outside all drawings selected with the Permanent 
Selection  option in the Select tool.

Paint
NOTE: The Paint commands require you to use the Permanent 
Selection  option in the Select tool so you can maintain a 
selection over multiple drawings.

Unpaint Selection Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings
Unpaints all art contained inside a selection on all the drawings within 
the same layer.

Unpaint Outside Selection
Unpaints any art existing outside a selection. If no selection have been 
drawn using the Select tool, the entire drawing will be unpainted.

Unpaint Outside Selection on All 
Drawings

Unpaints all art outside a selection on all the drawings within the same 
layer. 

Repaint Selection Repaints any art inside a selection.

Repaint Selection on All Drawings
Repaints any art inside a selection on all the drawings contained within 
the same layer. 

Repaint Outside Selection
Repaints any art outside a selection. If no selection has been drawn 
using the Select tool, the entire drawing will be repainted.

Repaint Outside Selection on All 
Drawings

Repaints any art outside a selection on all the drawings contained 
within the same layer. 

Convert

Pencil Lines to Brush Strokes
Converts the selected centreline pencil strokes into contour strokes 
brush lines.

Brush Strokes to Pencil Lines
Converts selected contour strokes into centreline pencil strokes. The 
brush stroke thickness will be lost.

Strokes to Pencil Lines Converts the selected invisible line to a pencil line.

Break Apart Text Layers
Text is treated as a single drawing object. This separates the text so 
each character becomes an individual drawing object you can select 
and modify independently.

Optimize

Flatten Merges drawing objects and brush strokes into a single layer. If you 
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draw new lines to fix a drawing or line with many brush strokes, it can 
be useful to flatten them all into a single shape. By default, lines are 
drawn one on top of each other. If you intend to repaint the lines or 
modify their shape, it will be easier if they are flattened. 

Smooth Smooths selected drawing strokes and removes extra points.

Create Contour Strokes
Adds a permanent invisible line around a shape that was drawn directly 
in Harmony. This allows you to unpaint lines with the Paint  tool but 
maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes

Remove any permanently invisible lines that were created while 
scanning and vectorizing drawings or manually adding contour strokes. 
This is useful for removing the intersection triangles created during 
vectorization.

Remove Extra Strokes
Removes strokes inside painted area. This option only works after the 
painted drawing is flattened.

Optimize

Reduces the number of layers, such as overlapping brush strokes, in 
the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of 
the final image when they are merged. 

Crop Brush Textures

Crops an unnecessarily large texture bitmap that lies unseen beneath 
the vector contour of a textured line. This often occurs when you cut 
and paste textured lines from one drawing into another. If you cut a por-
tion from a textured line and paste it into a different drawing, Harmony 
pastes the entire unseen texture bitmap from the source drawing into 
the new one, even if you only took a small portion of the source draw-
ing. Using the Crop Brush Texture command will crop away extraneous 
texture that does not touch the vector area. If there are many textured 
lines in your scene, this will greatly reduce the file size.

Reduce Drawing Texture 
Resolution

When you import and vectorize as texture (colour) a high resolution 
image, the size of your drawing can be heavy. You can reduce the size 
and resolution of the textures in a drawing. 

When you import and vectorize drawings using the grey or colour 
preset styles, you don't have control on the size of the bitmap texture. 
You can reduce that bitmap texture.

Transform

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 CW Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW Rotates the current selection 90 degrees counter-clockwise.

Rotate 180 Rotates the current selection 180 degrees.

Arrange

Bring to Front Moves the selected art to the front (on top).

Bring Forward Moves the selected art one level forward (closer to the front).

Send Backward Moves the selected art one level lower (behind).
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Send to Back Moves the selected art behind everything (bottom / back).

Create Empty Drawing
Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets 
another drawing, key exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you 
modify an existing drawing but retain the original. 

When duplicating a drawing, the selected cell is replaced with the new 
drawing. The exposure of the original drawing that was on the current 
cell is removed. The original drawing is not deleted from the project 
folder or other cells in which it is exposed.

Delete Selected Drawings
Permanently removes selected drawings. Once you save your project, 
these drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Rename Drawing with Prefix
Lets you rename a drawing sequence with a prefix, which can be quite 
useful for cut-out puppet breakdown and deformation animation. This 
applies to any deformation work done in pre-Harmony 12 versions.

Rename by Frame
Lets you rename a series of drawings relative to their frame position. 
This is useful in hand-drawn animation.

Select Strokes with Current Colour
Lets you select drawing elements and painted areas with the same 
colour as the currently selected colour in your colour palette.

Distribute to Layers

Every selected stroke in the Camera view is placed on separate layers; 
one layer per stroke. If artwork is composed of several strokes, you 
must group them to put them on the same layer. 

This operation cannot be done in the Drawing view.

Create Colour Art from Line Art

Lets you use the outline you traced on one of the four embedded layers 
(line art, colour art, overlay, underlay) and create invisible strokes to 
paint your drawings on separate layers. This provides more inking and 
painting flexibility. 

You can also configure this option to create the invisible strokes on any 
of the four embedded layers.

Create Breaking Triangles

Useful for brush strokes, creates triangular breaks at natural line 
intersections. These intersections are the probable locations where 
colour line breaks may occur, such as where a sleeve meets a hand. 

This makes it easier to soft trace lines in different colours when there 
are flattened or unflattened clean brush strokes.

Generate Auto-Matte
Fills colour based on currently selected colour swatch on different 
drawing layers (overlay, underlay) so overlapping lines are more visible 
during a line test.

Adjust Line Texture Opacity Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap Drawing Resolution

Lets you change the resolution of bitmap art for individual drawings. 
You can reduce the resolution of your bitmap file as well as increase it. 
Be careful because enlarging the bitmap resolution on an existing 
drawing will result in a loss of quality.Harmony will perform a pixel 
smoothing pass (resampling) and create additional pixels to avoid 
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losing too much quality, but only to a certain extent.  

This feature is very useful when you need to have a full resolution of a 
bitmap image (such as imported bitmaps as .psd or .tga for the 
background) for tracing to create a matte directly in Harmony.

By default, Harmony creates small thumbnail images when imported 
as bitmap in order to increase performance by using a small thumbnail 
image instead of using the original large size bitmap for animation work 
in Harmony. This will make difficult to view details or trace due to the 
low resolution (blurry). This option temporary increases the resolution 
of bitmaps up to their original bitmap resolution to make tracing easier.

NOTE: Regardless of using small thumbnails in Harmony, the final 
render will use the real image resolution so there is no loss of quality 
in the final render.

NOTE: The small thumbnail size can be changed in Preferences 
(Camera tab).

Previous Drawing Once a cell is selected in the Timeline or Xsheet view, you can 
navigate between the drawings, frames, and layers.

Displays the previous drawing, next drawing, previous layer or next 
layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection
Temporarily enables/disables the Colour Protection feature so you can 
quickly correct wrongly inked or painted areas under protected colour 
without readjusting the Current Colour Protection option.

Respect Colour Protection

In the Colour view, you can protect a colour swatch to avoid repainting 
or unpainting the zones linked to that swatch. If you using the Paint tool 
and this option is deselected, you will repaint or unpaint the protected 
colours on your drawings until you enable the option again.

Edit Menu

The Edit menu lets you repeat and undo actions, cut/copy/paste selected objects, select and manipulate objects, 
work with symbols, and access the Preferences dialog box.

How to access the Edit menu

‣ From the top menu, select Edit.

Command Description

Undo
Removes the last change made to your project. Harmony supports 
multiple undo, so you can undo changes you made in the order you 
made them.
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Redo
Redoes an operation you have undone. This command is active only 
after you use the Undo command.

Cut
Removes selected objects. You can then paste the object or its prop-
erties to another object.

Copy Copies selected objects and properties.

Paste
Places an object you cut or copied into the location you select in a 
view.

Paste Special

Opens the Paste Special dialog box which lets you determine how 
templates and symbols are imported in the Timeline view. 

There are advanced paste options for drawings, timings, keyframes, 
layers, as well as palettes and symbols.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the 
number of cycles to paste and select a type of cycle: Normal, Reverse, 
Forward-Reverse and Reverse-Forward.

Paste Reverse
Reverses the timing of drawings or keyframes in range of selection 
after copying.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the 
Drawing, Timeline and Camera views. This helps you manage multiple 
objects as one when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selected all other items that 
were not selected. For example, if some lines are selected in a 
drawing, this command will deselect them and select any other lines in 
the drawing that were not selected.

Not clear for me. Missing information: This however unselects the 
currently selected drawing (e.g. unselect current selected lines and 
select everything else that is unselected).

Auto-Apply

Automatically applies changes you make to a property dialog box. Har-
mony applies the modification automatically and displays the result 
immediately in the Camera view. If you do not want to immediately dis-
play every change made to your scene, turn off this default setting by 
deselecting the Auto Apply option. This is useful when you are working 
on a very heavy scene.

NOTE: If you want to always work in Auto-Apply mode, you can 
deselect the Auto-Apply option in the Preferences dialog box (General 
tab). Then, each time you start Harmony, the Auto-Apply  mode will be 
off. You must click the Apply button to see any modifications.

Create Symbol
Creates a symbol from selected drawing elements in the Drawing or 
Camera view, nodes in the Node view, or a layer or cells in the Timeline 
view.
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Open Merge Editor
Lets you bring together (merge) the layer or drawings from different 
version of the same scene.

Expand Symbol

Extracts a symbol's contents and places it on the root timeline. Its 
contents will be copied and inserted into the root timeline. The symbol 
will not be removed from the Timeline view once it is expanded. 

The symbol's layers will be parented to it in case you created motions 
and transformations on the drawing layer that contain the symbol. 
Breaking the hierarchy could result in the loss of any scaling and 
animation you may have created.

Expand Selected Symbol in Groups
Expands a symbol within a group to avoid crowding the timeline with a 
series of layers. When you expand the symbols, the layers will be con-
tained in a group node that you can expand to see the content.

Duplicate Selected Symbol
Creates a duplicate of a selected symbol. If other symbols are nested 
inside the new symbol, they are not duplicated. If you modify them, the 
original and other instances will also be modified.

Create Drawing from Drawing Selection

Breaks a character into its main body parts. There is no need to create 
any layers prior to this process. Make sure your model is well centered 
and sized in the Camera view—see Breaking Down the Main Parts on 
page 1.

Clone: Drawings Only
Creates a copy of the drawings in the selected layer in the Timeline 
view or column in the Xsheet view. The timing it not copied.

Clone: Drawings and Timing
Creates a copy of the drawings and their timings in the selected layer in 
the Timeline view or column in the Xsheet view.

Duplicate

Duplicates a layer to have a copy of the drawings that are independent 
from the original ones, as well as an independent timing (exposure). 
When you need the drawings to be modified independently, you will 
want to duplicate the layer instead of cloning it.

Merge

There are two methods of merging drawings. 

• You can merge selected drawings in adjacent elements. The 
columns and layers will be left intact, and each new merged 
drawing will reside in the frames of the left-most column or lower 
layer.

• You can merge elements. All drawings will be merged. Unused 
columns and layers will be deleted, but the original drawing files 
are still accessible.

Group

Group Groups selected drawing objects in the Camera or Drawing view.

Ungroup
Ungroups a selected group of drawing objects in the Camera or 
Drawing view.

Group Selected Layers
Groups selected layers in the Timeline view or nodes selected in the 
Node view.

Ungroup Selected Layers Ungroups a selected group in the Timeline or Node views.

Move to Parent Group
Moves selected nodes in the Node view up to the parent group level, 
maintaining all connections.
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Edit Drawing Mode

When the Auto-Get Rights to Modify Drawings option is selected in the 
Preferences dialog box (General tab), the system automatically gets 
the rights to modify drawings when you select a drawing. Otherwise, 
you must manually get the rights to modify drawings.

Edit Palette List Mode

When the Auto-Get Rights to Modify Palette option is selected in the 
Preferences dialog box (General tab), the system automatically gets 
the rights to modify palettes and palette lists when you select a colour 
from a palette. Otherwise, you must manually get the rights to modify a 
palette or palette list.

Get Rights to Modify Drawing Manually released the rights to modify a selected drawing.

Release Rights to Modify Drawing Manually releases rights to modify a selected drawing.

Force Release Rights to Modify Drawing
This option is always available even if the Get Rights to Modify All 
Scene Assets option is not selected in the Database Selector dialog 
box.

Preferences
Opens the Preferences dialog box where you can set your preferences 
for Harmony.

File Menu

The File menu lets you open, close, save, scan, print, and import and export files.

How to access the File menu

‣ From the top menu, select File.

Command Description

Open
Displays the Open Scene dialog box where you can browse for a 
scene file.  You can open a new scene from the current one and the 
previous scene will close.

Close
Closes the currently opened scene, but does not close the Harmony 
application.

Save
Saves all changes made to the opened scene, drawings, palettes, 
and palette lists.

Advanced Save

Lets you do the following:

 l Save the scene as the current version.

 l Save different versions representing different stages of the 
production of your scene.

 l Save different versions representing different scene setups.

 l Choose specific assets that you want to save, such as draw-
ings or palettes. 

Rights to Modify Scene Version
Allows you to modify the selected version of the scene and access 
the version manager during the opened session

Rights to Modify Scene
Allows you to modify the currently selected scene version, but locks 
access to the version manager during the opened session.
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Read Changed Drawings

Determines which drawing files have been modified on disk since 
you loaded them. All updated drawings will be reloaded. 

NOTE: Reloading a locked drawing will discard unsaved changes.

Manage Versions Allows you to manage all the versions of the current scene.

Update Database Scene
Updates your database with only the changes you made to the 
scene. To do this, you must enter your host name and host port in 
the Preferences dialog box, General tab.

Download Database Changes
If any changes were made to the scene you downloaded, you can 
perform an update by downloading these changes, which will be 
integrated into your scene.

Remove Unused Files Removes the unused palettes from the scene list.

Import

From Scanner Imports drawings from a TWAIN scanner.

Images
Imports bitmap images which you can choose to vectorize—see 
Importing Bitmap Images  on page 1.

3D Models

Once you have exported a model using a 3D authoring software, you 
can import it and integrate it in your 2D animation scene.  You have 
the possibility to convert your 3D models to *.osb files upon import 
to Harmony and save them as such. This will allow Harmony to 
render 3D files with the associated textures without the need to copy 
them manually (as long as the auxiliary files are linked correctly and 
named appropriately on your disk)—see Importing a 3D Object on 
page 1.

Link to Images
Links to images stored on a centralizer server when working with 
Harmony Server.

Movie
Lets you convert a QuickTime movie to an image sequence and 
audio file.

Sound Lets you import sound files into your project.

Colour Model
Lets you import TVG drawing file into your project. Once imported, it 
is display in the Model view for use as a colour model which you can 
load into any Harmony scene.

SWF, Illustrator Files to Library Lets you import SWF files into your project.

Export

Movie
Exports animation as a QuickTime movie—see Exporting a 
QuickTime Movie on page 1.

Render Write Nodes

Renders all the Write nodes in a node structure. 

When working with Harmony Server, you can send your scene to 
batch processing and to a render farm—see Batch Rendering.

Soundtrack
Exports a sound file as a merged soundtrack or series of individual 
files. The exported soundtracks are generated as *.wav files—see 
Exporting a Sound File on page 1.
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SWF

Exports a Flash movie file. 

The SWF export supports some bitmap effects (which can be 
previewed in Render View  mode) and SWF Blend Modes (vector 
effects which can be previewed in OpenGL View  mode).
See Exporting an SWF Movie on page 1.

OpenGL Frames

Exports OpenGL frames (fast display mode) for a quick screen 
renders of a scene that contain no transparency channel. Heavier 
scenes containing 3D, multiple effects and camera moves can be 
fairly long to export—see Exporting OpenGL Frames on page 1.

Layout Image Exports all the elements in your scene to a layout .psd file.

Layout Image from Selection
Exports only the selected elements to a layout .psd file—see Export-
ing a Layout on page 1.

Print

Xsheet
Prints the exposure sheet so you can take it to your animation table,  
provide a copy to the animator, or create your Xsheet skeleton 
directly in Harmony.

Node View Print the Node view for reference purposes.

Quit Closes the application.

Help Menu

The Help menu lets you display the Harmony documentation, Welcome screen and end user license agreement, 
as well as access the Toon Boom website, and identify the product name and version number.

How to access the Help menu

‣ At the top of the interface, select Help.

Command Description

Online Help
Opens the Harmony Help system, complete with instructions on 
how to use the system. This requires an internet connection.

Getting Started
Opens the Harmony Getting Started Guide (in PDF format) in a 
browser window. Requires Acrobat Reader.

Toon Boom on the Web
Opens the Harmony website, which features a Support and 
Community > Forum section.

Customer Experience Improvement 
Program

The Customer Experience Improvement Program allows Toon 
Boom to collect usage information. The data does not contain any 
personally identifiable information and cannot be used to identify 
you. The data will consist of a basic hardware description, a project 
summary and usage information. The information is used only for 
software improvement purposes, as well as for sharing with third 
parties for the same reason.

This program is enabled by default but is voluntary. If you prefer not 
to participate, you can opt out when you first launch the software, by 
using a global preference, or by a command line argument.
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About Identifies the product name and version number. 

Show End User License Agreement Displays the End User License Agreement.

Debug Mode

Enables the Debug mode for gathering and displaying precise 
information about each rendering frame, such as the nodes 
encountered and action taken. You can view this information in the 
Message Log view.

Command Description

Online Help
Opens the Harmony Help system, complete with instructions on how 
to use the system. This requires an internet connection.

Getting Started
Opens the Harmony Getting Started Guide (in PDF format) in a browser 
window. Requires Acrobat Reader.

Toon Boom on the Web
Opens the Harmony website, which features a Support and 
Community > Forum section.

Customer Experience Improvement 
Program

The Customer Experience Improvement Program allows Toon Boom to 
collect usage information. The data does not contain any personally 
identifiable information and cannot be used to identify you. The data will 
consist of a basic hardware description, a project summary and usage 
information. The information is used only for software improvement 
purposes, as well as for sharing with third parties for the same reason.

This program is enabled by default but is voluntary. If you prefer not to 
participate, you can opt out when you first launch the software, by 
using a global preference, or by a command line argument.

About Identifies the product name and version number. 

Show End User License Agreement Displays the End User License Agreement.

Debug Mode

Enables the Debug mode for gathering and displaying precise 
information about each rendering frame, such as the nodes 
encountered and action taken. You can view this information in the 
Message Log view.

Insert Menu

The Insert menu lets you create empty symbols in the Library view, different types of layers in the Timeline view, 
keyframes and control points.

How to access the Insert menu

‣ At the top of the interface, select Insert.

Command Description

Create Empty Symbol in Library
Creates an empty symbol in the Library view to which you can edit (add 
content).

Bone Adds a new Bone layer to the Timeline view.

Camera Adds a new Camera layer to the Timeline view.

Colour-Card Adds a new Colour-Card layer to the Timeline view.
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Drawing
Adds a new Drawing layer to the Timeline view and a column in the 
Xsheet view.

Game Bone Adds a new Game Bone layer to the Timeline and Node views.

Group Adds a new Group layer to the Timeline and Node views.

Kinematic Output Adds dd a new Kinematic Output layer to the Timeline and Node views.

Peg Adds a new Peg layer to the Timeline and Node views.

Quadmap Adds a new Quadmap layer to the Timeline and Node views.

Particle

Basic Particle System
Adds a new layer with a basic particle system in the Timeline and Node 
views. 

Basic Gravity-based System
Adds a new layer with a basic gravity-based particle system in the 
Timeline view. 

Keyframe Adds a keyframe to the selected cell in the Timeline view.

Keyframe and Duplicate Drawing
Adds a keyframe to the selected drawing layer cell in the Timeline view 
and creates a duplicate of the drawing, which sits on top of the original 
drawing.

Position Keyframe
Adds a position keyframe whereby keyframes will only be added on the 
X, Y and Z parameters of the selected layer. Keyframes are not added 
on the Angle, Scale and Skew parameters.

Control Point

Adds a control point to the trajectory of the selected element or peg in 
the Camera view when the element or peg is in a 3D path. Note that 
you must have a 3D path in the peg portion in order to add a control 
point.

Play Menu

The Play menu lets you play back animation and sound. Use it to scrub the sound to create your lip-sync, loop the 
playback, navigate through frames, and change the playback range and speed.

How to access the Play menu

‣ At the top of the interface, select Play.

Command Description

Play Plays and stops the animation.

Render and Play
Creates a render of your scene to play back the final result including 
the effects.

Test SWF Movie
Creates a SWF format movie and a report to test your result before 
proceeding to the final movie.

Stop Stops playback.

Playback Speed
Opens the Set New Frame Rate dialog box where you can set the 
frame rate at which the playback plays.

Loop Repeatedly plays back your animation indefinitely.
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Enable Sound Turns on sound during playback.

Enable Sound Scrubbing Turns on sound scrubbing during playback.

Start Frame
Opens the Set Playback Start Frame dialog box where you can set 
the frame number on which to start playback.

Stop Frame
Opens the Set Playback Stop Frame dialog box where you can set 
the frame number on which to stop playback.

First Frame Moves the red playhead to the first frame.

Previous Frame Moves the red playhead to the previous frame.

Next Frame Moves the red playhead to the next frame.

Last Frame Moves the red playhead to the last frame.

Go to Frame
Opens the Go to Frame dialog box where you can enter the frame 
number on which the red playhead to be positioned in the Timeline 
view.

Enable Playback

Top View

Plays back your animation in the Top, Side or Perspective views.Side View

Perspective View

Scene Menu

The Scene menu lets you set the scene length, add frames to the scene, view different displays of the scene, set 
render options, access the Scene Settings dialog box and Elements Manager window, and verify the drawing and 
palette files in your project.

How to access the Scene menu

‣ At the top of the interface, select Scene.

Command Description

Scene Length Lets you set the length of the scene in frames.

Frame

Add Frames at Start Adds the number of frames you specify to be added at the beginning or 
end of the scene.Add Frames at End

Add Frames Before Selection
Adds the number of frames you specify before or after your selection.

Add Frames After Selection

Remove Selected Frames Deletes the selected frames from your scene.

Camera

Default Camera
Lets you select a camera. If you only add one camera to your scene, 
you will only see Default Camera in your list.

Default Display
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Display All Shows the contents of a specific Display node, updating the contents 
of the Camera, Top, Side, Perspective, and Timeline views—see 
Display Concepts on page 1.Display

Scene Settings
Opens the Scene Settings dialog box where you can set the resolution, 
alignment, bitmap resolution and many other parameters.

Render

Auto Render

Automatically recalculates the preview image whenever you modify a 
parameter. If your scene is heavy and you do not want the preview 
rendered automatically, deselect the Auto-Render option and do the pre-
view update manually.Note that this will slow down Harmony as it 
takes resources to update every frame.

Auto Render Write

Renders a frame each time the current frame is changed. 

You must have a Write node in your node structure to use this 
command.

Recalculate All
Refreshes the node structure and rerenders the display when the Cam-
era view is in render mode.

Recalculate Selected
Refreshes the node structure and rerenders the display of selected ele-
ments when the Camera View is in render mode.

Cancel Preview Render Cancels a render that was started.

Element Manager

Opens the Element Manager window where you can add, delete or 
modify elements (drawing folders) in your scene. If you have drawing 
folders that are not linked to a column in your scene, use the Element 
Manager to delete them if needed. 

Check Files Verifies the integrity of the drawing and palette files in your project. 

View Menu

The View menu lets you manipulate the view by zooming, panning, or rotating. You can also display the grid and 
change its size, use the onion skin feature to help with drawing, and set the preview resolution. 

How to access the View menu

‣ At the top of the interface, select View.

Command Description

Toggle Full Screen

Enlarges the selected view to full screen which is done in three 
stages. 

First, the selected view enlarges to the maximum width or height, 
but keeps the tool views such as Colour or Tool Properties view. 

Second, the view enlarges to full screen. 

Third, the view returns to its original size.

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation 
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table.

Rotate View CCW
Rotates the Camera view 30 degrees counter-clockwise, like an 
animation table.

Reset Zoom Resets the view’s zoom to its default position.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Next Colour Goes to the next colour in the Colour view.

Previous Colour Goes to the previous colour in the Colour view.

Grid

Show Grid Displays the grid.

Grid Outline Only Displays the outline of the grid only.

Underlay Displays the grid under the drawing elements.

Overlay Displays the grid over the drawing elements.

Square Grid Displays a standard square grid.

12 Field Grid Displays a 12-field size grid.

16 Field Grid Displays a 16-field size grid.

Onion Skin

Show Onion Skin

Lets you preview the previous and next drawings. By default, the pre-
vious drawings appear in a shade of red and the next drawings are 
displayed with a shade of green. You can change these colours in 
the Preferences dialog box. 

Add to Onion Skin Adds a series of selected elements to the onion skin preview.

Remove from Onion Skin Removes a series of selected elements from the onion skin preview.

Remove Unselected from Onion 
Skin

Removes all elements except the ones selected from the onion skin 
preview.

Add All to Onion Skin Adds all of the scene's elements to the onion skin preview.

Remove All from Onion Skin Removes all of the scene's elements from the onion skin preview. 

Onion Skinning by Drawing
In Camera view, the onion skin by default is per frame, this option 
lets you set it by drawing so you don't see any exposure's onion skin 
from the same drawing.

No Previous Drawing
Removes the previous drawing's onion skin and displays only the 
next drawing.

Previous Drawing Displays the previous drawing.

Previous Two Drawings Displays the previous two drawings.

Previous Three Drawings Displays the previous three drawings.

No Next Drawing Do not show the onion skin for all of the next drawings.

Next Drawing Show the onion skin for the next drawing.

139



Chapter 3: Menus     

Next Two Drawings Show the onion skin for the next two drawings.

Next Three Drawings Show the onion skin for the next three drawings.

Reduce One Previous Drawing Reduces the number of previous visible drawings by one.

Add One Previous Drawing Adds one drawing to the number of previous visible drawings.

Reduce One Next Drawing Reduces the number of next visible drawings by one.

Add One Next Drawing Adds one drawing to the number of next visible drawings.

Light Table
Turns on the light table so you can see the previous and subsequent 
active layers in washed-out colours. It is useful for seeing the other 
layers when designing, animating or cleaning up your animation. 

Backlight

Produces a silhouette effect by changing the drawing’s coloured 
areas into a single dark, solid colour. Use this to verify the com-
pleteness of the ink and paint process. Any unpainted zones can be 
seen as the light shows through the unpainted areas of the sil-
houetted drawing.

Show

Symbol Pivot

Displays a symbol's pivot. The Symbol pivot is similar to the Draw-
ing pivot. Each symbol cell can have its own pivot and act the same 
as the Drawing pivot. The Symbol pivot can also be referred to as 
embedded pivot. Inside a symbol, each drawing can have its own 
pivot. 

Safe Area
Displays the TV safety zone and the centre of the camera frame. 
The safe area adapts to the scene resolution, as well as the safety 
zone and frame’s centre.

Camera Mask

Displays a black mask around the scene’s frame to avoid seeing the 
unnecessary artwork. This option is handy when you're animating 
and setting up the scene. It allows you to see your scene’s com-
position better.

Control Displays the controls of the selected element.

Current Drawing on Top

Displays the selected drawing on top of everything while you draw. 
By enabling this option, each time you select a drawing tool, the 
selected drawing is displayed in front of everything in the Camera 
view. The Timeline and Node view ordering remain unchanged. 

You only need to enable this option once, it is not necessary to do it 
each time you select a drawing tool.

Outline Locked Drawings
Displays drawing that are locked in the Timeline view (cannot be 
selected in the Camera view) as wireframes.

Show Strokes
Displays the strokes in your drawings so that the invisible lines 
stand out.

Show Strokes with Colour Wash Displays strokes with washed-out colours.

Hide All Controls Hides the controls of the selected element.

Deformation

Show Current Deformers and 
Hide All Others

Shows all current deformers and hides all other manipulators dis-
played in the Camera view.
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Particle

Show Particles as Dots in 
OpenGL

Displays the particles as dots in the OpenGL preview mode. This 
makes the playback speed faster for a heavy scene.

Preview Manager
Opens the Preview Manager where you can set options for the qual-
ity of previews, and clearing and updating the cache.

Preview Resolution

Same as Scene Resolution

Lets you choose a resolution for previewing a scene.

3/4 of Scene Resolution

1/2 of Scene Resolution

1/3 of Scene Resolution

1/4 of Scene Resolution

Custom
Lets you select a resolution from a list of presets or enter X and Y val-
ues for a  custom preview resolution.

Bitmap File Quality
Lets you change the quality of the preview of the bitmap file in the 
Camera view. It will not affect the final render.

Windows Menu

The Windows menu lets you customize your workspace to suit your working style, save it as a new workspace, and 
load it from the Workspace toolbar. You can also show or hide the different toolbars and views in Harmony.

How to access the Windows menu

‣ From the top menu, select Windows.

Command Description

Restore Default Workspace
Returns modified workspaces to their original default layout if you do 
not like the current modifications or inadvertently closed some 
windows.

Workspace

Workspace Manager
Opens the Workspace Manager where you can modify, create, delete, 
rename and reorder your workspaces.

Save Workspace Saves the current workspace along with any modifications you made.

Save Workspace As...
Saves the workspace as a new version to avoid overwriting the current 
one.

Workspace
Lets you open workspaces designed specifically for animating, com-
positing, hand drawing, scripting and the default workspace.

Toolbars

Lets you show or hide these toolbars: Tool Presets, Art Layer, Play-
back, File, Edit, Advanced Animation, Scripting, Coordinate, Control 
Point, Display, Tools, Flip, Onion Skin, Mark Drawing, Easy Flipping, 
Workspace, Deformation, Drawing View, Camera View, Xsheet View 
and Timeline View—see  Toolbars on page 1.

Camera Shows or hides the Camera view.
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Colour Shows or hides the Colour view.

Coord. and Control Points Shows or hides the Coordinates and Control Points view.

Drawing Shows or hides the  Drawing view.

Function Shows or hides the Function view.

Layer Properties Shows or hides the Layer Properties view.

Library Shows or hides the Library view.

Message Log Shows or hides the Message Log view.

Model Shows or hides the Model view.

Node Library Shows or hides the Library view.

Node View Shows or hides the Node view.

Perspective Shows or hides the Perspective view.

Side Shows or hides the Side view.

Timeline Shows or hides the Timeline view.

Tool Properties Shows or hides the Tool Properties view.

Top Shows or hides the  Top view.

Xsheet Shows or hides the Xsheet view.

Script Editor Shows or hides the Script Editor view.

Quick-access Menus
A quick-access menu lets you open a list of the commands you will use most often.

 How to access a quick-access menu

 1. Right-click anywhere in a view.
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View Menus
A view menu contains commands specifically related to that view.

How to access a  view menu 

In the top-left corner of a view, click the Menu  button.

Camera Menu

The Camera menu lets you do many things in the Camera view, including selecting and editing objects in different 
views, changing the display, setting morphing parameters, accessing tools and many more.
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How to access the Camera menu

‣ In the upper-left corner of the Camera view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Stroke With 
Current Colour

Select the strokes that contain the currently selected colour.

Invert Selection

Deselects the currently selected items and selected all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that were 
not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child 
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Group
Group: Groups selected drawing objects in the Camera or Drawing view.

Ungroup: Ungroups a selected group of drawing objects in the Camera or 
Drawing view.

View

Navigation

Zoom In: Zooms in the view.

Zoom Out: Zooms out the view.

Reset Zoom: Resets the view’s zoom to its default position.

Rotate View CW: Rotates the Camera view 30 degrees clockwise, like an 
animation table.
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Rotate View CCW: Rotates the Camera view 30 degrees counter-clockwise, 
like an animation table.

Reset Rotation: Resets the view’s rotation to its default position.

Reset Pan: Resets the view’s pan to its default position.

Reset View:  Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line Art and 
Colour Art@@

Open GL View

Switches the Camera view to fast display, letting you see your animation play 
in real time. The OpenGL display requires less memory. The final look of your 
effects is not shown in the OpenGL View Mode. You must switch to the Render 
View Mode to see your effects.

Render View

Switches the Camera view to a fully rendered display showing the final image 
of the current frame. If a modification is done to your current frame or if you 
move to a different frame, click the Update Preview button to update the 
display if your preview does not update automatically.The Render View Mode 
display lets you see the final look of your frames including effects and 
antialiasing. You cannot play back your scene in Render View Mode. To see 
your scene fully rendered and to play it back, you must press the Render and 
Play  button in the Playback toolbar.

Matte View

Switches the Camera view to a matte display showing the alpha channel of the 
elements in your scene. The transparency level ranges from 0 to 100 percent. 
Zero percent is completely transparent and represented by black and 100 per-
cent is completely opaque and represented by white. Everything in between 
these extremes has a transparency level somewhere between 1 and 99 percent 
and is represented in various shades of grey. 

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.

Overlay: Displays the grid over the drawing elements.

Square Grid: Displays a standard square grid.

12 Field Grid: Displays a 12-field size grid.

16 Field Grid: Displays a 16-field size grid.

Onion Skin

Show Onion Skin: Lets you preview the previous and next drawings. By 
default, the previous drawings appear in a shade of red and the next drawings 
are displayed with a shade of green. You can change these colours in the 
Preferences dialog box. 

Add to Onion Skin: Adds a series of selected elements to the onion skin 
preview.

Remove from Onion Skin: Removes a series of selected elements from the 
onion skin preview.

Remove Unselected from Onion Skin: Removes all elements except the 
ones selected from the onion skin preview.
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Add All to Onion Skin: Adds all of the scene's elements to the onion skin 
preview.

Remove All from Onion Skin: Removes all of the scene's elements from the 
onion skin preview. 

Onion Skinning by Drawing: 

No Previous Drawing: 

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.

Next Two Drawings: Displays the next two drawings.

Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous 
visible drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by 
one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table
Turns on the light table so you can see the previous and subsequent active 
layers in washed-out colours. It is useful for seeing the other layers when 
designing, animating or cleaning up your animation. 

Backlight

Produces a silhouette effect by changing the drawing’s coloured areas into a 
single dark, solid colour. Use this to verify the completeness of the ink and 
paint process. Any unpainted zones can be seen as the light shows through the 
unpainted areas of the silhouetted drawing.

Show

Symbol Pivot: Displays a symbol's pivot. The Symbol pivot is similar to the 
Drawing pivot. Each symbol cell can have its own pivot and act the same as 
the Drawing pivot. The Symbol pivot can also be referred to as embedded pivot. 
Inside a symbol, each drawing can have its own pivot. 

Safe Area: Displays the TV safety zone and the centre of the camera frame. 
The safe area adapts to the scene resolution, as well as the safety zone and 
frame’s centre.

Camera Mask: Displays a black mask around the scene’s frame to avoid see-
ing the unnecessary artwork. This option is handy when you're animating and 
setting up the scene. It allows you to see your scene’s composition better.

Control: Displays the controls of the selected element.

BBox Selection Style: Lets you change the display style of selected elements 
to a bounding box style. This removes the default overlay highlight and leaves 
only the bounding box around the selected element.
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Outline Locked Drawings: Drawings that are locked in the Timeline view 
(cannot be selected in the Camera view) are displayed as wireframes.

Show Current Drawing on Top: Displays the selected drawing on top of 
everything while you draw. By enabling this option, each time you select a 
drawing tool, the selected drawing is displayed in front of everything in the 
Camera view. The Timeline and Node view ordering remain unchanged.

Show Strokes: Displays the strokes in your drawings so that the invisible lines 
stand out.

Show Strokes with Colour Wash: Displays strokes with washed-out colours.

Highlight Selected Colour: 

Show Scan Information: Displays a status bar showing the scanning inform-
ation at the bottom of the Drawing and Camera view.

Hide All Controls Hides the controls of the selected element.

Render Current Frame Renders only the current frame.

Auto Render

Automatically recalculates the preview image whenever you modify a para-
meter. If your scene is heavy and you do not want the preview rendered auto-
matically, deselect the Auto-Render option and do the preview update 
manually.Note that this will slow down Harmony as it takes resources to 
update every frame.

Layer Properties
Displays the Layer Properties window of the selected layer in the Timeline 
view.

Preview Manager
Opens the Preview Manager where you can set options for the quality of pre-
views, and clearing and updating the cache.

Bitmap File Quality
Lets you change the quality of the preview of the bitmap file in the Camera 
view. It will not affect the final render.

Drawing

Clean Up

Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
number and size of dots removal from a selected drawing.

Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or filled 
zones. Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible 
strokes between the two closest points to close the colour zone. You do not 
need to trace directly over the gap. You can draw it a few millimeters away. The 
two closest points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if 
you work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a 
selection. It is recommended that you clean the Colour Art level as well. If you 
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have a stroke accumulation in the Colour Art, it can result in large output files, 
especially if you work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside 
all drawings selected with the Permanent Selection  option in the Select 
tool.

Paint

Unpaint Selection: Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings: Unpaints all art contained inside a 
selection on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If 
no selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a 
selection on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.

Repaint Selection on All Drawings: Repaints any art inside a selection on all 
the drawings contained within the same layer. 

Repaint Outside Selection: Repaints any art outside a selection. If no 
selection has been drawn using the Select tool, the entire drawing will be 
repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a 
selection on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil 
strokes into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into 
centreline pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges drawing objects and brush strokes into a single layer. If you 
draw new lines to fix a drawing or line with many brush strokes, it can be useful 
to flatten them all into a single shape. By default, lines are drawn one on top of 
each other. If you intend to repaint the lines or modify their shape, it will be 
easier if they are flattened. 

Smooth: Smooths selected drawing strokes and removes extra points.

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  
tool but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during vec-
torization.

Remove Extra Strokes: Removes strokes inside painted area. This option 
only works after the painted drawing is flattened.
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Optimize: Reduces the number of layers, such as overlapping brush strokes, 
in the selected drawing objects. Drawing objects will only be flattened and 
optimized if the selected objects do not change the appearance of the final 
image when they are merged. 

Crop Brush Textures: Crops an unnecessarily large texture bitmap that lies 
unseen beneath the vector contour of a textured line. This often occurs when 
you cut and paste textured lines from one drawing into another. If you cut a 
portion from a textured line and paste it into a different drawing, Harmony 
pastes the entire unseen texture bitmap from the source drawing into the new 
one, even if you only took a small portion of the source drawing. Using the Crop 
Brush Texture command will crop away extraneous texture that does not touch 
the vector area. If there are many textured lines in your scene, this will greatly 
reduce the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of 
the textures in a drawing. 

When you import and vectorize drawings using the grey or colour preset styles, 
you don't have control on the size of the bitmap texture. You can reduce that 
bitmap texture.

Arrange

Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).

Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).

Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty Drawing
Creates a drawing in the selected cell, replacing any drawing that may already 
be exposed in that cell and the following ones until it meets another drawing, 
key exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you modify an 
existing drawing but retain the original.

When duplicating a drawing, the selected cell is replaced with the new drawing. 
The exposure of the original drawing that was on the current cell is removed. 
The original drawing is not deleted from the project folder or other cells in which 
it is exposed.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art From 
Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 

149



Chapter 3: Menus     

on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Generate Auto-Matte

Automatically creates a matte from a selected drawing or all drawings on a 
layer. 

Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will 
be created.

Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you change the resolution of bitmap art for individual drawings. You can 
reduce the resolution of your bitmap file as well as increase it. Be careful 
because enlarging the bitmap resolution on an existing drawing will result in a 
loss of quality.Harmony will perform a pixel smoothing pass (resampling) and 
create additional pixels to avoid losing too much quality, but only to a certain 
extent.  

Previous Drawing
Once a cell is selected in the Timeline or Xsheet view, you can navigate 
between the drawings, frames, and layers

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour 
Protection feature so you can quickly correct wrongly inked or painted areas 
under protected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour 
swatch to avoid repainting or unpainting the zones linked to that swatch. If you 
using the Paint tool and this option is deselected, you will repaint or unpaint the 
protected colours on your drawings until you enable the option again.

Drawing Tools

Select Lets you select elements from the Camera and Drawing views.

Contour Editor Lets you add, remove or modify points on a vector line and control them.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust 
the stroke curve and position. 

Cutter Lets you cut a drawing area to move, copy, cut or delete it.

Smooth Editor Lets you optimize contours and reduce the number of points on a line.

Perspective Lets you deform a drawing selection and alter its perspective.

Envelope
Lets you deform and warp part of a drawing using a grid envelope and Bezier 
handles.

Reposition All 
Drawings

Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer.
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Drawing Pivot Lets you set pivots on a characters, drawings and symbols.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing the final images, such as character 
nodes, cut-out puppet and clean animation. Creates a central vector shape.

Text Lets you type text in your project using various fonts and text attributes.

Eraser A pressure-sensitive tool for precisely erasing parts of a drawing.

Dropper Lets you pick a colour directly from a drawing.

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Line

Lets you draw straight lines, rectangles, polylines and ellipses which you can 
then edit.

Rectangle

Ellipse

Polyline

Paint Lets you paint both empty and filled zones.

Ink
Lets you paint only the segment you clicked on between two intersections to be 
painted.

Repaint Brush

Close Gap
Lets you close small gaps in a drawing by creating small, invisible strokes 
between the two closest points.

Stroke Lets you draw stokes, connect line ends and flatten lines.

Edit Gradient/Texture
Lets you modify the position of a gradient or texture colour within a specific 
zone.

Hand Lets you pan the Drawing or Camera view.

Zoom Lets you zoom in and out of the Drawing or Camera view.

Rotate View
Lets you rotate the Drawing or Camera view just like with a real animation disc. 
Can also be used in Perspective view.

Animation

Insert Keyframe
Adds a keyframe on the selected cell in the Timeline view. If the Animate mode 
is enabled in the Camera view, a keyframe is automatically created on the 
current frame.

Insert Control Point

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic 
interpolation created between the selected point and the next one. The layer will 
maintain its position until the animation reaches the frame of the next point and 
will then jump to the new position. Deselect this option to generate interpolation 
and get the layer to progressively move to the next position.
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Flip

Set Ease for Multiple 
Parameters

Lets you set the ease in and ease out on multiple functions and keyframes. 
This opens the Set Ease For Multiple Parameters where you can modify the 
Bezier or Ease curve. You can apply easing parameters to a certain type of 
function only, such as rotation or scale.

Linear Motion

Lock in Time
Indicates if the point is locked to a specific frame (keyframe) or only locked to a 
specific position and the curve can flow through it freely as other points are 
being added, moved, or adjusted (control point).

No Z Dragging

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the previous or 

next drawing.Substitute Drawing 
Next

Select Previous 
Keyframe/Point

Select the previous or next keyframe/point.
Select Next 
Keyframe/Point

Lock

Reset

Returns the value of the selected element to the initial value of the active tool. 
For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values 
will be reset.

Reset All
Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the default position. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. This is 
useful when doing cut-out animation. Cut-out puppets often have a particular Z 
ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and skew 
as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Skew Slants the selected element.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 
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Spline Offset

Lets you reposition the visual trajectory without offsetting or modifying your 
animation. By default, the trajectory is located at 0,0,0 fields. If your elements 
were drawn in a different location than the centre of the drawing area, it will look 
like the trajectory is not aligned with your drawing. Also, if you have several 
elements attached to one trajectory, you might want your trajectory to be at a 
different location to represent the group's motion better.

Inverse Kinematic Tool
Lets you pull on a character's extremities, such as the hands and feet, and 
have the rest of the body follow. Can be used on any piece connected in a 
hierarchy. 

IK Constraints

Set IK Nail Blocks the X, Y and Z positions.

Set IK Hold Orientation Blocks the angle.

Set IK Hold X Blocks only the X position.

Set IK Hold Y Blocks only the Y position.

Set IK Min Angle Sets limitations on the angle parameter to prevent the puppet from bending too 
far.Set IK Max Angle

Remove All 
Constraints

Removes all nails except the minimum and maximum angles.

Morphing

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in 
other words, on Contour vectors. It allows you to control the line thickness and 
contour position. Also, if a contour is not animated correctly, you can use hints 
to correct the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from 
the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity rule. 
The Zone Hint is placed in the centre of the colour zone. Sometimes a colour 
zone is not associated with the corresponding one by default. For example, in a 
splash animation there are many water droplets that are the same colour. 
Harmony automatically morphs the droplet to the nearest one. This is not 
always the one you may have predicted. A Zone Hint will force a colour zone to 
morph with another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as central 
vector. It can be used on drawings that were done using the Pencil, Polyline, 
Ellipse, Line and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps 
to the central vector. Make sure to place it far enough away from the line so you 
will see it snap when you move it.

Pencil Hint points are magenta in colour.
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Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing 
shape. A shape will vanish from the source drawing when there is no 
corresponding shape in the destination drawing. If you do not place a Vanishing 
Point Hint to control the point of disappearance, the shape will vanish into its 
centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing 
shape. A shape will appear in the destination drawing when there is no 
corresponding shape in the source drawing. If you do not place an Appearing 
Point Hint to control the point of appearance, the shape will appear from its 
centre and expand outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles between the two key drawings in your morphing sequence. This option 
is useful while setting hints. You can use the default keyboard shortcut F4 to 
toggle between your drawings.

Suggest HInts
Automatically sets hint points on key drawings as a help tool. If you're not sure 
where to set hints, you can use this option. It will set the main hints which you 
can then fine tune.

Hide Hints
Temporarily hides the hint points from the key drawings. Use this option when 
you have a series of hint points hiding some lines you would like to see.

Colour Menu

The Colour  menu lets you access commands related to the Colour view such as creating new palettes, adding 
new colour swatches, and displaying the Tint panel.

How to access the Colour menu

‣ In the upper-left corner of the Colour view, click the menu button.

Command Description

Palettes

New

Creates a new colour palette.

By default, Toon Boom Harmony is set to the Basic mode. For simple 
productions, it is recommended to use the Basic mode.  This setting stores the 
palettes automatically for you and saves them at the Scene level. When you 
use the Advanced Palette Lists mode, you can decide at which level you want 
to store your palettes: Environment, Job, Scene, or Element.

Link
Lets you access other palettes created in the project and link them to your 
scene—see Importing and Linking Palettes on page 1.

Link to External
Lets you you link an external palette to your scene without copying it in your 
project.

Import Imports a colour palette located on your hard drive.

Remove Deletes the selected colour palette.

154



Harmony 12.2 Premium - Paperless Animation Guide (Server)

Rename Lets you five the selected colour palette a new name.

Duplicate

Creates a copy of the original palette, using the same names and colour 
values, but has a different ID and is independent from the original palette. This 
ensures that both the duplicate and original palettes are completely 
independent.

Clone
Creates a copy of the master palette. The colours in each palette have the 
same properties. The colours have the same identification number pointing to 
the same colour zones, but they can have different names and RGBA values.

Pencil Texture Palette

Move Up Moves the selected colour palette up one level.

Move Down Moves the selected colour palette down one level.

Colour Editor Opens the Colour Editor where you can 

Tint Panel
Opens the Tint panel where you can modify a series of colours to blend a tint in 
them or offset their RGBA values. 

Current Palette 
Overrides

Display Colour Values Display the colour values beside their colour swatches in the palette list.

Colours

Cut Cuts the selected colour swatch from the palette.

Copy Copies the selected colour swatch which you can paste in a different palette.

Copy Colour ID
Copies a colour swatch's colour ID so you can keep a reference file of colour 
IDs or use them with custom plug-ins. Example of a colour ID: 
075cf5b552401130.

Paste Colour Values Pastes the colour value of the copied swatch over an existing colour swatch.

Paste As New Colours Creates a new colour swatch from the colour value of the copied swatch.

Paste As Clones

New Creates a new colour swatch from the colour swatch that was last selected.

Edit
Opens the Colour Picker window in which you can edit the selected colour 
swatch.

Delete Deletes the selected colour swatch from the palette.

New Texture
Lets you add a bitmap colour swatch to your palette. You can load photos and 
textures and paint your drawings with it. The bitmap image must be a .tga or 
.psd file format.

Edit Texture

Scale Down Texture Lets you set a new maximum texture size or scaling factor.

New Default Colour

Protect Colour
Locks a selected colour, so if you ever paint over it accidentally, the work 
already done will not be affected. You can also block the filling colours if you 
painted all of the animation in Line Art and plan to repaint the lines.

Swatch Mode
Displays the colour swatches with its corresponding name inside the swatch. 
When this option is not selected, the names of the colour swatches are 
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displayed beside the swatch.

Independent Bitmap 
Colour

Bitmap Colour Sliders

RGB

HSV

Drawing Menu

The Drawing menu lets you access tools, set morphing  parameters, lock or unlock layers, and select elements in 
the Drawing view.

How to access the Drawing menu

‣ In the upper-left corner of the Drawing view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Stroke With 
Current Colour

Select the strokes that contain the currently selected colour.

Invert Selection

Deselects the currently selected items and selected all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that were 
not selected.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation table.

Rotate View CCW
Rotates the Camera view 30 degrees counter-clockwise, like an animation 
table.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.
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Reset View Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line Art and 
Colour Art

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.

Overlay: Displays the grid over the drawing elements.

Square Grid: Displays a standard square grid.

12 Field Grid: Displays a 12-field size grid.

16 Field Grid: Displays a 16-field size grid.

Onion Skin

Show Onion Skin: Lets you preview the previous and next drawings. By 
default, the previous drawings appear in a shade of red and the next drawings 
are displayed with a shade of green. You can change these colours in the 
Preferences dialog box. 

Show Centre Line: 

No Previous Drawing: 

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.

Next Two Drawings: Displays the next two drawings.

Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous 
visible drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by 
one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table
Turns on the light table so you can see the previous and subsequent active 
layers in washed-out colours. It is useful for seeing the other layers when 
designing, animating or cleaning up your animation. 

Backlight

Produces a silhouette effect by changing the drawing’s coloured areas into a 
single dark, solid colour. Use this to verify the completeness of the ink and 
paint process. Any unpainted zones can be seen as the light shows through the 
unpainted areas of the silhouetted drawing.
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Show

Show Strokes Displays the strokes in your drawings so that the invisible lines stand out.

Show Strokes with 
Colour Wash

Displays strokes with washed-out colours.

Highlight Selected 
Colour

Identify a selected colour swatch used in a drawing.

Show Morphing Key 
Drawing Thumbnail

Show Scan Information
Displays a status bar showing the scanning information at the bottom of the 
Drawing and Camera view.

Desk

No Thumbnail

Changes the size of the drawing desk thumbnails.
Small Thumbnail

Medium Thumbnail

Large Thumbnail

Remove Selected 
Drawing

Clears selected drawing from drawing desk.

Remove All Drawings Clears all drawing from drawing desk.

Drawing

Clean Up

Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
number and size of dots removal from a selected drawing.

Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or filled 
zones. Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible 
strokes between the two closest points to close the colour zone. You do not 
need to trace directly over the gap. You can draw it a few millimeters away. The 
two closest points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if 
you work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a 
selection. It is recommended that you clean the Colour Art level as well. If you 
have a stroke accumulation in the Colour Art, it can result in large output files, 
especially if you work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside 
all drawings selected with the Permanent Selection  option in the Select 
tool.

Paint Unpaint Selection: Unpaints any art existing inside a selection. 
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Unpaint Selection on All Drawings: Unpaints all art contained inside a 
selection on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If 
no selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a 
selection on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.

Repaint Selection on All Drawings: Repaints any art inside a selection on all 
the drawings contained within the same layer. 

Repaint Outside Selection: Repaints any art outside a selection. If no 
selection has been drawn using the Select tool, the entire drawing will be 
repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a 
selection on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil 
strokes into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into 
centreline pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges drawing objects and brush strokes into a single layer. If you 
draw new lines to fix a drawing or line with many brush strokes, it can be useful 
to flatten them all into a single shape. By default, lines are drawn one on top of 
each other. If you intend to repaint the lines or modify their shape, it will be 
easier if they are flattened. 

Smooth: Smooths selected drawing strokes and removes extra points.

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  
tool but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during vec-
torization.

Remove Extra Strokes: Removes strokes inside painted area. This option 
only works after the painted drawing is flattened.

Optimize: Reduces the number of layers, such as overlapping brush strokes, 
in the selected drawing objects. Drawing objects will only be flattened and 
optimized if the selected objects do not change the appearance of the final 
image when they are merged. 

Crop Brush Textures: Crops an unnecessarily large texture bitmap that lies 
unseen beneath the vector contour of a textured line. This often occurs when 
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you cut and paste textured lines from one drawing into another. If you cut a 
portion from a textured line and paste it into a different drawing, Harmony 
pastes the entire unseen texture bitmap from the source drawing into the new 
one, even if you only took a small portion of the source drawing. Using the Crop 
Brush Texture command will crop away extraneous texture that does not touch 
the vector area. If there are many textured lines in your scene, this will greatly 
reduce the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of 
the textures in a drawing. 

When you import and vectorize drawings using the grey or colour preset styles, 
you don't have control on the size of the bitmap texture. You can reduce that 
bitmap texture.

Arrange

Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).

Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).

Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty Drawing
Creates a drawing in the selected cell, replacing any drawing that may already 
be exposed in that cell and the following ones until it meets another drawing, 
key exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you modify an 
existing drawing but retain the original.

When duplicating a drawing, the selected cell is replaced with the new drawing. 
The exposure of the original drawing that was on the current cell is removed. 
The original drawing is not deleted from the project folder or other cells in which 
it is exposed.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art From 
Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 
on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Generate Auto-Matte
Automatically creates a matte from a selected drawing or all drawings on a 
layer. 
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Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will 
be created.

Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you change the resolution of bitmap art for individual drawings. You can 
reduce the resolution of your bitmap file as well as increase it. Be careful 
because enlarging the bitmap resolution on an existing drawing will result in a 
loss of quality.Harmony will perform a pixel smoothing pass (resampling) and 
create additional pixels to avoid losing too much quality, but only to a certain 
extent.  

Previous Drawing
Once a cell is selected in the Timeline or Xsheet view, you can navigate 
between the drawings, frames, and layers

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour 
Protection feature so you can quickly correct wrongly inked or painted areas 
under protected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour 
swatch to avoid repainting or unpainting the zones linked to that swatch. If you 
using the Paint tool and this option is deselected, you will repaint or unpaint the 
protected colours on your drawings until you enable the option again.

Drawing Tools

Select Lets you select elements from the Camera and Drawing views.

Contour Editor Lets you add, remove or modify points on a vector line and control them.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust 
the stroke curve and position. 

Cutter Lets you cut a drawing area to move, copy, cut or delete it.

Smooth Editor Lets you optimize contours and reduce the number of points on a line.

Perspective Lets you deform a drawing selection and alter its perspective.

Envelope
Lets you deform and warp part of a drawing using a grid envelope and Bezier 
handles.

Reposition All 
Drawings

Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer.

Drawing Pivot Lets you set pivots on a characters, drawings and symbols.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing the final images, such as character 
nodes, cut-out puppet and clean animation. Creates a central vector shape.

Text Lets you type text in your project using various fonts and text attributes.
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Eraser A pressure-sensitive tool for precisely erasing parts of a drawing.

Dropper Lets you pick a colour directly from a drawing.

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Line

Lets you draw straight lines, rectangles, polylines and ellipses which you can 
then edit.

Rectangle

Ellipse

Polyline

Paint Lets you paint both empty and filled zones.

Ink
Lets you paint only the segment you clicked on between two intersections to be 
painted.

Repaint Brush

Close Gap
Lets you close small gaps in a drawing by creating small, invisible strokes 
between the two closest points.

Stroke Lets you draw stokes, connect line ends and flatten lines.

Edit Gradient/Texture
Lets you modify the position of a gradient or texture colour within a specific 
zone.

Hand Lets you pan the Drawing or Camera view.

Zoom Lets you zoom in and out of the Drawing or Camera view.

Rotate View
Lets you rotate the Drawing or Camera view just like with a real animation disc. 
Can also be used in Perspective view.

Morphing

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in 
other words, on Contour vectors. It allows you to control the line thickness and 
contour position. Also, if a contour is not animated correctly, you can use hints 
to correct the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from 
the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity rule. 
The Zone Hint is placed in the centre of the colour zone. Sometimes a colour 
zone is not associated with the corresponding one by default. For example, in a 
splash animation there are many water droplets that are the same colour. 
Harmony automatically morphs the droplet to the nearest one. This is not 
always the one you may have predicted. A Zone Hint will force a colour zone to 
morph with another one.

Zone Hint points are cyan in colour.

Pencil Hint
A Pencil Hint  point is used to control a pencil line, also known as central 
vector. It can be used on drawings that were done using the Pencil, Polyline, 
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Ellipse, Line and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps 
to the central vector. Make sure to place it far enough away from the line so you 
will see it snap when you move it.

Pencil Hint points are magenta in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing 
shape. A shape will vanish from the source drawing when there is no 
corresponding shape in the destination drawing. If you do not place a Vanishing 
Point Hint to control the point of disappearance, the shape will vanish into its 
centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing 
shape. A shape will appear in the destination drawing when there is no 
corresponding shape in the source drawing. If you do not place an Appearing 
Point Hint to control the point of appearance, the shape will appear from its 
centre and expand outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles between the two key drawings in your morphing sequence. This option 
is useful while setting hints. You can use the default keyboard shortcut F4 to 
toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous Frame Goes to the previous frame of the selected frame in the morphing sequence.

Go to Next Frame

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest HInts
Automatically sets hint points on key drawings as a help tool. If you're not sure 
where to set hints, you can use this option. It will set the main hints which you 
can then fine tune.

Hide Hints
Temporarily hides the hint points from the key drawings. Use this option when 
you have a series of hint points hiding some lines you would like to see.

Function Menu

The Functions menu lets you do many things in the Camera view, including selecting and editing objects in different 
views, changing the display, setting morphing parameters, accessing tools and many more.

How to access the Function menu

‣ In the upper-left corner of the Function view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.
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Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select Next Keyframe Selects the next keyframe.

Select Previous 
Keyframe

Selects the previous keyframe.

Select Left Handle Selects the left handle of the selected keyframe.

Select Right Handle Selects the right handle of the selected keyframe.

Select All
Selects all objects in the Function view. This helps you manage multiple objects 
as one.

Deselect All Deselects all selected objects in the Function view.

View

Show Current Frame Displays the current frame 

Toggle Grid Enables the display of the grid.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Function List

Auto Load Selection

Clear

Load Selection

Add Selection

Remove Selection

Show

Show Motion: 

Show Rotation: 

Show Scale: 

Show Skew: 

Show Other: 

Library Menu

The Library menu lets you access commands specific to the Library view, such as opening a Library or getting the 
rights to modify a library folder.

How to access the Library menu

‣ In the upper-left corner of the Library view, click the menu button.

Command Description

View

List Displays the contents of the selected folder as a list.
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Thumbnails Displays the contents of the selected folder as a thumbnails.

Details Displays the details of the selected file.

Generate Thumbnails Creates a thumbnail to display in the preview window.

Edit

New Symbol

Creates a new symbol from a drawing or part of a drawing in the 
Drawing or Camera view, a layer in the Timeline view, or a node in the Node 
view. 

If your selection is in the Timeline  or Node view, the new symbol appears in 
the  Symbol folder. The current selection is not replaced by the new symbol. 
The new symbol only appears in the library. You must drag it into your scene to 
use it.

If your selection is in the Drawing or Camera view, the new symbol appears in 
the Symbol folder and in the Timeline view as a new layer.

Cut Cuts the selected file in the Library view.

Copy Copies the selected file in the Library view.

Paste Pastes the selected file in the Library view.

Delete Deletes the selected file in the Library view.

Delete Thumbnails Deletes any thumbnails that were generated for display in the preview window.

Edit Symbol

Places you inside the symbol where you can edit it. 

To return to the project's timeline, click the Top  button in the Camera 
view's top-left corner, press  Ctrl + Shift + E (Windows/Linux) or ⌘  + Shift + E 
(Mac OS X). 

Remove Unused Files Removes any files not in use in the 

Rename Template Lets you rename a selected template.

Import Files Opens the 

Folders

New Folder
Creates a new folder in the Library view. Before you can create a new folder, 
you must have the right to modify the folder in which you are creating the new 
folder.

Refresh Updates the view and its contents.

Open Library Lets you open a library on your computer.

Close Library

Model Menu

The Model menu lets you load models and view them in different ways, as well as access some drawing tools.

How to access the Model menu

‣ In the upper-left corner of the Model view, click the menu button.
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Command Description

Previous Model  

Next Model  

Import Model  

Use Current Drawing as Model  

Load Default Models  

Clear Model  

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation table.

Rotate View CCW
Rotates the Camera view 30 degrees counter-clockwise, like an animation 
table.

Reset Rotation Resets the view’s rotation to its default position.

Select Activates the Select tool. This tools is also available on the Tools toolbar.

Cutter Selection @@need help

Dropper Activates the Dropper tool. This tools is also available on the Tools toolbar.

Zoom Activates the Zoom tool. This tools is also available on the Tools toolbar.

Node Menu

The Node menu lets you organize the nodes according to how you like to work and the nodes you use most often. 
You can easily add categories and subcategories, remove categories you don't use, and rename categories.

How to access the Node menu

‣ In the upper-left corner of the Node view, click the menu button.

Command Description

File

Print
Lets you print the contents of the Node view. You must be connected to a 
printer.

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

166



Harmony 12.2 Premium - Paperless Animation Guide (Server)

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selected all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Layer Properties Shows or hides the Layer Properties view.

Recalculate Selected
Refreshes the node structure and rerenders the display of selected elements 
when the Camera View is in render mode.

Recalculate All
Refreshes the node structure and rerenders the display when the Camera view 
is in render mode.

Tag

You can tag elements in the Timeline or Node views to view only those 
elements. When you tag elements, an asterisk appears beside the item in the 
Timeline view. Once your elements are tagged and you have switched over to 
View Tagged Layers mode, the Timeline view will display only tagged 
elements. The red bar on the left of the layers indicates you are in this view 
mode. See Timeline View Modes on page 1.

Timeline Tag: Tags selected elements in the Timeline or Node views.

Timeline Untag: Untags selected layer in the Timeline view.

Timeline Untag All: Untags all tagged elements.

Timeline Untag All Others: Untags all elements except the selected one.

Auto Render Write
Renders a frame each time the current frame is changed. 

You must have a Write node in your node structure to use this command.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Group Content Select contents within the group node.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View
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Zoom In Node View Zooms in the view.

Zoom Out Node View Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Centre on Selection
Centre the display of the Node view on the selected node. This is useful when 
you have many nodes in the Node view, you may find it hard to locate which 
one is selected. 

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Show All Nodes Display all nodes.

Editor Display the Layer Properties editor of the selected node.

Publish Attribute Node

To quickly access parameters for nodes that are grouped, you can select your 
most common parameters to modify and make them appear in the group Layer 
Properties editor. This way, you can access them directly without having to 
enter the group every time.

Show Selected 
Thumbnails

Displays the thumbnails of selected nodes.

Hide All Thumbnails Hides all the thumbnails of selected nodes.

Navigator

 

Hide Navigator: Hides the navigator.

Top Right: Places the navigator in the top-right corner of the Node view.

Top Left: Places the navigator in the top-left corner of the Node view.

Bottom Right: Places the navigator in the bottom-right corner of the Node 
view.

Bottom Left: Places the navigator in the top-left corner of the Node view.

Cable Style
Line: Use straight lines to show the connections between nodes.

Bezier: Use curved (Bezier) lines to show the connections between nodes.

Nodes

Enable Activate the selected node.

Disable Deactivate the selected node.

Enable All Activate all nodes.

Disable All Others
Deactivates all nodes except for those those selected. This operation only 
affects the current level layers. It does not affect the nested nodes within a 
group. Deactivated nodes appear in red.

Clone Selected Nodes: 
Drawings and Timing

Creates a copy of the selected element that is linked to the original. If a 
drawing is modified in the original or cloned layer, both will be updated. 
However, cloned layers can have different timings.

When you clone a node, it does not automatically connect itself to the 
Composite node of your scene.

You can clone the drawings only or both the drawings and timing—see Cloning 
and Duplicating Layers  on page 1.

Clone Selected Nodes: 
Drawings Only

Duplicate Selected Creates an independent copy of the selected element.  This useful when you 
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Nodes
need to modify the element independently, including the timing (exposure). 
Changes to the original element do not propagate to the duplicate.

Group Selection
Creates a simple group from your selection. The resulting group displays the 
same number of connections as elements in the group.

Group Selection with 
Composite

Group a selection.

Ungroup Ungroups the selected group of nodes.

Move to Parent Group Moves selected nodes up to the parent group level.

Exit Group Exits the group.

Clear Published 
Attributes

Removes the most common parameters you selected for quick access in the 
Layer Properties editor of a group.

Insert

Composite Adds a Composite node to the Node view.

Display Adds a Display node to the Node view.

Drawing
Opens the Add Drawing Layer dialog box where you can specify the type of 
layer to add.

Group Adds a Group node to the Node view.

Parent Peg Adds a new peg to the timeline as a parent of the selected layer.

Peg Adds a Peg node to the Node view.

Effects
Lets you add effects from these categories: 3D, Combine, Deformation, 
Favourites, Filter, Generator, Group, Misc, Move, Output, Particle, Sapphire, 
Shading and Plugins.

Backdrop
Adds a backdrop to the Node view. Backdrops are a way to work with complex 
node systems that let you associate a selected set of nodes by colour. See 
Working with Backdrops on page 1.

Node Library Menu

The Node Library menu lets you organize the nodes according to how you like to work and the nodes you use most 
often. You can easily add categories and subcategories, remove categories you don't use, and rename categories.

How to access the Node Library menu

‣ In the upper-left corner of the Node Library view, click the menu button.

Command Description

New Category
Adds a new category to the list of categories to which you can organize nodes 
according to how you like to work and the nodes you use most often.

Rename Category Renames an existing category.

Remove Category Remove a category you no longer need.

Remove Node Removes a node from a category.

Refresh Updates the view and its contents.
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Perspective Menu

The Perspective menu lets you select and edit elements, manipulate the view during scene setup, set parameters 
for animation and access animation tools.

How to access the Perspective menu

‣ In the upper-left corner of the Perspective view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selected all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Move Forward

Move Backward

Reset Zoom Resets the view’s zoom to its default position.
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Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Look At Selected

Layer Properties Shows or hides the Layer Properties view.

Light Table
Turns on the light table so you can see the previous and subsequent active 
layers in washed-out colours. It is useful for seeing the other layers when 
designing, animating or cleaning up your animation. 

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Top, Side or Perspective views.

Animation

Animate

Enables the Animate mode which lets you keyframe drawing layers to create 
computer-generated animation. When working in the Animate mode, you can 
animate a layer's position and then turn off the mode to reposition a layer for 
the entire scene. When the Animate mode is disabled, keyframes are created 
on selected layers at the current frame. Depending on what transformations 
were performed (rotation, translation, skew), the new keyframes are added on 
the corresponding parameters (function curves).

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic 
interpolation created between the selected point and the next one. The layer 
will maintain its position until the animation reaches the frame of the next point 
and will then jump to the new position. Deselect this option to generate 
interpolation and get the layer to progressively move to the next position.

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-axis of 
the layer and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change 
the velocity of selection functions.

Linear Motion

Lock in Time
Indicates if the point is locked to a specific frame (keyframe) or only locked to a 
specific position and the curve can flow through it freely as other points are 
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being added, moved, or adjusted (control point).

No Z Dragging

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the previous or 

next drawing.Substitute Drawing 
Next

Select Previous 
Keyframe /Point

Select the previous or next keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks one or a multiple selection of layers. 

Unlock: Unlocks one or a multiple selection of locked layers.

Lock All: Locks all the layers in the Timeline view. 

Unlock All: Unlocks all the layers in the Timeline view. 

Lock All Others: Locks every layer except the selected ones.

Reset

Returns the value of the selected element to the initial value of the active tool. 
For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values 
will be reset.

Reset All
Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the default position. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. This is 
useful when doing cut-out animation. Cut-out puppets often have a particular Z 
ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and 
skew as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an 
object up to make it larger or down to make it smaller. Press Shift to scale the 
element while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Skew Slants the selected element.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset
Lets you reposition the visual trajectory without offsetting or modifying your 
animation. By default, the trajectory is located at 0,0,0 fields. If your elements 
were drawn in a different location than the centre of the drawing area, it will 
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look like the trajectory is not aligned with your drawing. Also, if you have sev-
eral elements attached to one trajectory, you might want your trajectory to be 
at a different location to represent the group's motion better.

Side Menu

The Side menu lets you position elements in 3D space, set parameters for animation and access animation tools—
see Side View on page 1.

How to access the Side menu

‣ In the upper-left corner of the Side view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selected all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.
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Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Top, Side or Perspective views.

Animation

Animate

Enables the Animate mode which lets you keyframe drawing layers to create 
computer-generated animation. When working in the Animate mode, you can 
animate a layer's position and then turn off the mode to reposition a layer for the 
entire scene. When the Animate mode is disabled, keyframes are created on 
selected layers at the current frame. Depending on what transformations were 
performed (rotation, translation, skew), the new keyframes are added on the 
corresponding parameters (function curves).

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic interpolation 
created between the selected point and the next one. The layer will maintain its 
position until the animation reaches the frame of the next point and will then jump 
to the new position. Deselect this option to generate interpolation and get the 
layer to progressively move to the next position.

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on your 
drawing layer following its original axis.Remembers the original X-axis of the layer 
and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change the 
velocity of selection functions.

Linear Motion

Lock in Time
Indicates if the point is locked to a specific frame (keyframe) or only locked to a 
specific position and the curve can flow through it freely as other points are being 
added, moved, or adjusted (control point).

No Z Dragging

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the previous or 
next drawing.
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Substitute Drawing 
Next

Select Previous 
Keyframe /Point

Select the previous or next keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks one or a multiple selection of layers. 

Unlock: Unlocks one or a multiple selection of locked layers.

Lock All: Locks all the layers in the Timeline view. 

Unlock All: Unlocks all the layers in the Timeline view. 

Lock All Others: Locks every layer except the selected ones.

Reset

Returns the value of the selected element to the initial value of the active tool. For 
example, if the Rotate  tool is active, the transformation angle will be reset to 
0 and if the Transform  tool is active, all the transformation values will be 
reset.

Reset All
Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the default position. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. This is 
useful when doing cut-out animation. Cut-out puppets often have a particular Z 
ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and skew 
as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset

Lets you reposition the visual trajectory without offsetting or modifying your anim-
ation. By default, the trajectory is located at 0,0,0 fields. If your elements were 
drawn in a different location than the centre of the drawing area, it will look like the 
trajectory is not aligned with your drawing. Also, if you have several elements 
attached to one trajectory, you might want your trajectory to be at a different loc-
ation to represent the group's motion better.

Timeline Menu

The Timeline menu lets you...
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select and edit elements, manipulate the view during scene setup, set parameters for animation and access 
animation tools.

How to access the Timeline menu

‣ In the upper-left corner of the Timeline view, click the menu button.

Parameter Description

Import

From Scanner Imports drawings from a TWAIN scanner.

Images
Imports bitmap images which you can choose to vectorize—see Importing 
Bitmap Images  on page 1.

Sounds Lets you import sound files into your project.

Edit

Cut cells from Xsheet
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy cells from Xsheet Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse 
and Reverse-Forward.

Paste Reverse
Reverses the timing of drawings or keyframes in range of selection after 
copying.

Delete Removes selected objects.

Modify Paste Presets

Lets you modify existing presets when pasting keyframes and exposures. 
There are three presets you can modify: the default presets for both key frames 
and exposures, key frames only and exposures only. See Modifying Paste 
Presets on page 1.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selected all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children Lets you select all elements parented to the selected peg element in the 
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Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Lock

Lock: Locks one or a multiple selection of layers. 

Unlock: Unlocks one or a multiple selection of locked layers.

Lock All: Locks all the layers in the Timeline view. 

Unlock All: Unlocks all the layers in the Timeline view. 

Lock All Others: Locks every layer except the selected ones.

Tag

Timeline Tag: You can tag elements in the Timeline or Node views to view 
only those elements. When you tag elements, an asterisk appears beside the 
item in the Timeline view. Once your elements are tagged and you have 
switched over to View Tagged Layers mode, the Timeline view will display 
only tagged elements. The red bar on the left of the layers indicates you are in 
this view mode. See Timeline View Modes on page 1.

Timeline Untag: Untags selected layer in the Timeline view.

Timeline Untag All: Untags all tagged elements.

Timeline Untag All Others: Untags all elements except the selected one.

Scene Markers

Mark Current Frame: Places a scene marker on the current frame on which 
the playhead is parked. The marker appears in the frame counter area of the 
Timeline view. You can customize the colour of the scene marker and add text 
to display as a tooltip when you hover over the marker—see Setting Scene 
Markers on page 1.

Create Scene Marker: Creates a scene marker from a selected frame range 
in the frame counter area of the Timeline view.

Edit Scene Marker: Lets you edit an existing scene marker. 

NOTE: It's important to select the entire length of the scene marker, otherwise 
the Timeline Scene Marker dialog box will not open for editing.

Delete Scene Marker: Removes an existing scene marker.

Share Functions

Lets you share an existing function curve. By default, all function curves can 
only be used and modified using their original parameter. If you want another 
layer or parameter to use the same function curve, you must share it. See 
Function Curves on page 1.

View

Cycle to Next View 
Mode

Displays the new view mode.

Normal View Mode
Displays the Normal view mode, the default in the Timeline view. It shows 
everything connected to the chosen display. In this mode, anything not 
connected to the currently set default display will not be shown in the Timeline 
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view. This also means that you cannot add certain elements to the Timeline 
view, as by default, when added they are not connected to any display or 
composite node. An example of such an element is a peg.

Selection Only Mode
Displays only elements currently selected in the Camera or Node view. This 
makes it easier to concentrate on one or a few elements at a time.

View Tagged Layers

Lets you see only elements which have been assigned a Tagged status. An 
item that has been tagged will appear in the Timeline view with a small asterisk 
beside its name. 

Once your elements are tagged and you have switched over to View Tagged 
Layers mode, the Timeline view will display only tagged elements. The red bar 
on the left of the layers indicates you are in this view mode. While in this mode, 
the asterisks are not displayed beside the tagged elements.

Show Functions  

Centre on Selection
Centers the Timeline view on the selected layer. This useful when you have 
several layers in the Timeline view, you may find it hard to locate which one is 
selected. 

Show

Show Manager: 

Show Sounds: 

Show Effects:

Show Groups: 

Show Composites: 

Show Sound Waveform: 

Change Track Colour  

Default Track Colour  

Collapse/Expand  

Collapse All  

Expand All  

Set Tempo Marker

Lets you set a marker that synchronizes your animation with a musical score. 
This lets you reproduce the FPB (Frames Per Beat) and use the tempo 
signature as tempo markers. The Xsheet view lets you pace your animation 
according to the tempo or beat of the soundtrack music or to any rhythmic 
sound, such as the ticking of a clock or water leaking from a spout. See Setting 
Tempo Markers on page 1.

Top Menu

The Top menu lets you position elements in 3D space, set parameters for animation and access animation tools—
see Top View on page 1.

How to access the Top menu

‣ In the upper-left corner of the Top view, click the menu button.

178



Harmony 12.2 Premium - Paperless Animation Guide (Server)

Command Description

Edit  

Cut Drawing Object
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Drawing Object Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Drawing Object Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selected all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Top, Side or Perspective views.

Animation

Animate

Enables the Animate mode which lets you keyframe drawing layers to create 
computer-generated animation. When working in the Animate mode, you can 
animate a layer's position and then turn off the mode to reposition a layer for the 
entire scene. When the Animate mode is disabled, keyframes are created on 
selected layers at the current frame. Depending on what transformations were 
performed (rotation, translation, skew), the new keyframes are added on the 
corresponding parameters (function curves).
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Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic interpolation 
created between the selected point and the next one. The layer will maintain its 
position until the animation reaches the frame of the next point and will then jump 
to the new position. Deselect this option to generate interpolation and get the 
layer to progressively move to the next position.

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on your 
drawing layer following its original axis.Remembers the original X-axis of the layer 
and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change the 
velocity of selection functions.

Linear Motion

Lock in Time
Indicates if the point is locked to a specific frame (keyframe) or only locked to a 
specific position and the curve can flow through it freely as other points are being 
added, moved, or adjusted (control point).

No Z Dragging

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the previous or 

next drawing.Substitute Drawing 
Next

Select Previous 
Keyframe /Point

Select the previous or next keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks one or a multiple selection of layers. 

Unlock: Unlocks one or a multiple selection of locked layers.

Lock All: Locks all the layers in the Timeline view. 

Unlock All: Unlocks all the layers in the Timeline view. 

Lock All Others: Locks every layer except the selected ones.

Reset
Returns the value of the selected element to the initial value of the active tool. For 
example, if the Rotate  tool is active, the transformation angle will be reset to 
0 and if the Transform  tool is active, all the transformation values will be 
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reset.

Reset All
Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the default position. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. This is 
useful when doing cut-out animation. Cut-out puppets often have a particular Z 
ordering for the different views of a character. You might want to reset the 
transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and skew 
as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Spline Offset

Lets you reposition the visual trajectory without offsetting or modifying your anim-
ation. By default, the trajectory is located at 0,0,0 fields. If your elements were 
drawn in a different location than the centre of the drawing area, it will look like the 
trajectory is not aligned with your drawing. Also, if you have several elements 
attached to one trajectory, you might want your trajectory to be at a different loc-
ation to represent the group's motion better.

Xsheet Menu

The Xsheet menu lets you 

—see Timing on page 1 on page 1.

How to access the Xsheet menu

‣ In the upper-left corner of the Xsheet view, click the menu button.

Parameter Description

File

Import

Images: Imports bitmap images which you can choose to vectorize—see 
Importing Bitmap Images  on page 1.

From Scanner: Imports drawings from a TWAIN scanner.

Sounds: Lets you import sound files into your project.

Print
Prints the exposure sheet so you can take it to your animation table,  provide a 
copy to the animator, or create your Xsheet skeleton directly in Harmony.

Edit

Cut cells from Xsheet Removes selected objects. You can then paste the object or its properties to 
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another object.

Copy cells from Xsheet Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse 
and Reverse-Forward.

Paste Reverse Reverses the timing of drawings or keyframes in range of selection after copying.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Insert Mode

Adds a new value or a new value sequence over existing ones, the new values 
are inserted between the old ones. The existing timing sequence is pushed down 
the column. The Insert mode opposite of the Overwrite mode, which is the Xsheet 
default mode.

Gestural Drag Mode
Lets you drag a cell to any other frame in the same column or into another column.

This feature does not apply to Annotation columns.

Send to Function View
Sends selected objects to the Function view where you can edit and adjust its 
function curve and parameters.

View

Zoom In Xsheet Zooms in the view.

Zoom Out Xsheet Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Set Tempo Marker  

Expand/Collapse

Collapse Selection: 

Expand Selection: 

Collapse All: 

Expand All: 

Column Properties

Lets you rename a column, and enable or disable a column. To view additional 
properties, select Edit > Preferences from the top menu. In the Preferences 
dialog box, select the Advanced tab, then select the Advanced Element Mode 
option.

Show Column List  

Column Types Manager Lets you add advanced column types to create particular animation paths. When 
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you create these columns, they are not linked automatically to any particular 
drawing layer. You can create a motion path using these columns and then link or 
unlink several drawing or peg layers to it. 

Show Thumbnails
Displays column thumbnails making it easier to identify a particular column. This 
option displays a small thumbnail picture of the current frame below the column 
header.

Show Selection  

Set Columns Width Lets you change the column width (in pixels) and set it as the default.

All Columns to Default 
Width

Returns all columns to their default width of 100 pixels.

Change Columns 
Colour

Lets you customize the colour of the column by selecting one from the Select 
Colour dialog box. The colour you select is also reflected in the correspondng 
layer in the Timeline view.

Default Column Colour Removes the colour you assigned to a column (if any).

Hide Selected Columns Hides selected columns.

Unhide All Columns Displays all columns.

Show Hidden Columns Displays columns that were previously hidden.

Empty Cells  

Row Units  

Held Exposures  

Preview Selected 
Drawings

 

Enable Playback Plays back your animation in the Top, Side or Perspective views.

Columns

Add Columns
Lets you add a column. You can specify the column name, type, and set drawing 
layer options in the Add Column dialog box that opens.

Delete Columns
Removes the selected column. You have the option to delete the associated 
drawing files and element folders.

Clone Selected 
Columns: Drawings 
Only

Creates a copy of the selected column that is linked to the original. If a drawing is 
modified in the original or cloned column, both will be updated. However, cloned 
columns can have different timings. 

You can clone the drawings only or both the drawings and timing—see Cloning 
Layers and Columns on page 1.

Clone Selected 
Columns: Drawings 
and Timing

Duplicate Selected 
Columns

Creates an independent copy of the selected column.  This useful when you need 
to modify the element independently, including the timing (exposure). Changes to 
the original element do not propagate to the duplicate.

Merge Selected 
Columns

There are two methods of merging drawings. 

• You can merge selected drawings in adjacent elements. The columns and 
layers will be left intact, and each new merged drawing will reside in the 
frames of the left-most column or lower layer.

• You can merge elements. All drawings will be merged. Unused columns 
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and layers will be deleted, but the original drawing files are still accessible.

See Merging Drawings on page 1.

Rename  

Convert

Frames  

Add Frames At Start Adds the number of frames you specify to be added at the beginning or end of the 
scene.Add Frames At End

Add Frames Before 
Selection

Adds the number of frames you specify before or after your selection.
Add Frames After 
Selection

Remove Selected 
Frames

Deletes the selected frames from your scene.

Drawings

Create Empty Drawing
Creates a drawing in the selected cell, replacing any drawing that may already be 
exposed in that cell and the following ones until it meets another drawing, key 
exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you modify an 
existing drawing but retain the original.

When duplicating a drawing, the selected cell is replaced with the new drawing. 
The exposure of the original drawing that was on the current cell is removed. The 
original drawing is not deleted from the project folder or other cells in which it is 
exposed.

Rename Drawing Lets you give a selected drawing a new name.

Rename Drawing with 
Prefix

 

Rename by Frame  

Delected Selected 
Drawings

 

Merge Selected 
Drawings

 

Vectorize Line Art in 
Selected Drawings

 

Mark Drawing As

Marks selected drawings as one of the following: Key, Breakdown, In-between, 
RetakeKey, RetakeBD or RetakeIB.  

This helps to keep the Xsheet well organized while animating.

When working with several animators, directors or even other studios, the 
necessity for retakes will often arise. Harmony gives you the possibility to mark 
new drawings as either Retake Key, Retake Breakdown, or Retake In-betweens.

See Drawing Identification on page 1.

Substitute Drawing Replaces the drawing or cell's symbol on the current frame by the previous or 
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Previous
next drawing.Substitute Drawing 

Next

Send Drawings to Desk  

Add Drawings to Desk  

Exposure

Increase

Adds one more exposure to a selected cell; repeating this action adds an extra 
cell each time. This is an efficient way to extend a drawing's exposure and is 
always set in Insert mode. Increasing an exposure pushes the existing exposure 
forward.

Decrease
Decreases exposure of a selected cell by one; repeating this action decreases 
one exposure adds an extra cell each time. This is an efficient way to shorten a 
drawing's exposure. Decreasing an exposure pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure Lets you extend the length of a selected cell.

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key Exposure
Removes only the key exposure (key frames) not all the exposures. The existing 
key exposure is replaced by the preceding exposure.

Remove Duplicate Key 
Exposure

When working with drawings to adjust the timing of a mouth in a lipsync, for 
example, and forcing the use of specific key exposures, unnecessary key 
exposures will be created. You can delete these duplicates without affecting the 
rest of the drawing. The first drawing of the selection will be used for the range.

NOTE: Duplicate key exposures may occur when pasting with the Enforce Key 
Exposure option selected.

Fill Empty Cells

Lets you fill empty cells to extend the exposure of single frame drawings to fill the 
range of empty cells after each one.When creating drawings on  cells that are not 
side-by-side, the exposure of the first drawing no longer fills automatically. You 
must select the frame range where you want your drawings to hold their exposure 
up to the next drawing and use the Fill Empty Cells command.

Insert Blank Cell Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Create Cycle  

Fill Selection

Lets you fill the same value over an entire selection. The selection can be over 
one cell, a cell range in one column, a cell range over many columns, an entire 
column, or many columns. You can use numbers, words, letters, or any 
alphanumeric value.

Sequence Fill
Lets you create a numbered sequence over a selection. The sequence can be 
forward, backward, single, double or higher increment, as a cycle, and so on. The 
selection can be over one cell or a cell range in one column or more or an entire 
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column or many entire columns.

Fill Cells Randomly

Lets you fill in random values over a selection. You can give a maximum and a 
minimum value and create a range for Harmony to choose the random values 
from. The selection can be over one cell or a cell range in one column or more or 
an entire column or many entire columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Motion

Insert Keyframe  

Insert Keyframe and 
Duplicate Drawing

 

Delete Keyframes Deletes the selected keyframe.

Go to Previous 
Keyframe

 

Go to Next Keyframe  

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic interpolation 
created between the selected point and the next one. The layer will maintain its 
position until the animation reaches the frame of the next point and will then jump 
to the new position. Deselect this option to generate interpolation and get the 
layer to progressively move to the next position.

Morphing

Create Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire sequence 
between the two keyframes.

Insert Morphing Key 
Drawing

Creates a morphing keyframe from a selected morphing frame.

Convert Morphing to 
Drawing

Lets you convert your morphing inbetweens to real drawings you can edit. This is 
useful when manually editing a morphing sequence or if you prefer to have 
animation timing in double frame (on twos) instead of single frame (on ones). 

Lip-Sync

Change Mouth Shape 
to

Lets you change the mouth shape to one of the following: A, B, C, D, E, F, G, X.

Auto Lip-Sync 
Detection

Generates a sound detection for lip-sync.

Map Lip-Sync
Automatically maps drawings in an element to the mouth chart you have 
generated for a sound. This can save time when you are lip-synching a voice 
track.

Sound Display

Sound Name Shows the name of the sound file, as well as the file format. The line running 
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vertically through the column frames between the same file name indicates a 
continuity of the same sound file in these frames.

Mouth Shapes

Shows the letter (or name depending on the way you named your character's 
different mouth positions) in the column's frames. There is only one mouth 
position allotted per frame and this position should correspond to the sound file 
after performing a lip-sync.

Waveform

Shows a vertical display of the sound file's actual waveform. In the column 
header, in the field under the column name, you can type in a percentage to zoom 
in or zoom out on the waveform, or pass the scroll cursor  over the Zoom 
Waveform  icon.

Sound Edit

Insert Blank Cell Places an empty cell between other cells. 

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Annotation

Import File Lets you import an image file in an Annotation column.

Change Pen Colour
Lets you change the pen colour by selecting one from the Select Colour dialog 
box.

Pen Width Lets you select a pen preset or change the pen width (in pixels).

Eraser Width Lets you modify the width of the Eraser tool.

Erase All
Removes all text and drawn annotations. Annotations that you type in cannot be 
erased using this method.

Erase Selected Images Removes images you select in the Annotation column.

Erase Selected Texts Removes text you select in the Annotation column.

Enable Drawing Lets you draw in the Annotation column using your mouse or pen tablet.
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Chapter 4: Toolbars
Harmony contains toolbars which, by default, are located at the top of the interface. Some views also have a toolbar 
which you can reposition to suit your work style. You can show or hide toolbars, as well as customize it with the 
tools you use most often and hide the ones you don't.

Main Toolbars

View Toolbars
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Chapter 5: Views
Intro...

Coordinates and Control Points View
The Coordinates and Control Points view displays the parameters of keyframes or control points selected in the 
Camera, Timeline or Xsheet view.  You can also see the same information in the Coordinate and Control Point 
toolbars.

In this view, you can edit keyframes and control point parameters, such as the position, continuity, bias, tension and 
lock-in-time. 

Parameter Description

Name The name of the function curve to which the select point is linked.

Position

Separate
Modifies modify the X, Y and Z coordinates independently. When this option is 
deselected, all three parameters are linked. If one is deleted, all others will also be 
deleted.

Cumulative Z

When a layer is parented to other layers that are moved forward or backward on 
the Z-axis, the currently selected layer's Z position value may not be accurate 
since its parent will also have an offset on the Z-axis. The Cumulative Z value is a 
compilation of all the Z-axis offsets to give the real Z-axis offset value related to 
the (0,0) centre.

Scale

Separate Scale Modifies the width and height values independently. When this option is selected, 
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the width and height are locked to the same value, forcing the scale to be on a 1:1 
ratio. If the option is deselected, you have the ability to squash and stretch your 
layer at will.

Rotation

Angle The rotation angle value from the permanent pivot of the element.

Skew

Skew This is the skewing value.

Control Point and Keyframe

Frame The frame at which the select point is set.

Locked in Time
Indicates if the point is locked to a specific frame (keyframe) or only locked to a 
specific position and the curve can flow through it freely as other points are being 
added, moved, or adjusted (control point).

Stop-Motion Keyframe

When this option is selected, the keyframe is set as a stop-motion point. This 
means that there is no automatic interpolation created between the selected point 
and the next one. The layer will maintain its position until the animation reaches 
the frame of the next point and will then jump to the new position. Deselect this 
option to generate interpolation and get the layer to progressively move to the next 
position.

Tension
Controls how sharply the path bends as it passes through a control point or 
keyframe.

Continuity Controls the smoothness of a transition between the segments joined by a point.

Bias
Controls the slope of the path so it flows towards one side of the motion point or 
the other.

Tension

 

Continuity
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Bias

Layer Properties
The Layer Properties editor or view lets you adjust the properties of a layer in the Timeline view or a node in the Node 
view. The Layer Properties can be viewed as a floating window or as a view (docked).

Each layer has its own set of properties that can be modified, including effect and peg layers. Display the Layer 
Properties editor or view if you want to modify some of the layer’s properties, such as the name or the antialiasing 
quality. 

How to access the Layer Properties editor

‣ Double-click on a layer in the Timeline view or a node in the Node view.

‣ Right-click on a layer in the Timeline view or a node in the Node view and select Layer Properties.

‣ Select a layer in the Timeline view or a node in the Node view and press Shift + E.

How to access the  Layer Properties view

 1. Do one of the following:

‣ Select the view you want to add from Windows > Layer Properties.

‣ In the top-right corner of a view, click the Add View  button and select Layer Properties from the list.

By default, the Layer Properties view appears as a tab.
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Transformation Tab

The Transformation tab contains parameters for adjusting the position, scale, rotation, skew and pivots of an 
element.

When the Enable 3D option is selected, additional parameters appear in the Rotation and Pivot sections to rotate 
objects on 3 axis in the 3D space.
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Parameter Description

Enable 3D Displays additional parameters for working with 3D objects.

Position

3D Path: Lets you use a 3D path function to animate an element.

Separate: Lets you independently edit the different coordinate fields.

Path (x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

Path (y) Axis: Lets you type in a new North/South coordinate corresponding to 
the desired position.

Path (z) Axis: Lets you ype in a new Forward/Backward coordinate 
corresponding to the desired position.

Velocity: When the 3D Path option is selected, lets you set the speed at which 
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Scale

Locked: Resizes the element while keeping its ratio. The X and Y axes scale 
proportionally

Separate: Resizes the element allowing to modify the ratio (squash and stretch).

(x) Axis: Lets you type in the horizontal scale value.

(y) Axis: Lets you type in the vertical scale value.

Scale in Fields: Instead of using the standard scaling units, when this option is 
enabled, images are scaled using field units, based on the traditional animation 
field chart.

Ignore Parent Scaling: When this option is enabled, any scaling value applied to 
a parent layer is ignored in the current layer. This can be handy in cut-out rigs 
when you need to scale an arm without affecting the forearm. 

Rotation
Angle z: Lets you  type in a degree value for the rotation angle. Note that you can 
enter values greater than 360 and -360 degrees. If you enter 720, the object will 
rotate twice.

Skew Skew: Lets you type in a degree value between -90 to 90 for the skew angle.

Pivot

(x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

(y) Axis: Lets you ype in a new North/South coordinate corresponding to the 
desired position.

Drawing Pivot

Use Embedded Pivots: 

Harmony has three types of pivots:

• Permanent Pivot
This is a permanent pivot, sometime referred to as peg pivot, that is 
applied to the entire drawing or peg layer. If you modify its position, it will 
be changed for the entire layer, modifying the animation, scale and rotation 
interpolation. The permanent pivot is set using the Rotate, Translate or 
Scale tool. The Transform tool will only move that pivot temporarily for 
positioning purposes, but the animation interpolation will be done from the 
original permanent pivot's position. The Transform tool is designed to 
move the pivot temporarily during the animation process. It also permits 
you to select multiple pegs and apply a common temporary pivot.

To permanently move a peg pivot, use the Rotate  or Scale  tool. You can 
also directly type the values in the Layer Properties window in the Pivot 
section's (x) Axis and (y) Axis fields.

In the Layer Properties window, in the Drawing Pivot section, select the 
Don't Use Embedded Pivot option to use the permanent pivot.

• Drawing Pivot
The Drawing pivot is contained within each drawing. In one layer, each 
drawing can have its own pivot. If you have many different views of a 
character within one layer, the pivot can be different and the animation will 
adjust to the pivot. The Drawing pivot can also be referred to as embedded 
pivot. If you are not mixing different views within the same layers or are 
using pegs to animate your layers, it is recommended to use the 
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permanent pivot.

You can set a different pivot for each one of your drawings. For example, if 
you have a series of drawings from different views, they are not likely to 
rotate from the same location. In that case, you can set a different pivot for 
these drawings by using the Drawing Pivot  tool.

In the Layer Properties window, in the Drawing Pivot section, select the 
Apply Embedded Pivot on Drawing Layer option to use the drawing 
pivot directly on the drawing layer. If you want to apply the drawing pivot to 
a parent peg to force the peg to follow the drawing pivot variations, enable 
the Apply Embedded Pivot on Parent Peg option.

• Symbol Pivot
The Symbol pivot is similar to the Drawing pivot. Each symbol cell can 
have its own pivot and act the same as the Drawing pivot. The Symbol 
pivot can also be referred to as embedded pivot. Inside a symbol, each 
drawing can have its own pivot. If you are not mixing different views within 
the same layers or are using pegs to animate your layers, it is 
recommended to use the Peg pivot.

For a simple character rig, it is recommended to set the Peg pivot (even on 
drawing layers) using the Rotate  tool.

Drawing Tab

The Drawing tab contains parameters for the element and timing columns, designating art layers, and setting bitmap 
options.
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Parameter Description

Element Columns

Full Name: Select which element to connect to the node from the list of 
elements that already exist in your scene.  

Drawing Path: Displays the full path to the current drawing.

Timing Columns

Name: Path to the file you want to link to.  

Timing Column: Link to the column that contains the desired timing.  

Extension: When linking to a background file, enter its file name extension.  

Field Chart: If you are importing traditional animation, select the size of the 
paper on which the animation was drawn.

Art Layers

Overlay Art Enabled: Enables the Overlay Art display.

Line Art Enabled: Enables the Line Art display.

Colour Art Enabled: Enables the Colour Art display. 

Underlay Art Enabled: Enables the Underlay Art display.  

Overlay Art Type: Allows you to set the Overlay Art as Vector or Bitmap type.

Line Art Type: Allows you to set the Line Art as Vector or Bitmap type.

Colour Art Type: Allows you to set the Colour Art as Vector or Bitmap type.

Underlay Art Type: Allows you to set the Underlay Art as Vector or Bitmap 
type.

Bitmap File Options

When an image is created with an external software and that image has some 
transparency, there are several formats the software can use when writing the 
RBG channels. The purpose of the four import options for the transparency is 
for the user to tell Harmony how to interpret the RGB channels of the imported 
image. The correct option has to match the ouput format of the software that 
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was used to create the image in the first place. For instance, if the you used 
Adobe Photoshop and exported an image as Straight, then it should be 
imported in Harmony as Straight in order to get the correct result. 

Note that if the image has no alpha channel or if it does have an alpha channel 
and all the pixels are 100% opaque, it does not make any difference which 
option is selected. 

Colour: Controls the production of colour information from bitmap images. If 
this module reads 3 or 4-channel bitmaps, this selection determines whether 
the colour should be read or ignored. If this module reads 1-channel bitmaps, 
this selection determines whether the channel should be read as colour. When 
this option is selected with 1-channel images, the resulting image will be a 
greyscale image.  

Transparency: Controls the production of alpha information from bitmap 
images. If this module reads a 1 or 3-channel image, this option will create a 
matte from the colour values in the image. If the module reads a 4-channel 
image and this option is not selected, the alpha information in the image will be 
ignored.

Transparency Type  

Premultiplied with Black: Semi-transparent pixels in the original image are 
blended with black. 

Premultiplied with White: Semi-transparent pixels in the original image are 
blended with white. 

Straight: Semi-transparent pixels in the original image are left as is 
(unmatted). 

Clamp Colour to Alpha: Semi-transparent pixels in the original image are 
blended with black. On import, each of the RGB channels is clamped so that a 
color value never exceed the alpha value for a given pixel. When the RGB 
values are multiplied with the alpha value, that is to say, if you have a pixel of 
value R=247, G=188, B=29 and the alpha is 50% or the image has a 50% 
transparency, then the actual RGB values output would be half of the amounts 
listed above.

Drawing Tab

The Drawing tab contains parameters for the element and timing columns, designating art layers, and setting bitmap 
options.
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Parameter Description

Element Columns

Full Name: Select which element to connect to the node from the list of 
elements that already exist in your scene.  

Drawing Path: Displays the full path to the current drawing.

Timing Columns

Name: Path to the file you want to link to.  

Timing Column: Link to the column that contains the desired timing.  

Extension: When linking to a background file, enter its file name extension.  

Field Chart: If you are importing traditional animation, select the size of the 
paper on which the animation was drawn.

Art Layers

Overlay Art Enabled: Enables the Overlay Art display.

Line Art Enabled: Enables the Line Art display.

Colour Art Enabled: Enables the Colour Art display. 

Underlay Art Enabled: Enables the Underlay Art display.  

Overlay Art Type: Allows you to set the Overlay Art as Vector or Bitmap type.

Line Art Type: Allows you to set the Line Art as Vector or Bitmap type.

Colour Art Type: Allows you to set the Colour Art as Vector or Bitmap type.

Underlay Art Type: Allows you to set the Underlay Art as Vector or Bitmap 
type.

Bitmap File Options

When an image is created with an external software and that image has some 
transparency, there are several formats the software can use when writing the 
RBG channels. The purpose of the four import options for the transparency is 
for the user to tell Harmony how to interpret the RGB channels of the imported 
image. The correct option has to match the ouput format of the software that 
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was used to create the image in the first place. For instance, if the you used 
Adobe Photoshop and exported an image as Straight, then it should be 
imported in Harmony as Straight in order to get the correct result. 

Note that if the image has no alpha channel or if it does have an alpha channel 
and all the pixels are 100% opaque, it does not make any difference which 
option is selected. 

Colour: Controls the production of colour information from bitmap images. If 
this module reads 3 or 4-channel bitmaps, this selection determines whether 
the colour should be read or ignored. If this module reads 1-channel bitmaps, 
this selection determines whether the channel should be read as colour. When 
this option is selected with 1-channel images, the resulting image will be a 
greyscale image.  

Transparency: Controls the production of alpha information from bitmap 
images. If this module reads a 1 or 3-channel image, this option will create a 
matte from the colour values in the image. If the module reads a 4-channel 
image and this option is not selected, the alpha information in the image will be 
ignored.

Transparency Type  

Premultiplied with Black: Semi-transparent pixels in the original image are 
blended with black. 

Premultiplied with White: Semi-transparent pixels in the original image are 
blended with white. 

Straight: Semi-transparent pixels in the original image are left as is 
(unmatted). 

Clamp Colour to Alpha: Semi-transparent pixels in the original image are 
blended with black. On import, each of the RGB channels is clamped so that a 
color value never exceed the alpha value for a given pixel. When the RGB 
values are multiplied with the alpha value, that is to say, if you have a pixel of 
value R=247, G=188, B=29 and the alpha is 50% or the image has a 50% 
transparency, then the actual RGB values output would be half of the amounts 
listed above.

Controls Tab
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The Controls tab contains animation control options.

Parameter Description

Animation

Animate Using Animation Tools: By default, a drawing layer can be animated 
using the same parameters as a peg, but you can disable this feature. Being 
able to switch your drawing layers so they can no longer be animated without a 
peg has certain advantages. In cut-out animation, it is easier to separate your 
drawing exposure and keyframes to change timing easier and rearrange 
keyframe position in the Timeline view. This feature is also available for 
backward compatibility when bringing in templates created in older versions of 
the software, so as not to lose their offset keyframes or drawing substitution 
keyframes.

Angle Limit Values

Lets you set a maximum and minimum rotation angle for a drawing. This option 
is used mainly for a cut-out character when you do not want an elbow to bend 
too far in or out. 

 Enable Min/Max Angle: Activates the minimum and maximum angle 
constraints. 

Min Angle: Type the minimum angle you want the drawing to rotate too. 

Max Angle: Type the maximum angle you want the drawing to rotate too.

Spline Offset

In the X, Y and Z axis fields, type the coordinates of where you want to offset 
the visual trajectory. By default, the trajectory is displayed at the centre 
drawing, using the layer's pivot position. If you want to move it so it 
corresponds better with your drawing, either type new coordinates or use the 
Spline Offset  tool available in the Advanced Animation toolbar.  

To display the trajectory in the Camera view, select your drawing and select 
View > Show > Control. You can also press Shift + F11 (Windows/Linux) or 
⌘  + F11 (Mac OS X).

Advanced Tab 

The Advanced tab contains options for setting the alignment of drawings, clipping, line thickness, vector render 
options, and more.
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Parameter Description

Alignment

Alignment Rule: The alignment rule selections are intended to deal with drawings 
that were created on paper of a different size or orientation from the default 
alignment rule (set up in the Scene Settings dialog box) or imported bitmap 
images. The drawings are then scaled to match the Harmony alignment 
rectangle. Note that alignment rules are not based on the camera frame, but on 
the scene frame. Refer to the Fundamentals Guide to learn more about scene 
alignment and scene settings.

• Left: The default alignment for drawings; aligns the drawings to the left 
side of the scene’s alignment rectangle. Harmony scales the drawings to 
match their height to the alignment rectangle of the scene.

• Right: Aligns the drawings to the right side of the alignment rectangle. 
Harmony scales the drawings to match their height to the height of the 
alignment rectangle of the scene.

• Top: Aligns the drawings to the top of the alignment rectangle. Harmony 
scales the drawings to match their widths to the width of the alignment 
rectangle of the scene.

• Bottom: Aligns the drawings to the bottom of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.
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• Centre Fit: Centers the drawings.

• Centre Fill: Centers the drawings and then scales them so the width or 
height fills the available space.

• Centre LR: Aligns the drawings in the left-right centre of the alignment 
rectangle. Harmony scales the drawings to match their height to the height 
of the alignment rectangle of the scene.

• Centre TB: Aligns the drawings in the top-bottom centre of the alignment 
rectangle. Harmony scales the drawings to match their widths to the width 
of the alignment rectangle of the scene.

• Stretch: Scales the drawings so they fit within the alignment rectangle of 
the scene. This is particularly useful for images that you will manipulate 
with a Quadmap node. If the drawings in the Quadmap node do not have 
the same aspect ratio as the alignment rectangle of the scene (from the 
Scene Settings dialog box), the handles on the quadmap will not appear on 
the corners of the image, making it difficult to manipulate the quadmap. In 
this case, you would set the drawing layer of the quadmap images to 
Stretch to make the handles appear on the corner of the image. This can 
have the effect of distorting the images, but it is not an issue with images 
that will be distorted through the Quadmap node anyways.

• As Is: Leaves the drawings aligned as they are. 

• Centre First Page: Aligns the centre of the first part of a standard pan cel 
with the centre of the field chart.

Turn Before Alignment: Rotates  the drawings in the selected element 90 
degrees to the left before scaling and aligning them according to the alignment 
rule, and before performing any offset, rotation or scaling for the element or peg. 
This and the Alignment Rule are intended for drawings that were created on paper 
of a different size or orientation than the other paper in the scene, and requires 
alignment  so they are treated accurately.

Flip Horizontal: Flips the drawing on the X-axis.

Flip Vertical: Flips the drawing on the Y-axis.

Clipping

No Clipping: Select this option if you do not want to clip the images in this node 
before an effect is applied to it.

Clipping Factor (X)/(Y): This is an option for rendering images that are larger 
than the final frame. With this option enabled, images can be moved by an Apply 
Peg Transformation node without black entering into the composite as a result 
of early clipping. In addition, this option is useful for images that have a blur that 
should appear in the frame even though the image itself is not in frame—see Apply 
Image Transformation and Apply Peg Transformation.

Line Thickness

As you move the camera in your scene along the Z-axis, notice that, logically, the 
lines of the elements become thicker the closer the camera gets to the drawing. If 
you prefer the lines to remain the same size or become thicker at a different 
speed, you can use the thickness feature to adjust your brush stroke and pencil 
line thickness. You can modify the size of the lines even if the camera is not 
animated.
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To learn how to use this feature, see Camera Truck-ins and Line Thickness.

Adjust Pencil Lines Thickness: Lets you work with pencil lines and adjust their 
thickness. You will not see any changes to lines in the Camera view OpenGL 
mode. You must switch to the Render mode.

Normal Thickness: Disables all overrides on the brush stroke line thickness. 
This option must be enabled in order for the pencil line thickness parameter and 
pencil lines to appear. If you want to modify the brush stroke thickness, deselect 
this option. To enable brush strokes to work with the line thickness feature, you 
must first create central strokes in the Colour Art layer. The central strokes 
control the line variation of your brush strokes in the Line Art layer. Select 
Drawing > Create Colour Art from Line Art.

Zoom Independent Thickness: Select this if you want your line thickness to 
remain constant independently from the camera move. Everything else will 
increase in size, but the line thickness will stay the same.

Proportional: Enter a multiple by which you want to increase the line thickness 
base on its original thickness. A value of 1 will result in no change; a value of 0 
(zero) will hide the lines.

Constant:  Enter a value in pixels (based on a 720x540 screen resolution) to 
indicate the amount of pixels you want to add around the existing line.

Minimum: Enter a value in pixels (based on a 720x540 screen resolution) for the 
minimum line thickness allowed.

Maximum: Enter a value in pixels (based on a 720x540 screen resolution) for the 
maximum line thickness allowed.

Vector Render Options

• Antialiasing Quality: A smoothness (antialiasing) setting applied to the 
final rendered image. 

• Low: No antialiasing 

• Medium Low: Basic antialiasing

• Medium: Improved antialiasing (blurs the textures)

• High: High quality antialiasing (does not blur the textures)

Higher quality images require more time to render and more system 
memory. Choose a lower quality if you are rendering a pencil test.

• Antialiasing Exponent: Controls the size of the area around the final 
image edges used in the antialiasing process. A higher value uses less 
area, resulting in sharper edges, while a lower value uses more area, 
resulting in softer edges. If the Antialiasing Quality value is set to Low (no 
antialiasing) or Medium Low, this value is ignored. Values: Between 0 and 
1.

• Texture Filter: This option changes the way coloured pixels of TVG 
textures are calculated when rendered for different degrees of accuracy. 

• Bilinear: This option takes the four pixels around each point and 
makes a bilinear interpolation between them. (Medium Quality)

• Nearest: This option chooses the colour of the closest pixel to a point. 
(Lower Quality)
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• Nearest (Filtered): This option is an improved version of Bilinear and 
improves the quality when zooming on a texture. (Best Quality)

Miscellaneous

• Depth: Overrides the order of cables in the node system to determine the 
forward/backward order in which this element is rendered. The Z position 
value overrides the depth value.

• Morphing Velocity: Creates a velocity function curve for morphing 
sequences in the layer. This function modifies the interpolation percentage 
between the 2 drawings. If set, the morphing between the two drawings 
will not be linear over time between the two drawings but will be modulated 
according to this curve.  This can be used to create a periodic morphing 
over a long period of time.

• Opacity: Lets you quickly change the transparency of the selected 
element. Opacity settings here will be reflected in both OpenGL preview, 
and full render.  
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Chapter 6: Windows
Intro...

Element Manager Window
The Element Manager window lets you add, delete or modify elements (drawing folders) in your scene. If you have 
drawing folders that are not linked to a column in your scene, use the Element Manager to delete them if needed.

For more information on working with this window, see Modifying Layers and Columns on page 1.

How to access the Element Manager window

 1. From the top menu, select Scene > Element Manager.

Parameter Description

Elements

Delete Elements Deletes the selected elements.

Delete Elements and 
Directories

Deletes  the selected layer and its directories (drawing folder).

Add/Modify Element

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Vector
Select this option if the new element is a vector drawing or if you want to enable 
the parameters on the selected element in the Elements list.

Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Scan module, 
select the scan type from the list.

Field Chart
If you're importing traditional animation, select the size of the paper on which the 
animation was drawn.

Add
Creates a new element with the current parameters entered in the Add/Modify 
Element section.

Modify Applies the parameter changes made to the selected element.
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Manage Tool Presets Window
The Tool Presets window lets you create new tool presets and manage them. 

For more information on working with this window, see Working with Tool Presets on page 1.

How to access the Manage Tool Presets window

 1. Do one of the following:

‣ From the top menu, select Windows > Toolbars > Tool Presets.

‣ Right-click an empty area below the top menu and select Tool Presets.

 2. In the Tool Presets toolbar, click the Manage Presets  button.

Parameter Description

Icon Lets you select a preset to manage.

Import Lets you import an existing preset.

Export Lets you export a preset for use in other projects.

Delete Removes the preset from the list of tool presets.

Name Lets you change the name of the preset.

Icon list Lets you select an icon for the preset.

Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the new preset.
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Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any 
tool. The colour preset would then work on any selected tool. Selecting the 
brush tool was only a vehicle to get into the New Tool Preset dialog box. 

Update
After adjusting the settings for a preset, the current properties are applied to the 
presets, as well as any other changes you made in the Manage Tool Presets 
window.

Versions Window
The Versions window lets you delete any unnecessary versions of scenes when working with Harmony Server. 
When working with multiple versions of a scene, you may to clean up the database by deleting the ones you no 
longer need.

For more information on working with this window, see Saving a Scene on page 1.

How to access the Versions window

 1. Make sure you have the necessary rights. If you do not, select File > Rights to Modify Scene. 

 2. From the top menu, select File > Manage Versions. 

Parameter Description

Existing Versions Displays the different versions of a scene that you can delete.

Description Displays information about the selected version.

Delete Removes the selected version of a scene. 
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IMPORTANT: This operation cannot be undone.

Export to Easel JS
The Export to Easel JS window lets you a flattened image sequence of your animation. Even if you have a fully 
rigged puppet or a single drawing layer with your animation sequence, the outcome will still be a flattened output 
of each frame, grouped together in your sprite sheet. This allows for more flexibility and freedom of work as you 
have access to any tools or effect modules you want to use. However, this can result in heavier files depending 
on the length, complexity and export size of your animation.

How to access the Export to Easel JS window

 1. From the top menu, select Windows > Toolbars > Game.

The Game toolbar appears above the Camera view, to the left.
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 2. Click the Export to Easel JS  button.

Parameter Description

Select Directory

Save Path The folder path where you want to save your export.

Save Name
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder Displays the clips in the folder.

Scene Options

Display

Here, you must select the Display of your character. This is the one that will be 
used to render out all of the information attached to that Display node. If the 
Unconnected_Display option is selected, all of the visual information in your 
scene will be rendered out.

Sprite Sheet Preferences

Max Width This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.Max Height

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it does 
not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 1024 
x 1024.  This is optimized for many graphics cards, but consumes more memory.

NPOT: Some game engines are optimized specifically to render to non powers of 
two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames

This option works in tandem with the Threshold option. The export will compare 
the drawings in your project to reuse a maximum of similar drawings and reduce 
the amount of information found in the sprite sheet, making it lighter. The export 
will omit the creation of new drawings if the difference is less than the threshold 
percentage.

Threshold

Calculates the differences between multiple drawings. A 2% threshold will 
prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, only 
2 of those pixels need to be different from my other drawing in order to create a 
new one. The higher the threshold, the fewer similar drawings you will have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.
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Export to Sprite Sheets
The Export to Sprite Sheets window export to multiple resolutions, generating multiple .xml files and one or 
multiple sprites sheets depending how many sprite resolutions you defined.

This saves different animations of the same character into the same name. For example, if there's an idle, run, 
and jump animation, these should all share the same Save Name. You can think of it as the overall collection of 
animations. Inside are the different saved scene versions whose drawings you can reuse for all the animations in 
that character set. Each scene version will be displayed as an item in the list.

When you export an animation, only the drawings used in that scene are exported. All the drawings are exported 
individually first and then atlased together into a sprite sheet.

If you saved multiple animations to the same Save Name (i.e. SpaceDuck: run, idle), then it will reatlas the sprite 
sheet to include all the drawings from all the animations in that folder, creating a new animation file, but reusing 
the same skeleton.
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How to access the Export to Sprite Sheets window

 1. From the top menu, select Windows > Toolbars > Game.

The Game toolbar appears above the Camera view, to the left.

 2. Click the Export to Sprite Sheets  button.

Parameter Description

Select Directory

Save Path The folder path where you want to save your export.

Save Name
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder

Overwrite Project
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Clear Texture Folder
Removes any information from the texture folder within the Harmony file. This 
has no incidence towards the Unity export but contributes to a lighter Harmony 
file.

Project Settings

Unit Scale

Lets you change the scale when exporting to Unity to accommodate the size of 
the export without it affecting the Harmony scene. This helps you resize assets 
properly for Unity without having to resize them in Harmony. The basic scale is 
one Animation Field for one Unity unit.

Sprite Sheet Preferences

Max Width
This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.

Max Height
Makes linear values for interpolation. This increases the amount of memory used 
but frees up the calculation so it is not done on the fly.

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it does 
not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 1024 
x 1024.  This is optimized for many graphics cards, but consumes more memory.

NPOT: Some game engines are optimized specifically to render to non powers of 
two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames This option works in tandem with the Threshold option. The export will compare 
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the drawings in your project to reuse a maximum of similar drawings and reduce 
the amount of information found in the sprite sheet, making it lighter. The export 
will omit the creation of new drawings if the difference is less than the threshold 
percentage.

Threshold

Calculates the differences between multiple drawings. A 2% threshold will 
prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, only 
2 of those pixels need to be different from my other drawing in order to create a 
new one. The higher the threshold, the fewer similar drawings you will have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.

Precalculate Curves
Makes linear values for interpolation. This increases the amount of memory used 
but frees up the calculation so it is not done on the fly.
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